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LỜI NÓI ĐẦU 
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dựng, Bộ môn Kết cấu công trình Trƣờng Đại học Xây dựng Miền Trung biên soạn 

cuốn giáo trình “Kết cấu nhà cao tầng bêtông cốt thép”. 

Kết cấu bêtông cốt thép là loại kết cấu chủ yếu trong xây dựng hiện đại. Kiến 
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hàng đầu trong thiết kế và thi công nhà cao tầng. 

Giáo trình trình bày những nguyên tắc cơ bản về lựa chọn các giải pháp kết cấu 
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cấu nhà cao tầng bêtông cốt thép.  
Đây là tài liệu rất cơ bản, giúp ích cho sinh viên trong quá trình học tập, làm đồ 
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Tài liệu chắc chắn sẽ còn những thiếu sót, rất mong nhận đƣợc những ý kiến 

đóng góp quý báu, chân thành của bạn đọc.  

Chân thành cảm ơn các thầy giáo, cô giáo trong Bộ môn Kết cấu công trình và 

các đồng nghiệp đã cộng tác, góp ý và giúp đỡ để hoàn thành cuốn tài liệu này.  
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Chương 1 

 TỔNG QUAN NHÀ CAO TẦNG 

1.1. Khái niệm về nhà cao tầng 

Định nghĩa về nhà cao tầng thay đổi từng nƣớc tùy thuộc vào sự phát triển khoa 

học kỹ thuật, kinh tế, xã hội và ứng dụng công nghệ của nƣớc đó. 

Theo Ủy Ban nhà cao tầng Quốc tế: ”Một công trình đƣợc xem là nhà cao tầng 

nếu chiều cao của nó quyết định các điều kiện thiết kế, thi công hoặc sử dụng khác với 

nhà thông thƣờng”. 

Có thể định nghĩa theo cách khác: “Nhà cao tầng là một nhà mà chiều cao của nó 

ảnh hƣởng tới ý đồ và cách thức thiết kế”. 

Quy định nhà cao tầng của một số quốc gia: 

Quốc gia SNG 
Trung 

Quốc 
Mỹ Pháp Anh Nhật Đức 

Việt 

Nam 

Nhà ở 
10 tầng 

trở lên 

10 tầng 

trở lên 

10 tầng 

trở lên 
>50 m 

> 24,3 m 

11 tầng 

và chiều 

cao từ 31 

m 

Cao 22 

m tính từ 

mặt nền 

Công 

trình cao 

trên 40 m 

Công 

trình 

khác 

7 tầng >24 m 
Nhà trên 

22 -25 m 
>28 m 

1.2. Lịch sử phát triển 

Từ đầu thế kỉ XX, cùng với sự phát triển của khoa học kỹ thuật (nhƣ công nghệ 

vật liệu, công nghệ chế tạo máy ...) đã đƣa thế giới vào một cuộc chạy đua xây dựng 

các công trình chọc trời. Do vậy nhà cao tầng xuất hiện và trở thành biểu tƣợng cho sự 

phồn thịnh và phát triển mà điển hình là sự phát triển ở Mỹ: 

- Năm 1913 cao ốc Woolworth Building đƣợc xây dựng (57 tầng, 241m);  

- Năm 1930 xây dựng cao ốc Chrysler chiều cao 319m; sau vài tháng tòa nhà 

Empire State Building đƣợc xây dựng cao 381m (102 tầng), tính cả ăngten – cao 448 

m.  

- Sau đó tháp đôi World Trade Center ra đời cao 415 và 417 m (Bị đánh bom 

11/09/2001). 

- Năm 1973 xây dựng Sears Tower ở Chicagol, cao 442 m.  

Ở Châu Á, xu hƣớng phát triển này cũng bắt đầu từ những năm 70 mà điển hình 

là: 

- Bank of China Tower – Hong Kong cao 269m (70 tầng);  

- Jin Mao Tower ShangHai cao 421m (86 tầng);  

- Petronas Tower Malaysia cao 450m (95 tầng). 

Nhà cao tầng ở Mỹ: 
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Trƣờng phái nhà cao tầng Chicago: Là trƣờng phái nhà cao tầng xuất hiện trƣớc 

đặc điểm phát triển nhà cao tầng theo kiến trúc High-Tech và Super High-Tech. Mang 

nặng về mặt kỹ thuật, có hình thức khối tƣơng đối vuông vắn, cục mịch và không đa 

dạng cũng nhƣ không mang tính nghệ thuật. Kiểu nhà cao tầng phổ biến nhất tại thành 

phố Chicago nói riêng và toàn nƣớc Mỹ nói chung là những tòa nhà chọc trời đƣợc 

thiết kế thiên hƣớng theo công năng và kết cấu hiện đại mang tính công nghệ cao 

nhƣng không mang tính phong phú và đa dạng về nghệ thuật kiến trúc nhà cao tầng. 

Kể từ khi đƣợc giới thiệu và sử dụng rộng rãi, kiến trúc này đã làm chuyển đổi các tòa 

nhà theo phong cách Châu Âu cổ điển sang trƣờng phái thiết kế theo công nghệ phô 

diễn kết cấu. 

Cao ốc Woolworth (241m)     Cao ốc Chrysler (319m)    State Empire Building (344m)  

Hình 1. 1. Các tòa nhà cao tầng nổi tiếng ở Mỹ. 

Trƣờng phái nhà cao tầng New York:  Là trƣờng phái sau trƣờng phái nhà cao 

tầng Chicago, có đặc điểm phong phú và đa dạng về hình thức kiến trúc của tổ hợp. 

Trƣờng phái này có xử lý hình khối kiến trúc của tổ hợp một cách nghệ thuật. Bao 

gồm: Tổ hợp mặt bằng; tổ hợp mặt đứng mà hiệu quả là phần kết của mặt đứng. 

Trƣờng phái này thể hiện bởi các kiểu nhà cao tầng phổ biến nhất tại thành phố New 

York là những tòa nhà chọc trời. Kể từ khi đƣợc giới thiệu và sử dụng rộng rãi ở đây, 

kiến trúc này đã làm chuyển đổi các tòa nhà của New York từ kiểu truyền thống Châu 

Âu thấp và các khối nhà theo phong cách cao tầng thô mộc Chicago sang những khu 

thƣơng mại vƣơn thẳng đứng lên cao và có xử lý nghệ thuật ở phần mái. Đến 8/2008, 

New York có 5.538 tòa nhà cao tầng (nhiều nhất ở Hoa Kỳ và đứng hạng nhì thế giới 

sau Hong Kong). Hiện nay thành phố có 50 nhà chọc trời xây dựng xong, cao trên 200 

mét. Bị bao quanh bởi mặt nƣớc, mật độ dân số và giá trị bất động sản cao trong những 
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khu thƣơng mại khiến cho New York trở thành nơi tập trung nhiều nhất các tòa nhà, 

tòa tháp chung cƣ và văn phòng trên thế giới. 

New York có những tòa nhà cao tầng với kiến trúc nổi bật mang nhiều phong 

cách khác nhau. Woolworth Building tại 40 phố Wall (1913), là tòa nhà chọc trời 

mang kiến trúc Gothic phục hƣng thời kỳ đầu. Nghị quyết phân vùng năm 1916 bắt 

buộc các tòa nhà mới phải đƣợc xây theo kiểu hình chồng lên nhau (phần dƣới có diện 

tích rộng hơn phần trên) và giới hạn các tháp bằng một phần trăm nền đất bên dƣới để 

cho ánh nắng mặt trời chiếu xuống đƣờng phố bên dƣới. Kiểu thiết kế art deco của tòa 

nhà Chrysler năm 1930 với đỉnh thon nhỏ và hình chóp bằng thép đã phản ánh những 

yêu cầu bắt buộc đó. Tòa nhà này đƣợc nhiều sử gia và kiến trúc sƣ xem nhƣ là tòa nhà 

đẹp nhất New York với cách trang trí rõ nét, thí dụ các góc của tầng 61 có hình biểu 

tƣợng chim ó gắn trên nắp phía trƣớc đầu xe Chrysler kiểu năm 1928 và cả các mẫu 

đèn hình chữ v đƣợc ghép chặt bởi một tháp chóp bằng thép ở trên đỉnh tòa nhà. Một 

ví dụ về ảnh hƣởng lớn của kiến trúc phong cách quốc tế tại Hoa Kỳ là tòa nhà 

Seagram (1957), đặc biệt vì diện mạo của nó sử dụng các xà bằng thép hình chữ H 

đƣợc bọc đồng dễ nhìn thấy để làm nổi bật cấu trúc của tòa nhà. Tòa nhà Condé nast 

(2000) là một thí dụ điển hình cho cấu trúc thiết kế bền vững (Sustainable Design) 

trong các tòa nhà chọc trời của Hoa Kỳ. 

 
Hình 1. 2. Nhà cao tầng ở Chicago. 

Đặc điểm của các khu dân cƣ lớn của New York thƣờng là các dãy nhà phố 

(rowhouse, townhouse) đá nâu tao nhã và các tòa nhà cao tầng tồi tàn đƣợc xây dựng 

trong một thời kỳ mở rộng nhanh từ năm 1870 đến năm 1930. Đá và gạch trở thành 

các vật liệu xây dựng chọn lựa của thành phố sau khi việc xây nhà gỗ bị hạn chế bởi 

vụ cháy lớn vào năm 1835. Không giống nhƣ Paris trong nhiều thế kỷ đã đƣợc xây 

dựng từ chính nền đá vôi của mình, New York luôn lấy đá xây dựng từ một hệ thống 

các mỏ đá xa xôi và các tòa nhà xây bằng đá của thành phố thì đa dạng về kết cấu và 
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màu sắc. Một điểm nổi bật khác của nhiều tòa nhà cao tầng trong thành phố là có sự 

hiện diện của những tháp nƣớc bằng gỗ đặt trên nóc. Vào thập niên 1800, thành phố 

bắt buộc các tòa nhà cao trên sáu tầng gắn các tháp nƣớc nhƣ vậy để không cần phải 

nén nƣớc quá cao ở các cao độ thấp mà có thể làm bể các ống dẫn nƣớc của thành phố. 

Những tòa nhà cao tầng chung cƣ có vƣờn hoa trở nên quen thuộc suốt thập niên 1920 

tại những khu ngoại ô trong đó có Jackson Heights nằm trong quận Queens.  

Dạng trƣờng phái nhà cao tầng này lan tỏa trên nƣớc Mỹ với nhiều công trình có 

thẩm mỹ đẹp và nổi bật. Dƣới đây là một vài công trình minh họa. 

 
Hình 1. 3. Nhà cao tầng ở New York. 

Nhà cao tầng ở Châu Âu: 

Châu Âu đi sau Mỹ trong quá trình phát triển nhà cao tầng. Từ những năm 1950 

Frankfurt - Đức trở thành thành phố nhà cao tầng đầu tiên của Châu Âu. Năm 1960 

tháp Henninge trong khu phố Sachsenhausen là căn nhà Frankfurt đầu tiên vƣợt qua 

tháp tây của nhà thờ lớn Frankfurt về chiều cao (120 mét). các nhà cao nhất của những 

năm 1970 (Plaza Baro Center/khách sạn Marriott, DG-Bank (ngân hàng hợp tác xã 

Đức), Dresdner Bank) là những tòa nhà cao nhất nƣớc Đức với chiều cao tròn 150m, 

tháp hội chợ (Messeturm) 1990 đạt chiều cao 257 m và đã là tòa nhà cao nhất châu Âu 

cho đến 7 năm sau đó bị vƣợt qua bởi tòa nhà cao 259 m (cả ăngten cao 300 m) là trụ 

sở chính của Commerzbank. 

Nhà cao tầng ở Mỹ La tin, Trung Đông, Châu Á: 

Từ cuối thập niên 1930, nhà cao tầng cũng dần dần xuất hiện ở Nam Mỹ và ở 

Châu Á nhƣ: Thƣợng Hải, Hồng Kông và Singapore.  
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Trƣớc sự khan hiếm về đất đai xây dựng cũng nhƣ tỉ lệ hoàn vốn và lợi nhuận 

trên diện tích sàn cao, nhà chọc trời trở thành một xu hƣớng phát triển chung của loài 

ngƣời. Mặt khác, nhà cao tầng cũng đƣợc xem nhƣ biểu tƣợng của sức mạnh kinh tế. 

Kể từ cuối thập niên 1980, Hồng Kông và Trung Quốc đóng góp một số công 

trình nhà cao tầng nổi tiếng, bao gồm nhà băng Trung quốc và trung tâm tài chính 

quốc tế. Trên thế giới bộ ba Chicago, Hồng Kông và New York đƣợc xem là ba ông 

lớn về nhà cao tầng trên thế giới. 

Trong số 10 tòa nhà cao nhất thế giới hiện nay, Châu Á chiếm tới 8 và giữ ngôi 

vị quán quân của Châu Á vẫn là tháp Taipei 101 với chiều cao 509 m. Hiện nay, Châu 

Á đua nhau xây nhà cao nhất thế giới. 

Bƣớc vào thế kỷ 21, ngay cả những nƣớc giàu có về dầu lửa ở Trung Đông cũng 

chƣa thể so với các thành phố Châu Á trong cuộc đua xây dựng các tòa nhà cao chọc 

trời. Tuy nhiên, cuối năm 2008, Taipei 101 đã phải nhƣờng ngôi vị cao nhất thế giới 

cho tòa tháp Burj ở Dubai, Tiểu vƣơng quốc Arập thống nhất. Tháp Burj do hãng kiến 

trúc Mỹ thiết kế cao tới 800 m với 160 tầng dùng làm khách sạn, siêu thị, văn phòng 

cho thuê và căn hộ sang trọng. 

Taipei 101 cao nhất của Châu Á cũng sẽ bị một tòa nhà khác ở Châu Á hoàn 

thành vào năm 2010 hoặc 2011 vƣợt mặt. Đó là tháp Thiên niên kỷ ở thành phố cảng 

Busan (Hàn Quốc) với chiều cao 560 m. 

Ngày nay, thành phố nào may mắn mới giữ đƣợc kỷ lục trong hơn nửa thập kỷ. 

Tháp đôi Petronas (Kuala lumpur) hoàn thành năm 1998 đã bị tháp Taipei 101 vƣợt 

qua năm 2004. Tuy nhiên, Tháp Taipei 101 chỉ giữ đƣợc kỷ lục trong 4 năm bởi tháp 

Burj (Dubai) đã hoàn thành và đƣa vào sử dụng. 

 

Hình 1. 4. Chiều cao các tòa nhà nổi tiếng trên thế giới. 

Việc đua nhau xây các tòa nhà chọc trời còn chứng tỏ tiềm lực kinh tế của các 

quốc gia và vùng lãnh thổ. Thành phố công nghiệp Thƣợng Hải (Trung Quốc) từ 
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những năm 1990 đã đƣợc ví nhƣ Manhattan của Châu Á với hàng loạt tòa nhà cao chót 

vót. Nổi tiếng nhất ở Thƣợng Hải là tháp Jin Mao với 88 tầng, 421 m là tòa nhà cao 

nhất Trung Quốc. Tuy nhiên, Thƣợng Hải đã có thêm một tòa nhà cao chọc trời nữa là 

Trung tâm Tài chính thế giới với chiều cao 492 m vào năm 2008. 

Nhà cao tầng ở Việt Nam: 

Trong khoảng hai mƣơi năm trở lại đây, đất nƣớc ta đã xây dựng rất nhiều công 

trình nhà cao tầng. Các công trình nhà cao tầng đã đem lại cho các đô thị Việt Nam 

một cảnh quan mới, một không gian kiến trúc hiện đại, tạo ra biểu tƣợng cho nền văn 

minh và tiến bộ xã hội. Việt Nam trong những năm gần đây số lƣợng nhà có số tầng từ 

20 trở lên tăng rất nhanh: SaiGon Plaza 33 tầng, Hanoi Tower 25 tầng, Vetcombank 

Tower 68 tầng (đang xây dựng), Khách sạn Melia 22 tầng, khu đô thị Trung Hòa 34 

tầng, chung cƣ Sông Đà ở Km10 Nguyễn Trãi 34 tầng; Keangnam Hanoi Landmark 

Tower 345m (70 tầng), Tháp Dầu khí Việt Nam 79 tầng (dự kiến xây dựng), Trung 

tâm tài chính Bitexco 262,5m (68 tầng), Hanoi City Complex 195m (65 tầng)... 

Sự phát triển của nhà cao tầng tạo điều kiện cho sự phát triển các hệ kết cấu chịu 

lực đặc biệt là các hệ kết cấu chịu tải trọng ngang. 

Bảng 1. 1. Một số công trình nhà cao tầng ở Việt Nam 

Công trình Số tầng Cao, m 

Keangnam Hanoi Landmark Tower 72 336 

Lotte Center Hà Nội 65 267 

Bitexco Financial Tower (TPHCM) 68 262,5 

Keangnam Hanoi Landmark Tower A (Hà Nội) 48 212 

Keangnam Hanoi Landmark Tower B (Hà Nội) 48 212 

Vietcombank Tower (TPHCM) 40 206 

Saigon One Tower (TPHCM) 42 195,3 

Diamond Flower Tower (Hà Nội) 40 177 

Da Nang City Hall 34 166,9 

1.3. Phân loại nhà cao tầng 

Phân loại theo mục đích sử dụng: nhà ở; nhà làm việc và các dịch vụ khác; khách 

sạn. 

Phân loại theo hình dạng: 

Nhà tháp: mặt bằng hình tròn, tam giác, vuông, đa giác đều  cạnh,  trong đó giao 

thông theo phƣơng đứng tập trung vào một khu vực duy nhất. 
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Nhà dạng thanh: mặt bằng chữ nhật, trong đó có nhiều đơn vị giao thông theo 

phƣơng thẳng đứng. 

Phân loại theo chiều cao nhà (Ủy ban nhà cao tầng Quốc tế): 

Nhà cao tầng loại I:   09 - 16 tầng (cao nhất 50m); 

Nhà cao tầng loại II:  17 - 25 tầng (cao 50m-75m); 

Nhà cao tầng loại III: 26 - 40 tầng (cao 75m-100m); 

Nhà cao tầng loại IV: 40 tầng trở lên (trên 100m, siêu cao tầng). 

Phân loại theo vật liệu cơ bản dùng để thi công kết cấu chịu lực: nhà cao tầng 

bằng bê tông cốt thép; nhà cao tầng bằng thép; nhà cao tầng có kết cấu tổ hợp bằng Bê 

tông cốt thép và thép. 

Phân loại theo dạng kết cấu chịu lực: Kết cấu thuần khung; kết cấu tấm (vách); 

kết cấu hệ lõi “Kết cấu hệ ống”; kết cấu hỗn hợp. 

Các nƣớc trên thế giới tùy theo sự phát triển nhà cao tầng của mình mà có cách 

phân loại khác nhau. Hiện nay ở nƣớc ta đang có xu hƣớng theo sự phân loại của ủy 

ban Nhà cao tầng Quốc tế. 

Về mặt kết cấu, một công trình đƣợc định nghĩa là cao tầng khi độ bền vững và 

chuyển vị của nó do tải trọng ngang (gió, động đất) quyết  định. Mặc dù chƣa có sự 

thống nhất chung nào về định nghĩa nhà cao tầng nhƣng có một ranh giới đƣợc đa số 

các Kỹ sƣ kết cấu chấp nhận, đó là từ nhà thấp tầng sang nhà cao tầng có sự chuyển 

tiếp từ phân tích tĩnh học sang phân tích động  học khi nhà chịu tác động của tải gió, 

động  đất... tức là vấn đề  dao động và ổn định nói chung. 

Các công trình nhà cao tầng ngày càng cao hơn, nhẹ hơn và mảnh hơn so với  các 

nhà cao tầng trong quá khứ. Các nghiên cứu trên thế giới cũng khẳng định xu hƣớng 

này trong tƣơng lai, thông qua các kết quả so sánh cho thấy các công trình có độ mảnh 

cao đồng thời cũng mang lại hiệu quả kinh tế cao hơn. 
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Chương 2 

 CÁC HỆ KẾT CẤU CHỊU LỰC NHÀ CAO TẦNG 

2.1. Khái niệm về các hệ kết cấu chịu lực 

2.1.1. Đặc điểm chịu lực nhà cao tầng 

Do số lƣợng tầng nhiều nên tải trọng bản thân và tải trọng sử dụng thƣờng rất 

lớn, thƣờng bố trí trên mặt bằng nhỏ, nên cấu tạo móng rất phức tạp. Vì vậy đa số công 

trình đều lựa chọn giải pháp móng sâu (móng cọc đóng, cọc khoan nhồi..); 

Nhà cao tầng thƣờng rất nhạy cảm đến độ lún lệch của móng. Nó ảnh hƣởng đến 

khả năng chịu lực của công trình do độ cao công trình rất lớn; 

Chịu tác dụng của tải trọng ngang lớn nhƣ: gió, động đất …; 

Sự phân bố độ cứng của công trình theo độ cao nhằm hạn chế chuyển vị ngang 

cũng nhƣ việc giảm khối lƣợng tham gia các thành phần dao động của công trình có 

ảnh hƣởng rất lớn đến khả năng chịu lực của công trình; 

Nhà cao tầng thƣờng có điều kiện thi công phức tạp, quy trình thi công rất 

nghiêm ngặt và yêu cầu độ chính xác cao; 

Khả năng đảm bảo về thông gió, cấp thoát nƣớc, phòng chống cháy nổ, giao 

thông... là rất phức tạp. 

Đối với những ngôi nhà có chiều cao từ 40m trở lên, kết cấu chịu lực phải đƣợc 

tính toán cả với thành phần động của tải trọng gió và kiểm tra theo tải trọng động đất 

từ cấp 7 trở lên (theo thang MSK-64) đƣợc xem là nhà cao tầng. 

Bảng 2. 1. Chiều cao lớn nhất thích hợp cho nhà BTCT liền khối (m) 

Hệ kết cấu 
Không có 

động đất 

Cấp động đát thiết kế (MSK-64) 

6 7 8 9 

Khung 60 60 55 45 25 

Khung – Vách - Lõi 130 130 120 100 50 

Vách – Tƣờng cứng 140 140 120 100 60 

Lõi - ống, ống trong ống 180 180 150 120 70 

Ghi chú: Độ cao nhà đƣợc tính từ mặt đất ngoài nhà đến diềm mái công trình, 

không kể độ cao của các bộ phận nhô lên khỏi mái nhƣ bể nƣớc, buồng thang máy; 

2.1.2. Đặc điểm sử dụng vật liệu 

Nhà cao tầng yêu cầu khắc khe về vật liệu chịu lực và bao che. 

- Trong nhà cao tầng các cấu kiện đều chịu các tải trọng thẳng đứng và tải trọng 

ngang lớn. Để đủ khả năng chịu lực đồng thời đảm bảo tiết diện các kết cấu thanh nhƣ 

cột, dầm, các kết cấu bản nhƣ sàn, tƣờng có kích thƣớc hợp lý, phù hợp với giải pháp 
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kiến trúc mặt bằng và không gian sử dụng, vật liệu dùng trong kết cấu nhà cao tầng 

cần có cấp độ bền chịu kéo, nén, cắt cao. Thƣờng dùng bê tông B25 đến B60 (tƣơng 

đƣơng mác 300 đến 800) và cốt thép có giới hạn chảy từ 300 MPa trở lên. 

- Bê tông là vật liệu đàn - dẻo, nên có khả năng phân phối lại nội lực trong các 

kết cấu, sử dụng rất hiệu quả khi chịu tải trọng lặp lại (động đất, gió bão). Bê tông có 

tính liền khối cao giúp cho các bộ phận kết cấu liên kết lại thành một hệ chịu lực theo 

các phƣơng tác động của tải trọng. Tuy vậy, bê tông có trọng lƣợng bản thân lớn nên 

thƣờng đƣợc sử dụng có hiệu quả cho các ngôi nhà dƣới 30 tầng. Khi nhà cao trên 30 

tầng nhất thiết phải dùng bê tông có cấp cƣờng độ cao, bê tông ứng lực trƣớc hay bê 

tông cốt cứng (hàm lƣợng cốt thép cứng µ≤15%) hoặc dùng kết cấu thép hoặc kết cấu 

thép - bê tông liên hợp. 

- Trong nhà cao tầng thƣờng sử dung các lƣới côt rộng từ 6x6 m
2
 trở lên nhƣng 

chiều cao tầng điển hình thƣờng không lớn, nên giải pháp kết cấu sàn phải lựa chọn 

sao cho các dầm đỡ sàn có chiều cao tối thiểu. Bởi vậy bê tông ứng lực trƣớc thƣờng 

đƣợc sử dụng cho kết cấu sàn đổ toàn khối hay lắp ghép nhất là hệ sàn phẳng không 

dầm. Ngoài kết cấu chịu lực, kết cấu bao che trong nhà cao tầng cũng chiếm tỷ lệ đáng 

kể trong tổng khối lƣợng công trình. Bởi vậy cần sử dụng các vật liệu nhẹ, có khối 

lƣợng riêng nhỏ, tạo điều kiện giảm đáng kể không những chỉ dối với tải trọng thẳng 

đứng mà còn cả đối với tải trọng ngang do lực quán tính gây ra. 

2.1.3. Các hệ kết cấu chịu lực nhà cao tầng 

Các cấu kiện chịu lực chính tạo thành các hệ chịu lực nhà cao tầng bao gồm: 

Cấu kiện dạng thanh: cột, dầm, thanh chống, thanh giằng; 

Cấu kiện dạng tấm: Tƣờng (vách), sàn. 

Trong nhà cao tầng, khi có sự hiện diện của các khung thì tuỳ theo các làm việc 

của các cột trong khung mà hệ kết cấu chịu lực đƣợc phân thành các loại sơ đồ: sơ đồ 

khung; sơ đồ giằng; và sơ đồ khung- giằng. 

Trong nhà cao tầng, sàn các tầng, ngoài khả năng chịu uốn do tải trọng thẳng 

đứng, còn phải có độ cứng lớn để không bị biến dạng trong mặt phẳng khi truyền tải 

trọng ngang vào cột, vách, lõi nên còn gọi là những sàn cứng. 

Cấu kiện không gian là các vách nhiều cạnh hở hoặc khép kín, tạo thành các hộp 

bố trí bên trong nhà, đƣợc gọi là lõi cứng. Ngoài lõi cứng bên trong, còn có các dãy cột 

bố trí theo chu vi nhà với khoảng cách nhỏ tạo thành một hệ khung biến dạng tƣờng 

vây. Tiết diện các cột ngoài biên có thể đặc hoặc rỗng. Khi là những cột rỗng hình hộp 

vuông hoặc hình tròn sẽ tạo nên hệ kết cấu đƣợc gọi là ống trong ống. Dạng kết cấu 

này thƣờng sử dụng trong nhà có chiều cao lớn. 

Phụ thuộc vào các giải pháp kiến trúc, từ 3 thành phần kết cấu chính (cấu kiện 

dạng thanh, tấm, không gian) có thể liên kết tạo thành 2 nhóm kết cấu chịu lực: 

Nhóm 1: Gồm 1 cấu kiện chịu lực độc lập – khung, tƣờng, vách, lõi hộp (ống); 
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Nhóm 2: Hệ chịu lực đƣợc tổ hợp từ 2 hoặc 3 cấu kiện cơ bản trở lên: 

- Kết cấu KHUNG + VÁCH; 

- Kết cấu KHUNG + LÕI; 

- Kết cấu KHUNG + VÁCH + LÕI v.v… 

 

Hình 2. 1. Sơ đồ tổ hợp các hệ chịu lực nhà cao tầng. 

Sự phân chia trên chỉ là quy ƣớc tƣơng ứng với từng giả thiết và mô hình tính 

toán công trình cụ thể, và phụ thuộc vào chiều cao (H), tỷ lệ giữa chiều rộng (B) và 

chiều dài (L) mặt bằng nhà v.v... Khi H tăng lên thì vai trò khung cột dầm giảm dần 

đối với tác động của tải trọng ngang. Dầm, cột khung chủ yếu chịu các loại tải trọng 

thẳng đứng truyền từ sàn tầng vào. Bởi vậy trong thực tế, ngay cả các hệ vách, lõi, ống 

vẫn luôn kết hợp với hệ thống khung cột đƣợc bố trí theo các ô lƣới nhất định, phù hợp 

với giải pháp mặt bằng kiến trúc. 

2.1.3.1. Hệ khung chịu lực 

- Các khung ngang và khung dọc liên kết thành 1 khung phẳng hoặc khung 

không gian, tải lên khung bao gồm tải trong theo phƣơng đứng và phƣơng ngang. Để 

đảm bảo độ cứng tổng thể cho công trình nút khung phải là nút cứng.  

 

Hình 2. 2. Sơ đồ hệ khung chịu lực. 

- Dƣới tác dụng của tải trọng, các thanh cột và dầm vừa chịu uốn, cắt vừa chịu 

kéo, nén. Chuyển vị của khung gồm 2 thành phần chuyển vị ngang do uốn khung nhƣ 

chuyển vị ngang của thanh côngxon thẳng đứng, tỷ lệ này khoảng 20%. Chuyển vị 

ngang do biến dạng của các thanh thành phần, chiếm khoảng 80% (trong đó do dầm 

biến dạng khoảng 65%; do cột biến dạng khoảng 15%). 

KHUNG

LOÕI

OÁNGVAÙCH
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- Khung có độ cứng ngang bé, khả năng chịu tải không lớn, thông thƣờng khi 

lƣới cột bố trí đều đặn, trên mặt bằng khoảng 6-9 m, chỉ nên áp dụng cho nhà dƣới 30 

tầng.  

- Về tổng thể, biến dạng ngang của khung cứng thuộc loại biến dạng cắt. 

- Khung thuần túy nên sử dụng cho nhà có chiều cao dƣới 40 m. Trong kiến trúc 

nhà cao tầng luôn có những bộ phận nhƣ hộp thang máy, thang bộ, tƣờng ngăn hoặc 

bao che liên tục trên chiều cao nhà có thể sử dụng nhƣ lõi, vách cứng nên hệ kết cấu 

khung chịu lực thuần tuý trên thực tế không tồn tại.  

- Để tăng độ cứng ngang của khung, có thể bố trí thêm các thanh xiên tại một số 

nhịp trên suốt chiều cao của nó, phần kết cấu dạng dàn đƣợc tạo thành sẽ làm việc nhƣ 

một vách cứng thẳng đứng. Nếu thiết kế thêm các dàn ngang (tầng cứng-OUTRIGER) 

ở tầng trên cùng hoặc ở 1 số tầng trung gian liên kết khung còn lại với dàn đứng thì 

hiệu quả tăng độ cứng sẽ tăng lên và làm giảm thiểu chuyển vị ngang. Dƣới tác động 

của tải trọng ngang, kết cấu dàn ngang sẽ đóng vai trò phân phối lực dọc giữa các cột 

khung, cản trở chuyển vị xoay của cả hệ và giảm mômen uốn ở dƣới khung. 

- Hệ kết cấu khung sử dụng hiệu quả cho công trình có không gian lớn,  bố trí nội 

thất linh hoạt, phù hợp với nhiều loại công trình. Tuy nhiên hệ khung có khả năng chịu 

cắt theo phƣơng ngang kém. Ngoài ra hệ thống dầm thƣờng có chiều cao lớn nên ảnh 

hƣởng đến không gian sử dụng và làm tăng độ cao của công trình. 

- Chiều cao nhà thích hợp cho kết cấu BTCT là không quá 30 tầng. Nếu trong 

vùng có động đất từ cấp 8 trở lên  thì chiều cao khung phải giảm xuống. Chiều cao tối 

đa của ngôi nhà còn phụ thuộc vào số bƣớc cột, độ lớn các bƣớc, tỷ lệ chiều cao và 

chiều rộng nhà. 

2.1.3.2. Hệ tường chịu lực 

Là một hệ tấm tƣờng phẳng vừa làm nhiệm vụ chịu tải trọng đứng, vừa là hệ 

thống chịu tải trọng ngang và là tƣờng ngăn giữa các phòng. Căn cứ vào cách bố trí 

các tấm tƣờng chịu tải trọng thẳng đứng chia làm 3 sơ đồ: 

Tƣờng dọc chịu lực. 

Tƣờng ngang chịu lực. 

Tƣờng dọc và ngang cùng chịu lực. 

 

Hình 2. 3. Sơ đồ hệ tƣờng chịu lực. 

Trong các nhà mà tƣờng chịu lực chỉ đặt theo một phƣơng, sự ổn định của công 

trình theo phƣơng vuông góc đƣợc đảm bảo nhờ các vách cứng. Nhƣ vậy, vách cứng 

đƣợc hiểu theo nghĩa là các tấm tƣờng thiết kế để chịu tải trọng ngang. Trong thực tế, 
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đối với nhà cao tầng, tải trọng ngang bao giờ cũng chiếm ƣu thế nên các tấm tƣờng 

chịu lực đƣợc thiết kế để vừa chịu tải trọng ngang vừa chịu tải trọng đứng. Các tấm 

tƣờng đƣợc làm bằng BTCT có khả năng chịu cắt và chịu uốn tốt nên đƣợc gọi là vách 

cứng. 

Để đảm bảo độ cứng không gian cho công trình nên bố trí vách cứng theo cả hai 

phƣơng dọc và ngang nhà. Số lƣợng vách theo mỗi phƣơng xác định theo khả năng 

chịu tải trọng theo phƣơng đó. Ngoài ra, vách cứng cũng nên bố trí sao cho công trình 

không bị xoắn khi chịu tải trọng ngang. 

Tải trọng ngang đƣợc truyền đến các tấm tƣờng chịu tải thông qua hệ các bản sàn 

đƣợc xem là tuyệt đối cứng trong mặt phẳng của chúng. Do đó các vách cứng làm việc 

nhƣ những dầm công xon có chiều cao tiết diện lớn. Khả năng chịu tải của các vách 

cứng phụ thuộc nhiều vào hình dáng và kích thƣớc tiết diện ngang của nó. Các vách 

cứng thƣờng bị giảm yếu do có các lỗ cửa, số lƣợng, vị trí, kích thƣớc lỗ cửa ảnh 

hƣởng quyết định đến khả năng làm việc của chúng. 

 

Hình 2. 4. Hình dạng các vách cứng. 

Các đặc điểm cơ bản của hệ tường chịu lực:  

Các vách cứng đổ tại chỗ có tính liền khối tốt, độ cứng theo phƣơng ngang lớn.  

Khả năng chịu động đất tốt: kết quả nghiên cứu thiệt hại do các trận động đất lớn 

gây ra, cho thấy rằng: các công trình có vách cứng bị hƣ hỏng tƣơng đối nhẹ, trong khi 

các công trình có kết cấu khung bị hƣ hỏng nặng hoặc sụp đổ.  

Hệ vách cứng có trọng lƣợng lớn, độ cứng kết cấu lớn nên tải trọng động đất tác 

động lên công trình có giá trị lớn. Đây là đặc điểm bất lợi cho công trình thiết kế chịu 

động đất.  

Hệ kết cấu này thích hợp cho các công trình mà có không gian bị ngăn chia bên 

trong nhƣ nhà ở, khách sạn, bệnh viện.. và cho các công trình có chiều cao dƣới 40 

tầng.  

Hiện nay VLXD đa dạng nên cấu tạo tấm tƣờng cũng đa dạng. Ngoài việc xây 

bằng gạch đá, hệ lƣới thanh tạo thành các cột đặt ngần nhau liên kết qua các dầm 

ngang, xiên cũng đƣợc xem là loại kết cấu này. 

2.1.3.3. Hệ lõi chịu lực 

Lõi có dạng vỏ hộp rỗng tiết diện kín hoặc hở, chịu tải trọng đứng và ngang tác 

dụng lên công trình và truyền xuống đất nền. Lõi có thể xem là sự kết hợp của nhiều 

tấm tƣờng theo các phƣơng khác nhau. Trong lõi có thể bố trí hệ thống kỹ thuật, thang 

bộ, thang máy... Sau đây là một số cách bố trí thông dụng: 

- Nhà lõi tròn, vuông, chữ nhật, tam giác.. (kín hoặc hở). 
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- Nhà có một lõi hoặc hai lõi. 

- Lõi nằm trong nhà hoặc theo chu vi nhà hoặc có một phần nằm ngoài. 

 

Hình 2. 5. Các hệ lõi chịu lực. 

Trƣờng hợp nhà có nhiều lõi cứng thì chúng đƣợc đặt xa nhau và các sàn đƣợc 

tựa lên hệ thống dầm lớn liên kết với các lõi. Các lõi cứng đƣợc bố trí trên mặt bằng 

nhà sao cho tâm cứng của công trình trùng với trọng tâm của nó để tránh bị xoắn khi 

dao động. 

Lõi cứng làm việc nhƣ một consol lớn ngàm vào mặt móng công trình, lõi có tiết 

diện kín, hở hoàn toàn hoặc nửa hở, tuy nhiên thực tế lõi cứng thƣờng có tiết diện hở 

hoặc nửa hở. 

Đây là hệ kết cấu đƣợc sử dụng khá phổ biến, có thể sử dụng cho những công 

trình có số tầng lên đến 60-70 tầng. 

 

Hình 2. 6. Công trình “The Miglin-Beiler Tower” ở Chicago (Hoa Kỳ). 

Hình dƣới mô tả công trình “The Miglin-Beiler Tower” ở Chicago (Hoa Kỳ) có 

phần kết cấu thân không kể tháp thép ở trên cao 443,2m sử dụng hệ kết cấu lõi chịu 

lực, trong đó ở giữa công trình đặt một lõi bê tông cốt thép chịu lực chính có bề dày 
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giảm dần từ 0,91m đến 0,46m, ngoài ra xung quanh đƣợc bố trí thêm một số cột thép 

rỗng nhồi bê tông và một số dàn thép ở biên để tăng độ cứng tổng thể. 

2.1.3.4. Hệ hộp chịu lực 

Ở hệ này, các bản sàn đƣợc gối lên các kết cấu chịu tải nằm trong mặt phẳng 

tƣờng ngoài mà không cần các gối trung gian khác bên trong.  

Hệ hộp với giải pháp lƣới không gian có các thanh chéo thƣờng dùng cho các 

nhà có chiều cao lớn. 

 

Hình 2. 7. Các hệ hộp chịu lực. 

Xuất phát từ sự phát triển của vật liệu bê tông cốt thép, nhiều công trình có chiều 

cao lớn đã đƣợc xây dựng. Sau một thời gian thực tế đã chứng minh rằng với những 

công trình quá cao (trên 30 tầng) thì việc sử dụng hệ kết cấu khung là không kinh tế do 

kích thƣớc của dầm và cột quá lớn ảnh hƣởng nhiều đến không gian sử dụng, kết cấu 

móng. Nếu sử dụng các hệ vách, lõi ở bên trong công trình thì thƣờng công trình 

không đủ độ cứng, độ ổn định tổng thể cần  thiết. Từ đó hệ kết cấu hộp xuất hiện nhằm 

đáp ứng yêu cầu đặt ra cho công trình siêu cao tầng. 

Hệ kết cấu gồm các cột đặt dày đặc trên toàn bộ chu vi công trình đƣợc liên kết 

với nhau nhờ hệ thống dầm ngang gọi là kết cấu hộp (còn gọi là kết cấu ống). 

Hệ hộp chịu tất cả tải trọng đứng và tải trọng ngang. Các bản sàn đƣợc gối lên 

các kết cấu chịu tải nằm trong mặt phẳng tƣờng ngoài mà không cần các kết cấu trung 

gian khác bên trong. Khi các cột đặt thƣa nhau thì kết cấu làm việc theo sơ đồ khung, 

khi các cột đặt kề nhau và hệ dầm có độ cứng lớn thì dƣới tác dụng của tải trọng ngang 

kết cấu làm việc nhƣ một consol. Trong thực tế, khoảng cách giữa các cột biên đặt 

theo một mức độ cho phép cho nên kết cấu ống, thực chất nằm trung gian giữa sơ đồ 

biến dạng consol và sơ đồ khung. 

Các giải pháp kết cấu cho vỏ hộp: 

- Dùng các lƣới ô vuông tạo thành từ các cột đặt cách nhau ở khoảng cách bé với 

các dầm ngang có chiều cao lớn. Hệ kết cấu này rất phù hợp  với bản chất toàn khối 

của kết cấu bê tông cốt thép. Tuỳ thuộc vào chiều cao và kích thƣớc mặt bằng công 

trình mà khoảng cách giữa các cột có thể từ 1,5m đến 4,5m, chiều cao của dầm từ 0,6 

đến 1,2m. Dùng cho nhà cao từ 40-60 tầng. 
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 - Dùng lƣới không gian với các thanh chéo: tạo thành lƣới ô vuông từ cột và 

dầm, tạo thành ô lƣới quả tràm có hoặc không có thanh ngang. Dùng cho nhà có chiều 

cao cực lớn trên 80 tầng. Tác dụng của thanh chéo: làm tăng độ cứng ngang và chống 

xoắn của công trình, khắc phục tính biến dạng của dầm ngang. Các thanh chéo không 

chỉ tạo ra một hệ giàn phẳng mà còn hoạt động tƣơng hỗ với các giàn trong mặt phẳng 

vuông góc tạo thành hình chữ X giữa các cột góc trên mặt đứng. 

 - Nhìn chung hệ hộp là hệ kết cấu đƣợc sử dụng chính với những công trình cao 

chọc trời dạng tháp (Tower). 

Hình dƣới mô tả công trình “JinMao Tower” ở Thƣợng Hải cao 421m (87 tầng) 

sử dụng hệ kết cấu hộp giàn không gian, trong đó giữa nhà bố trí một lõi bê tông cốt 

thép bề dày giảm dần từ 0,84m đến 0,46m, và một hệ giàn thép bao bên ngoài công 

trình liên kết các hệ cột ở biên. 

 

Hình 2. 8. Công trình “JinMao Tower” ở Thƣợng Hải. 

2.1.3.5. Hệ hỗn hợp: KHUNG-TƯỜNG (Vách) chịu lực 

Về mặt cấu tạo, kết cấu hệ hỗ hợp đƣợc cấu tạo từ sự kết hợp giữa 2 hay nhiều hệ 

kể trên: KHUNG-VÁCH; KHUNG-LÕI; KHUNG-HỘP; KHUNG-VÁCH-LÕI 

Ở hệ KHUNG-VÁCH có 2 sơ đồ sau: SƠ ĐỒ GIẰNG và SƠ ĐỒ KHUNG-

GIẰNG. 

Sơ đồ giằng: Các liên kết cột-dầm là khớp. Ở sơ đồ này, khung chỉ chịu 1 phần 

tải trọng thẳng đứng tƣơng ứng với diện tích truyền tải đến nó, còn toàn bộ tải trọng 

ngang do hệ tƣờng chịu lực chịu. Sự làm việc của nhà tƣơng tự nhƣ hệ tƣờng chịu lực 

chịu tải trọng ngang. 

Sơ đồ khung-giằng: Khi các cột liên kết cứng với dầm. Ở sơ đồ này, khung cùng 

tham gia chịu tải trọng (đứng và ngang) với tƣờng. Tính chất làm việc của sơ đồ này 

tƣơng tự nhƣ hệ khung cứng có các giằng đứng. 
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Hình 2. 9. Hệ hỗn hợp Khung – Tƣờng (Vách) chịu lực. 

 

Hình 2. 10. Sơ đồ giằng. 

 

Hình 2. 11. Sơ đồ khung – giằng. 

2.1.3.6. Hệ KHUNG-LÕI chịu lực 

Phụ thuộc vào liên kết cột-dầm hệ này cũng đƣợc chia thành 2 sơ đồ. Trong hệ 

kết hợp này, tải trọng ngang hầu nhƣ chỉ truyền vào hệ lõi cứng còn hệ khung chỉ chủ 

yếu chịu phần tải trọng đứng trong phạm vi của nó, do vậy khi bố trí hệ kết cấu cần 

chú ý: 
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- Bố trí tâm cứng của hệ lõi càng gần với tâm đặt tải trọng càng tốt để hạn chế 

gây mômen xoắn; 

- Bố trí chu vi của hệ lõi càng lớn càng tốt để tăng khả năng ổn định tổng thể;  

- Đƣa các hệ khung ra chu vi để tận dụng khả năng chịu uốn tốt của khung và 

hình thành nên hệ khối không gian để tăng độ cứng tổng thể cả chịu uốn và chịu xoắn 

của công trình. 

 

Hình 2. 12. Hệ khung – lõi chịu lực. 

2.1.3.7. Hệ KHUNG-HỘP chịu lực 

  

Hình 2. 13. Nhà có vách cứng dạng dàn. 

 

Hình 2. 14. Sơ đồ biến dạng của hệ kết cấu. 
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Hệ này có thể đƣợc thiết kế theo 2 sơ đồ nhƣ các hệ hỗn hợp trên. Ở sơ đồ giằng 

với khung khớp, tải trọng ngang sẽ gây ra các chuyển vị dọc khác nhau giữa các cột 

bên trong và thành hộp bên ngoài. Độ chênh chuyển vị dọc sẽ làm cho các vách ngăn 

bị nứt và gây rối loạn các liên kết. Để tránh hiện tƣợng này cần thiết kế thêm các dàn 

ngang ở 1 số cao trình nhà. Các dàn cứng ngang này cũng làm tăng hiệu quả của hệ 

hỗn hợp trong sơ đồ khung giằng khi khung cứng cùng tham gia chịu tải trọng ngang 

cùng với vỏ hộp. 

2.1.3.8. Hệ HỘP-TƯỜNG chịu lực 

Ở hệ này các tấm tƣờng chịu tải đƣợc bố trí bên trong hộp và cũng tham gia chịu 

tải (đứng và ngang) cùng với vỏ hộp. Hệ có các sơ đồ sau:  

- Hộp-tƣờng ngang chịu tải; 

- Hộp-tƣờng dọc chịu tải; 

- Hộp-tƣờng dọc và tƣờng ngang chịu tải (hệ hộp nhiều ngăn). 

2.1.3.9. Hệ HỘP-LÕI chịu lực (ống trong ống) 

Hộp là những lõi có kích thƣớc lớn thƣờng đƣợc bố trí cả bên trong và gần biên 

ngôi nhà. Khác với hệ khung-lõi, hệ hộp chịu lực toàn bộ tải trọng đứng và ngang do 

sàn truyền vào, không có hoặc rất ít cột trung gian đỡ sàn. 

 

Hình 2. 15. Các giải pháp lõi - ống, ống trong ống. 

Hộp trong nhà cũng giống nhƣ lõi, đƣợc hợp thành từ các tƣờng đặc hoặc có lỗ; 

Hộp ngoài biên có diện tích mặt phẳng lớn, đƣợc tạo thành từ cãc cột có khoảng 

cách nhỏ liên kết với nhau bởi các thanh ngang có chiều cao lớn theo hai phƣơng 

ngang hoặc chéo tạo nện những mặt nhà dạng khung - lƣới, có hình dáng phù hợp với 

các giải pháp kiến trúc mặt đứng. Tiết diện cột ngoài biên có thể đặc hoặc rỗng tạo nên 

những dãy ống nhỏ nên còn gọi là kết cấu hộp trong hộp hay ống trong ống, thƣờng 

đƣơc sử dụng trong các ngôi nhà rất cao. 

Ở hệ hỗn hợp này cả hộp và lõi đều tham gia chịu tải trọng đứng và ngang. Các 

bản sàn liên kết 2 bộ phận chịu lực này lại và chúng sẽ làm việc nhƣ 1 hệ duy nhất khi 

tải trọng ngang xuất hiện. 
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Phần hộp ngoài chịu phần lớn tải trọng ngang ở phía trên, trong khi đó phần lõi 

cứng lại chịu phần lớn tải trọng ngang ở phía dƣới nhà. 

2.1.3.10. Hệ TƯỜNG-LÕI chịu lực 

Ở hệ này phần lõi chịu lực đƣợc bố trí ở bên trong nhà, còn các tấm tƣờng đƣợc 

bố trí phía ngoài, vừa làm nhiệm vụ phân chia không gian vừa làm nhiệm vụ chịu tải. 

2.1.3.11. Hệ KHUNG - VÁCH - LÕI 

 

Hình 2. 16. Kết cấu khung – vách – lõi.  

Lựa chọn hệ chịu lực theo số tầng: 

 

Hình 2. 17. Sơ đồ lựa chọn hệ kết cấu theo số tầng. 
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Đây là một hệ kết hợp khá phổ biến và hiệu quả cao trong kết cấu nhà cao tầng. 

Khi bố trí hệ kết  cấu  khung - vách - lõi cần chú ý: 

- Bố trí các hệ lõi đối xứng ở tâm nhà để tăng khả năng chịu uốn. 

- Bố trí các vách phẳng kết hợp với hệ khung phẳng ở biên để vừa chịu uốn vừa 

chịu cắt đồng thời tăng khả năng chống xoắn. 

Trong thiết kế và xây dựng nhà cao tầng, việc lựa chọn hệ kết cấu chịu lực hợp lý 

phụ thuộc vào nhiều yếu tố nhƣ chiều cao, các điều kiện địa chất thuỷ văn, bản đồ 

phân vùng động đất khu vực hoặc toàn lãnh thổ đất nƣớc và các giải pháp kiến trúc 

công trình. 

Lựa chọn hệ chịu lực theo cấp động đất: 

Để đảm bảo độ cứng, hạn chế chuyển vị ngang, tránh mất ổn định tổng thể cần 

hạn chế chiều cao và độ mảnh (tỷ lệ chiều cao H trên chiều rộng B của công trình) lấy 

theo bảng 2.2. 

Bảng 2. 2. Chiều cao tối đa H (m) và tỷ số giới hạn giữa chiều cao và chiều rộng H/B. 

Hệ kết cấu 
Không có động 

đất 

Có động đất cấp 

6 và 7 8 9 

Nhà khung Max H 

H/B 

60m 

5 

60-55m 

5 

45m 

4 

25m 

2 

Nhà vách và 

khung ống 

Max H 

H/B 

130m 

5 

130-120m 

5 

100m 

4 

50m 

3 

Nhà vách Max H 

H/B 

140m 

6 

140-120m 

6 

120m 

5 

60m 

4 

Nhà ống và ống 

trong ống 

Max H 

H/B 

180m 

6 

180-150m 

6 

120m 

5 

70m 

4 

2.2. Nguyên tắc lựa chọn kết cấu chịu lực nhà cao tầng 

2.2.1. Giải pháp kiến trúc 

Kiến trúc sự sáng tạo và biến đổi hình dạng công trình, xác định qua các kích 

thƣớc hình dạng mặt bằng, hình dạng trên chiều cao đồng thời đã tác động trực tiếp 

đến việc lựa chọn hệ kết cấu chịu tải của nó: bao gồm cả vị trí thiết kế, loại cấu kiện 

chịu tải và vật liệu sử dụng. Khả năng chịu lực của nhà cao tầng dƣới tác động của tải 

trọng ngang về cơ bản đƣợc quyết định bởi giải pháp kiến trúc.  

Khả năng kháng chấn của nhà phụ thuộc vào rất nhiều yếu tố: 

1. Tính đơn giản của kết cấu 

Do sự hiểu biết của ta về sự làm việc của các kết cấu đon giản tốt hơn kết cấu 

phức tạp, các chi tiết cấu tạo và thi công dễ hơn các kết cấu phức tạp, vì thế không nên 

chọn các kết cấu phức tạp. 

2. Kích thƣớc hình khối và mặt bằng nhà 
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Kích thƣớc mặt bằng nhà nên chọn dạng hình vuông, chữ nhật, hình tròn họặc đa 

giác. Đối với nhà có mặt bằng phức tạp nhƣ hình H, I, L, Z, U, E ..., nên chia thành các 

đơn nguyên nhỏ có dạng đơn giản, thông qua việc bố trí các khẹ co giãn, khe lún, khe 

kháng chấn. 

Đối với nhà cỏ mặt bằng hình chữ nhật, cần khống chế tỉ lệ giữa chiều dài nhà L 

và chiều rộng nhà B. Công trình đƣợc xếp vào loại đều đặn có tỉ số L/B≤4 khi có xét 

đến tính kháng chấn cho công trình. Khi nhà có L/B>4, tính kháng chấn của chúng sẽ 

bị giảm, khả năng chống xoắn của nhà giảm. 

Chiều dài tối đa của nhà trong các vùng địa chấn khác nhau, tùy thuộc vào giải 

pháp kết cấu sử dụng, tùy theo các tiêu chuẩn thiết kế. 

 

Hình 2. 18. Một số hình dạng mặt bằng nhà cao tầng. 

Hình khối nhà:  

Hình dạng theo phƣơng đứng khi thiết, kế nhà cao tầng cần đảm bảo tính đối 

xứng qua hai trục hoặc nhiều trục trên mặt bằng. Mặt bằng các tầng nhà không thay 

đổi theo chiều cao ihà hoặc có thay đổi tốt nhất nên giảm dần theo chiều cao, tránh 

thay đổi đột ngột hoặc mở rộng theo chiều cao nhà. Nếu thay đột ngột về số tầng nên 

chia thành các đơn nguyên nhỏ có dạng đơn giản thông qua việc bố trí các khe co giãn, 

khe lún, khe kháng chấn. 

 

Hình 2. 19. Một số hình dạng phù hợp của nhà trên chiều cao. 

Tỷ lệ giữa chiều cao H và chiều rộng nhà B cần hạn chế (theo bảng 2.2): 

Khe khaùng chaán

B

L

B

H

H/B<3,5

<B/4
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Nguyên nhân chủ yếu hạn chế tỷ lệ H/B là 

- Để cho nhà cao tầng đủ độ cứng: hạn chế chuyển vị ngang của nhà; 

- Tránh sự mất ổn định tổng thể của công trình dƣới tác dụng của tải trọng đứng; 

- Ngăn chặn lật của công trình dƣới tác dụng của tải ngang (gió, động đất); 

- Giảm giá trị tần số dao động, gia tốc dao động. 

3. Tính đối xứng (hình học, độ cứng, trọng lực) 

Công trình đƣợc xem là đối xứng qua một, hai hoặc nhiều trục trên mặt bằng 

hoặc trên chiều cao nếu các thông số hình học cùa nó giống hệt nhau ở mỗi phía của 

trục đang xét. 

Tính đối xứng của nhà cỏ thể phân làm 2 loại: 

- Đối xứng trong mặt bằng qụa một hoặc nhiều trục ngang 

- Đối xứng trên chiều cao qua một trục đứng, ngang hoặc cả hai. 

Khi nhà đối xứng qua hai trục thì tâm cứng trùng với trọng tâm nhà, nếu tâm 

cứng không trùng với trọng tâm nhà thì mômen xoắn xuất hiện làm cho nhà bị xoắn, 

mômen xoắn cũng có thể phát sinh nếu tâm khối lƣợng không trùng với trọng tâm nhà 

. .. lúc này các trị nội lực do mômen xoắn gây ra và có thể đó chính là nguyên nhân 

chính dẫn đến sự phá hoại công trình trong thời gian động đất. Tuy nhiên, mô men 

xoắn phát sinh chủ yếu do mặt bằng nhà không đối xứng. 

2.2.2. Giải pháp kết cấu 

2.2.2.1. Tính đồng nhất và liên tục của việc phân bổ độ cứng và cường độ của các 

cấu ki chịu lực 

- Khi thiết kế kháng chấn cần phải tạo ra một sự đồng nhất và liên tục trong việc 

phân độ cứng và cƣờng độ của các cấu kiện chịu tải. 

- Độ cứng của các cấu kiện chịu tải ngang (cột, vách, lõi...) không đổi suốt chiều 

cao phải đồng trục, tránh lệch trục. 

- Tất cả các cột và vách chịu lực đều liên tục và đƣờng truyền tải của nó không bị 

gãy hoặc đứt khúc từ móng đến mái. 

- Tất cả các dầm không có dạng khúc khuỷu (do thay đổi tiết diện dầm), nên bố 

trí lƣới cột sao cho các nhịp dầm gần bằng nhau. 

- Các cột và dầm phải đồng trục, bề rộng các cột và dầm phải gần bằng nhau, để 

dễ dàng cho việc cấu tạo các chi tiết cốt thép và thuận lợi cho việc truyền mô men, lực 

cắt qua chỗ liên kết giữa chúng. Hạn chế dùng dầm bẹt vì thƣờng bị phá hoại cạnh chỗ 

liên kết với cột. 

- Không có cấụ kiện chủ yếu nào bị thay đổi tiết diện đột ngột. 

- Kết cấu càng liên tục và càng liền khối càng tốt, bậc siêu tĩnh càng cao càng tốt. 

- Kết cấu càng liên tục và càng liền khối càng tốt, bậc siêu tĩnh càng cao càng tốt. 
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Hình 2. 20. Khung nhiều nhịp. 

- Đối với kết cấu khung BTCT, độ cứng các dầm tại các nhịp khác nhau cần đƣợc 

thiết kế sao cho độ cứng của nó trên các nhịp đều nhau, tránh nhịp này quá cứng so với 

nhịp khác, điều này gây ra tập trung ứng suất tại các dầm có nhịp ngắn làm cho nó cỏ 

thể bị phá hoại sớm. 

Sơ đồ khung: nên tuân theo các nguyên tắc  

- Nên chọn khung đối xứng: 

- Không nên chọn khung hẩng cột, thông tầng 

 

Hình 2. 21. Các sơ đồ khung không nên chọn và biện pháp khắc phục. 

Phân bố khối lƣợng và độ cứng của cấu kiện chịu tải trong mặt bằng và theo 

chiều cao công trình: 

Phải bố trí sao cho khối lƣợng các tầng không đổi, nếu có thay đổi thì giảm dần 

theo chiều cao nhà và tâm khối lƣợng các tầng nên đồng trục, ữánh lệch trục. 

L
1
=L

2
=L

3

a- Neân choïn

L
1
>L

2
<L

3

b- Khoâng neân choïn

EI
1
>EI

2
<EI

3

c- Bieän phaùp khaéc phuïc

a) b) c)

a) b) c)

d) e)

Daàm cöùng

Conxon daøi

Töông quan ñoä cöùng giöõa coät vaø

daàm: neân choïn

EJ
coät

 > EJ
daàm

a, b, c, e: khoâng neân

d: bieän phaùp khaéc phuïc
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a, b, f – vách cứng bố trí không liên tục, lệch trục: không hợp lý 

c, g – Vách cứng bố trí liên tục, đồng trục: hợp lý 

d, e – Độ cứng phân bố theo chiều cao nhà: không hợp lý 

h, l – Độ cứng phân bố theo chiều cao nhà: hợp lý 

Hình 2. 22. Bố trí vách cứng trong khung. 

 

Hình 2. 23. Phân bố khối lƣợng theo chiều cao. 

2.2.2.2. Bố trí vách cứng 

Trong nhà khung - vách cần tuân theo các yêu cầu sau: 

- Trong mặt bằng nhà hình chữ nhật nên bố trí từ ba vách trở lên theo cả hai 

phƣơng. 

Chieàu cao

Ñoä cöùng

Ñoä cöùng

a b c d e

f g h i

Vaùch cöùng

Truïc vaùch cöùng

Chieàu cao

Khoái löôïng
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- Nên thiết kế các vách giống nhau (về độ cứng cũng nhƣ kích thƣớc hình học) và 

bố trí sao cho tâm cứng của hệ trùng với tâm trọng lực (trọng tâm hình học mặt bằng) 

nhà. Nếu độ lệch tâm này càng lớn công trình có thể bị phá hoại do tác động xoắn. 

 

Hình 2. 24. Vị trí tâm khối lƣợng và tâm cứng trên mặt bằng nhà. 

- Các vách nên có chiều cao chạy suốt từ móng đến mái và có độ cứng không đổi 

trên toàn bộ chiều cao hoặc giảm dần từ dƣới lên trên. 

- Không nên chọn vách có khả năng chịu tải lớn với số lƣợng ít, nên chọn nhiều 

vách có khả năng chịu tải tƣơng đƣơng phân bố đều trên mặt bằng. 

- Không nên chọn khoảng cách giữa các vách và từ vách đến biên quá lớn. 

- Chiều đày vách đổ toàn khối chọn không nhỏ hơn 200 mm và không nhỏ hom 

1/20 chiều cao tầng. 

- Vách cứng trong nhà có thể bổ trí từng nhóm hình L, T, I... 

- Các lỗ cửa trên các vách cần bố trí đều đặn và thẳng hàng từ trên xuống dƣới, 

không bố trí lệch nhau. 

- Việc bố trí số lƣợng và vị trí của các vách cứng, lõi cứng trong nhà cao tầng rất 

quan trọng vì nó ảnh hƣởng đến vị trí tâm cứng, tâm uốn trên mặt băng. Bổ trí các 

vách cứng, lõi cứng trên mặt bằng nên bố trí đối xứng cả hai trục để tâm khối lƣợng 

(M) trùng với tâm cứng (R): (M=R). Nếu tâm (M) không trùng tâm (R) của nhà thì nhà 

sẽ bị xoắn. Độ lệch tâm cùa hai tâm này quyết định tới trị số của mô men xoắn. 

- Theo quan điểm kháng chấn (bố trí vách, lõi cứng) đôi khi mâu thuẫn với quan 

điểm thiết kế chức năng sử dụng công trình, trƣờng hợp này tất cả các yếu tố liên quan 

phải đƣợc xem xét và phân tích đồng thời để chọn giải pháp tối ƣu, sao cho độ lệch 

tâm là bé nhất. 

2.2.2.3. Phân bố độ cứng và cường độ theo phương ngang 

Độ cứng và cƣờng độ kểt cấu nên bố trí đều đặn và, đối xứng trên mặt bằng công 

trình. 

Để giảm độ xoắn khi dao động, tâm cớng của công trình cần đƣợc bổ trí gần 

trọng tâm của nó. 
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Hệ thống chịu lực ngang chính của công trình cần đƣợc bố trí theo hai phƣơng và 

khoảng cách giữa các vách cứng phải nằm trong giới hạn nhất định để có thể xem kết 

cấu sàn không bị biển dạng trong mặt phăng của nó khi chịu tải trọng ngang. 

Bảng 2. 3. Khoảng cách giữa các vách cứng phải thỏa mãn điều kiện: 

Thiết kế không kháng chấn Lv ≤ 5B và Lv ≤ 60 m 

Thiết kế kháng chấn cấp ≤ 7 Lv ≤ 4B và Lv ≤ 50 m 

Thiết kế kháng chấn cấp 8 Lv ≤ 3B và Lv ≤ 40 m 

Thiết kế kháng chấn cấp 9 Lv ≤ 2B và Lv ≤ 30 m 

2.2.2.4. Bố trí lõi cứng 

Đối với nhà có lõi cứng, vị trí của lõi cứng trên mặt bằng sẽ có ảnh hƣởng quyết 

định tới trị số mômen xoắn. Nên bố trí lõi cứng gần trọng tâm nhà, nếu không thể bố 

trí các lõi cứng một cách đối xứng thì cần bổ sung thêm vào hệ kết cấu một vài vách 

cứng chịu tải khác. 

Nhà có chiều cao trên 100m thƣờng dùng hệ lõi, ống, ống trong ống. Vai trò 

khung cột, nếu có chỉ giảm nhịp sàn, hầu nhƣ không tham gia vào tải ngang. Khi hệ 

cột đƣợc bố trí dày đặc dọc theo chu vi công trình và có độ cứng lớn đáng kể so với độ 

cứng của lõi tạo thành một kết cấu khung không gian cùng tham gia chịu lực cùng lõi. 

Việc thiết kế ống cần thỏa mãn các yêu cầu sau: 

- Tỷ số giữa chiều cao và chiều rộng của ống cần lớn hơn 3. 

- Khoảng cách giữa các trụ - ống ngoài chu vi không nên lớn hơn chiều cao tầng 

và nên nhỏ hơn 3 m. Mặt cắt trụ - ống ngoài cần dùng dạng chữ nhật hoặc chữ T. 

- Khoảng cách giữa ống trong và ống ngoài khi không tính động đất không lớn 

hơn 12m, ngƣợc lại không lớn hơn 10m. 

 

a)Một lõi trong;  b, e, g, h) Hai lõi trong;  c) Hai lõi ngoài; 

 f)Ba lõi trong;  d, l) Kết hợp lõi trong lõi ngoài 

Hình 2. 25. Vị trí lõi cứng trong mặt bằng nhà. 

a b c

d e f

g h i

Loõi cöùng
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2.2.2.5. Phân bố độ cứng và cường độ theo phương đứng 

Độ cứng và cƣờng độ của kết cấu nhà cao tầng cần đƣợc thiết kế đều hoặc giảm 

đần lên phía trên, tránh thay đổi đột ngột. 

Độ cứng của tầng trên không nhỏ hơn 70% độ cứng của kểt cấu tầng dƣới kề nó. 

Nếu ba tầng giảm độ cứng liên tục thì tổng mức giảm không vƣợt quá 50%. 

2.2.2.6. Nguyên tắc cơ bản của việc thiết kế kháng chấn 

 

Hình 2. 26. Sơ đồ hình thành khớp dẻo của khung. 

Nguyên tắc cơ bản của việc thiết kế kháng chấn là đảm bảo cho các cột không bị 

phá hoại trƣớc dầm “cột khỏe hơn dầm”. Dƣới tác động của tải địa chấn, biến dạng 

dẻo phải xuất hiện trƣớc hết ở dầm, sau đó mới tới các cột: có thể một số dầm bị hƣ 

hỏng trong khi đó cột định còn đủ khả năng chịu tải, công trình không bị sụp đổ. Nếu 

thiết kế “dầm khỏe cột yếu”, khớp dẻo xuất hiện ở cột trƣớc, cột bị biến dạng và mất 

ổn định đầu tiên thì lực nén sẽ nhanh chóng làm cột bị phá hoại dẫn đến nguy cơ công 

trình có khả năng bị sụp đổ cao. 

Khi thiết kế nhà cao tầng cần chú ý việc chọn độ cứng giữa cột và dầm sao cho 

tránh trƣờng hợp cột bị phá hoại trƣớc dầm. 

2.2.3. Bố trí khe co dãn, khe lún, khe kháng chấn 

Khi thiết kế nên điều chỉnh hình dạng mặt bằng, dùng các biện pháp cấu tạo, tính 

toán và thi công hợp lý để tránh đặt khe lún, khe nhiệt, khe kháng chấn. 

Khe co dãn: 

Buộc phải bố trí đối với các trƣờng hợp sau: 

Mặt bằng công trình có hình dạng phức tạp. 

Công trình với các khu vực có số tầng chênh lệch quá lớn. 

Độ cứng hoặc tải trọng các bộ phận kết cấu chênh lệch nhau khá nhiều mà không 

có biện pháp xử lý hiệu quả. 
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Bảng 2. 4. Khoảng cách lớn nhất của khe co dãn khi không tính toán 

Loại kết cấu Phƣơng pháp thi công Khoảng cách lớn nhất 

Khung Đổ tại chỗ 50 

Khung – vách Lắp ghép 70 

Vách cứng Đổ tại chỗ 45 

Khe lún:  

Thƣờng bố trí nơi các khối nhà có sự chênh lệch số tầng lớn, do địa chất thay đổi 

phức tạp. Khe lún phải xuyên qua móng do đó cần có biện pháp xử lý rất phức tạp đối 

với công trình có nhiều tầng hầm vì thế nên hạn chế bố trí nhiều khe lún, chỉ bố trí khe 

lún khi thật cần thiết. 

Có thể không cần bố trí khe lún nếu: 

Công trình sử dụng móng cọc chống vào lớp đá hoặc bằng các biện pháp khác 

chứng minh đƣợc độ lún lệch công trình không đáng kể. 

Việc tính lún có độ tin cậy cao, thể hiện độ chênh lệch lún giữa các bộ phận nằm 

trong giới hạn cho phép. 

Có thể dùng biện pháp thi công thích hợp nhƣ thi công phần cao tầng trƣớc phần 

thấp tầng sau, có tính toán mức độ chênh lệch lún hai khối kề nhau, để khi thi công 

xonệ thì độ lún hai khối đó xấp xỉ nhau, hoặc chừa một mạch bê tông giữa hai khối để 

đổ sau, khi độ lún của hai khối đã ổn định. 

Khe kháng chấn: 

Phải đặt theo suốt chiều cao công trình và có thể không xuyên qua móng, trừ 

trƣờng hợp kểt hợp với khe lún. 

Khi mặt bằng nhà phức tạp dạng hình chữ L, T, U, H, Y... thƣờng hay bị hƣ hỏng 

hoặc sụp đổ khi gặp động đất mạnh, khi đó phải bố trí khe kháng chấn, để chia mặt 

bằng nhà thành các khối nhà có mặt bằng đơn giản. 

Bề rộng khe kháng chấn cần phải có bề rộng đủ lớn để khi dao động các phần của 

công trình đã đƣợc tách ra, sao cho các phần nhà nằm cạnh nhau không va đập vào 

nhau khi động đất xảy ra. 

 

Hình 2. 27. Khe kháng chấn. 

D
min
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Khi thiết kế khe kháng chấn cần xác định chuyển vị ngang lớn nhất có thể xảy ra 

ở hai phần nhà kế cận nhau, xét trƣờng hợp bất lợi nhất khi cả hai khối nhà cùng 

nghiêng đồng thời vào nhau, bề rộng khe kháng chấn đƣợc xác định nhƣ sau: 

Dmin=U1+U2+20 mm 

Với U1 và U2 - chuyển vị lớn nhất theo phƣơng ngang của hai khối kề nhau. 

Bảng 2. 5. Bề rộng tối thiểu của khe kháng chấn (mm) 

Loại kết cấu 

Cấp kháng chấn 

Không kháng chấn (Kháng 

chấn cấp 6) 

Kháng chấn 

cấp ≤7 

Kháng chấn 

cấp 8 

Kháng chấn 

cấp 9 

Khung 4H + 10 5H – 5 7H – 35 10H – 80 

Khung – 

Vách 
3,5H + 9 4,2H – 4 6H -30 8,5H – 68 

Vách 2,8H + 7 3,5H – 3 5H – 25 7H - 55 

H (m) là độ cao của mái của đơn nguyên thấp hơn trong các đơn nguyên kề nhau. 

2.3. Kết cấu nhà cao tầng 

2.3.1. Kết cấu theo phương đứng 

1)  Hệ kết cấu cơ bản nhà cao tầng 

Các cấu kiện chịu lực cơ bản gồm: 

- Cấu kiện dạng thanh: cột, dầm 

- Cấu kiện phẳng: tƣờng đặc, tấm sàn 

- Cấu kiện không gian: lõi cứng, lƣới hộp; dƣới tác động của tải trọng, hệ không 

gian này làm việc nhƣ một kết cấu độc lập. 

Phân nhóm kết cấu – 2 nhóm: 

- Nhóm 1: chỉ gồm một loại cấu kiện chịu lực độc lập nhƣ khung, vách, lõi, hộp  

- Nhóm 2: đƣợc tổ hợp từ hai hoặc ba loại cấu kiện cơ bản trở lên: 

o Kết cấu khung + vách 

o Kết cấu khung + lõi 

o Kết cấu khung + hộp 

o Kết cấu khung + vách + lõi... 

Việc chọn hệ kết cấu dạng này hay dạng khác phụ thuộc vào điều kiện cụ thể của 

công trình, công năng sử dụng, chiều cao nhà và độ lớn của tải trọng ngang (gió, động 

đất). 

2) Hệ kết cấu thuần khung  

Kết cấu thuần khung bao gồm hệ thống cột và đầm liên kết cứng tại các nút, 

nhiều khung phẳng tạo thành khung không gian vừa chịu tải trọng đứng và tải trọng 

ngang. 
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Kết cấu thuần khung có khả năng tạo ra các không gian lớn, linh hoạt có thể đáp 

ứng đầy đủ các yêu cầu sử dụng công trình. 

Kết cấu thuần khung có sơ đồ làm việc rõ ràng, nhƣng độ cứng theo phƣơng 

ngang tƣơng đối nhỏ, khả năng chịu cắt theo phƣơng ngang kém, năng lực chống lại 

tác động của tải ngang kém khi chiều cao công trình lớn; 

Chiều cao tối đa của nhà khi sử dụng kết cấu thuần khung phụ thuộc vào tải trọng 

ngang (gió: 15 tầng hay động đất: 10 tầng), còn phụ thuộc vào số nhịp, độ lớn các nhịp 

và tỷ lệ giữa chiều cao và chiều rộng nhà. 

Khi tính toán, chọn mô hình tính toán khung-sàn kết hợp: với giả thiết bản sàn 

tuyệt đối cứng trong mặt phẳng của nó. 

Các nội lực trong cột bao gồm: lực dọc, lực cắt, mô men uốn theo hai phƣơng, 

mô men xoắn. 

3) Hệ kết cấu vách cứng chịu lực 

Kết cấu vách chịu lực là một hệ thống vách vừa chịu tải đứng vừa chịu tải ngang, 

đồng thời làm cả nhiệm vụ vách ngăn các phòng. 

Vách cứng (BTCT) trong nhà cao tầng phải bố trí suốt từ móng đến mái, phải 

đồng trục: vách cứng có khả năng chịu lực cắt và chịu uốn tốt 

Hệ kết cấu này là tổ hợp các vách phẳng bố trí theo hai phƣơng. Hạn chế việc bố 

trí cáp vách cứng tập trung ở trọng tâm nhà do khả năng chống xoắn kém, tốt nhất nên 

bố trí các vách cứng dọc theo chu vi nhà vì nhà có khả năng chống xoắn tốt hơn và 

chịu tải cả hai phƣơng. 

Vách cứng liên tục không khoét lỗ gọi là vách đặc. Phần lớn vách bị khoét lỗ 

dành cho các cửa đi và cửa sổ. 

 

Hình 2. 28. Mặt bằng kết cấu khung điển hình. 

Kết cấu vách cứng có những đặc điểm cơ bản sau: 

Kết cấu vách cứng đổ tại chỗ có tính liền khối tốt, độ cứng theo phƣơng ngang 

lớn, kết họp với bản sàn tạo thành kêt cấu hộp nhiều ngăn có khả năng chịu tải lớn, đặc 

biệt là khả năng chịu tải ngang (tải động đất). 
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a) Nhà không có khả năng chống xoắn; b) Nhà có khả năng chống xoắn tốt hơn 

Hình 2. 29. Bố trí vách cứng trong mặt bằng. 

Loại kết cấu này có khoảng không gian nhỏ nên chỉ phù hợp với các công trình 

nhà ở. 

Kết cấu này có trọng lƣợng bản thân lớn, độ cứng lớn làm tăng tải trọng động đất 

Kết cấu vách cứng đƣợc xem nhƣ là một tấm phẳng chỉ chịu lực trong mặt phăng 

bản thân, không chịu lực ngoài mặt phẳng đó. Do đó cần phải bố trí vách cứng theo cả 

hai phƣơng. 

Cách bố trí vách cứng sao cho công trình có khả năng chống xoắn cao khi chịu 

tải ngang. 

Vách cứng đƣợc xem nhƣ một conson ngàm với móng và chịu uốn trong mặt 

phẳng của nó. 

Nội lực trong vách bao gồm: lực dọc, mômen uốn và lực cắt trong mặt phẳng 

vách. 

 

Hình 2. 30. Hệ kết cấu vách chịu lực. 

4) Kết cấu lõi 

Đối với một số công trình cần có không gian rộng với việc bố trí mặt bằng đa 

dạng, để đáp ứng yêu cầu này cần tạo hệ chịu lực bằng các vách cứng theo các phƣơng 

liên kết lại với nhau gọi là lõi cứng. Lõi cứng vừa chịu tải đứng vừa chịu tải ngang. Có 

a) b)
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thể có một hoặc nhiều lõi cứng: nếu chỉ có 1 lõi cứng thƣờng đƣợc bố trí ở trung tâm, 

nếu có nhiều lõi cứng thì đặt xa nhau và nên bố trí đối xứng trên mặt bằng, không nên 

bố trí lệch một bên. Các lõi cứng phải bố trí sao cho tâm độ cứng của chúng trùng với 

trọng tâm nhà để tránh công trình bị xoắn khi dao động. 

Lõi cứng có tiết diện kín, hở và nửa hở (có khoét lỗ cửa). 

Lõi cứng làm việc nhƣ một thanh cônson ngàm với móng, nội lực bao gồm: N, M 

theo hai phƣơng, Q theo hai phƣơng và cả mômen xoắn Mt. 

 

 a,b, Lõi cứng bố trí đối xứng; c, Lõi cứng bố trí lệch một bên (không nên) 

Hình 2. 31. Bố trí lõi cứng trên mặt bằng. 

5) Kết cấu ống 

Hệ kết cấu này gồm các cột đặt dày đặc trên toàn bộ chu vi công trình đƣợc liên 

kết với nhau bằng hệ dầm giao nhau. 

Nếu các cột đặt xa nhau thì kết cấu làm việc theo sơ đồ khung. 

Hạn chế: các cột đặt dày đặc nên gây cản trở đến mỹ quan công trình. 

 

Hình 2. 32. Kết cấu ống. 

6) Hệ kết cấu khung – vách cứng 

Vách cứng có thể bố trí theo một phƣơng hoặc hai phƣơng, hoặc liên kết nhau 

thành một nhóm (kín hoặc hở). 

Đặc điểm của kết cấu này là khả năng chịu tải trọng ngang rất tốt, vách thƣờng 

sử dụng trong nhà cao tầng chủ yếu để chịu tải ngang (trên 85%) 

a) b) c)
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Kết cấu vách đạt hiệu quả trong nhà từ 20 đến 40 tầng 

Khả năng chịu tải của vách phụ thuộc phần lớn vào hinh dạng tiết diện ngang của 

nó.  

Nhà cao tầng nên tránh dùng kết cấu thuần khung, thƣờng nên kết hợp vách và 

khung. 

 

Hình 2. 33. Một số dạng vách cứng thƣờng gặp. 

Trong thực tế rất khó bố trí vách cứng đáp ứng cả 2 yêu cầu: kiến trúc và khả 

năng chịu lực. Vì vậy, cần tuân thủ các nguyên tắc: 

Với nhà cao <40m nếu phƣơng án kiến trúc đƣợc coi là tối ƣu thì bố trí các  hệ 

vách cứng phải tùy thuộc vào phƣơng án kiến trúc. 

Với nhà cao >40m, bố trí hệ vách cứng tuân theo những yêu cầu sau: 

- Cần phối hợp chặt chẽ với phƣơng án kiến trúc, cần tăng chiều dày vách cứng 

hơn là bố trí quá nhiều vách cứng, việc tăng số lƣợng vách cứng chỉ hợp lý đối với nhà 

có mặt bằng kéo dài. 

- Đảm bảo tính bất biến hình của ngôi nhà, tức là có một hệ thống vách cứng với 

ít nhất 3 vách không đƣợc cắt nhau trên một đƣờng thẳng. 

- Mặt bằng nhà nên bố trí đối xứng qua 2 trục và 2 trục này cũng chính là các trục 

đối xứng của hệ vách. 

Trong thực tế, điều kiện này thƣờng rất khó thỏa mãn, nên cần bố trí hệ vách 

cứng sao cho khoảng cách từ tâm cứng đến trọng tâm hình học cùa nhà là bé nhất. 

 

Hình 2. 34. Kết cấu khung – vách. 

7) Hệ kết cấu khung - lõi cứng 
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Hình 2. 35. Hệ kết cấu khung – lõi cứng. 

8) Hệ kết cấu khung không gian lớn tầng dƣới đỡ vách cứng 

Chân tƣờng ngang, dọc của kết cấu không làm tới đáy ở tầng 1 hoặc một số tầng 

dƣới cùng. 

Dùng dầm khung lớn đỡ vách cứng phía trên. Loại kết cấu này tạo không gian 

lớn và có khả năng chống tải ngang lớn. 

 

Hình 2. 36. Khung đỡ vách. 

9)  Hệ kết cấu khung – lõi (ống) 

 

Hình 2. 37. Hệ kết cấu ống. 

Kết cấu dạng ống là dạng các vách cứng tạo thành ống, loại này gồm: 

Vaùch

Daàm ñôõ

Coät
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Loại khung - ống: phía trong dạng ống, xung quanh bên ngoài là khung thông 

thƣờng hoặc khung không đầm. 

Loại ống lồng: gồm nhiều ống kết hợp với nhau đƣợc bố trí phía trong hoặc phía 

ngoài của công trình. 

2.3.2. Kết cấu theo phương ngang (sàn và các dầm) 

Kết cấu chịu lực theo phƣơng ngang gồm sàn, các dầm. Nó có nhiệm vụ Kết hợp 

với kết cấu chịu lực thẳng đứng gồm: cột, vách (lõi). 

Sàn ngoài chức nàng tiếp nhận tải trọng sừ dụng và truyền tải sang các dầm rồi 

truyền cho các kết cấu thẳng đứng (cột, vách). Sàn còn đƣợc xem là các vách cứng 

nằm ngang nối vói các vách cứng thẳng đứng thành một hệ không gian duy nhất.  

Sàn có vai trò phân phối tải trọng cho các kết cấu thẳng đứng. 

Khi tính nhà cao tầng dựa vào giả thiết sàn tuyệt đối cứng trong mặt phẳng của 

nó nghĩa là chuyển vị của tất cả kết cấu đứng tại mỗi tầng có chuyển vị bằng nhau nếu 

sàn không có chuyển vị do xoắn. 

 Sàn không dầm        sàn sườn  

 

    Sàn ứng lực trƣớc                       Sàn composit 

 

Hình 2. 38. Các loại sàn thƣờng gặp. 

2.4. Sơ đồ làm việc nhà cao tầng 

Ở các kết cấu hỗn hợp tùy theo cách làm việc của khung mà phân ra làm hai sơ 

đồ: sơ đồ GIẰNG và  sơ đồ KHUNG-GIẰNG. 

1. Sơ đồ giằng  

Khi khung chỉ chịu tải đứng tƣơng ứng với diện truyền tải, còn toàn bộ tải ngang 

do vách, lõi chịu. Trong sơ đồ này, tất cả các nút khung đều có cấu tạo khớp: đối với 
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công trình bê tông cốt thép toàn khối, việc cấu tạo các nút khung là khớp rất khó thực 

hiện, một cách gần đúng có thể xem tất cả các cột đều có độ cứng chống uốn vô cùng 

bé. 

Độ cứng của nhà bằng tổng độ cứng của khung và vách: 

B = Bv +Bk 

Trong đó Bv>>Bk và xem Bk = 0 

Tính toán theo sơ đồ này tƣơng đối đơn giản có thể thực hiện bằng các công cụ 

thô sơ, dùng phƣơng pháp KHANZI để tính toán. 

 

a, Sơ đồ khung  b, Sơ đồ giằng  c, Sơ đồ khung – giằng  

Hình 2. 39. Các sơ đồ làm việc. 

2. Sơ đồ khung – giằng 

Tính toán dựa vào quan niệm: mômen đƣợc phân phối theo độ cứng B của từng 

cấu kiện (cấu kiện có B lớn thì tiếp thu mômen lớn. Vì thế, việc chọn B của khung và 

vách cứng rất quan trọng khi thiết kế. 

Sơ đồ khung-giằng: Nếu chọn Bk của khung và Bv vách cứng một cách hợp lý thì 

vách chịu khoảng từ 80% đến 90% nội lực do tải trọng ngang gây ra, còn khung chỉ 

chịu từ 20% đến 10%.  

Độ cứng của nhà: B=Bv+Bk, (Với Bv>>Bk) 

Để đạt đƣợc yêu cầu này phải thực hiện tính vòng lặp để điều chỉnh tiết diện 

ngang của cột-vách một cách hợp lý nhất. 

Tính toán theo sơ đồ này rất khó khăn, đòi hỏi phải dùng các phần mềm tính toán 

chuyên dụng (Sap, Etabs, v.v...);  

Việc chọn sơ đồ nào để đƣa vào tính toán tùy thuộc vào phƣơng pháp tính và 

công cụ để tính toán.  

Chú ý, khi đã dùng sơ đồ nào để tính thì phải tính toán và cấu tạo sao pho phù 

hợp với sơ đồ tính đó. 

2.5. Tầng hầm 

Đối với nhà cao tầng nên thiết kế tầng hầm với mục đích: 
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Tăng diện tích sử dụng: làm chỗ đậu xe 

Giảm chiều cao nhà 

Giảm chuyển vị ngang của nhà 

Giảm dao động 

Tăng ổn định về lật. 

 

Hình 2. 40. Tầng hầm. 

 Hiệu quả của việc thiết kế tầng hầm là rất cao, tuy nhiên việc thiết và thi công 

tầng hầm đòi hỏi phải có công nghệ cao, phải có biện pháp thi công thích hợp để tránh 

hậu quả. 

2.6. Cơ sở thiết kế nhà cao tầng 

Khi thiết kế nhà cao tầng cần xem xét công trình đó có nằm trong vùng có khả 

năng xảy ra động đất mạnh hay không để áp dụng các qui định tƣơng ứng. 

Kết cấu không có thiết kế chống động đất gọi là kết cấu thông thuờng. 

Đặc biệt chú ý đến các yêu cầu cấu tạo khi thiết kế kết cấu chống động đất Tải 

trọng: kết cấu nhà cao tầng cần tính toán thiết kế với các tổ hợp tải trọng đứng, tải 

ngang (gió: tĩnh và động), tải động đất theo TCVN 2737:1995 “Tải trọng và tác động”; 

TCVN 9386:2012 Thiết kế công trình chịu động đất; TCXDVN 198 – 1999 Nhà cao 

tầng. 

Kết cấu nhà cao tầng cần phải tính toán và kỉểm tra về độ bền, biến dạng, độ 

cứng, ổn định và dao động. 

Nội lực và biến dạng của kết cấu nhà cao tầng đƣợc tính toán theo phƣơng pháp 

đàn hồi. Đối với dầm, có thể điều chỉnh lại nội lực do biến dạng dẻo. 

  

Saøn taàng haàmMaët ñaát
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Chương 3 

TẢI TRỌNG TÁC ĐỘNG LÊN NHÀ CAO TẦNG 

Tải trọng tác động lên nhà cao tầng bao gồm:  

- Tải trọng thẳng đứng gồm:  

+ Tĩnh tải là tải trọng tác động thƣờng xuyên, có vị trí, phƣơng, chiều và giá trị 

không đổi trong quá trình sử dụng. Đó là trọng lƣơng bản thân kết cấu chịu lực, các kết 

cấu bao che, các lớp cách âm,… 

+ Hoạt tải là tải trọng tác động không thƣờng xuyên. 

- Tải trọng ngang gồm:  

+ Tải trọng gió do tác động của khi hậu và thời tiết thay đổi theo thời gian, độ 

cao, và địa điểm dƣới dạng áp lực trên các mặt hứng gió hoặc hút gió của ngôi nhà. 

+ Tải trọng động đất là một trong những tải trọng đặc biệt là các lực quán tính 

phát sinh trong công trình khi nền đất chuyển động. Tải trọng động đất có thể tác động 

đồng thời theo phƣơng thẳng đứng và phƣơng ngang. 

3.1. Tải trọng đứng 

Tải trọng thẳng đứng tác động lên hệ kết cấu chịu lực của nhà bao gồm hai loại: 

tĩnh tải do trọng lƣợng bản thân kết cấu chịu lực và kết cấu bao che, và hoạt tải là tải 

trọng sử dụng tác động thƣờng xuyên hoặc ngắn hạn và đƣợc lấy theo tiêu chuẩn thiết 

kế tải trọng và tác động TCVN 2737-1995. 

Đối với các vách ngăn cố định, vách ngăn tạm thời đặt lên sàn có thể tính gần 

đúng nhƣ tải trọng phân bố đều và phải lấy theo tác dụng thực tế. Nếu vách ngăn bằng 

vật liệu nhẹ lấy không nhỏ hơn 75 daN/m
2
. 

Mái bằng sử dụng trồng cây trên mái lấy không nhỏ hơn 500 daN/m
2
. 

Mái bằng nhà cao tầng còn có thể sử dụng làm bãi đỗ máy bay trực thăng. Tải 

trọng lớn nhất khi trực thăng cất hạ cánh có thể tính theo công thức: 

kPQ
S

  (3.1) 

trong đó: k – hệ số động lực ( k =3); 

  P – trọng lƣợng của trực thăng căn cứ vào loại máy sử dụng; loại nhỏ lấy 

bằng 20 ÷30 kN, loại trung bình 30÷50 kN; 

  S – diện tích chịu lực trong phạm vi khoảng cách giữa các bánh xe lấy 

theo số liệu thực tế (hoặc lấy bằng 2x2m
2
 cho loại nhỏ, 2x3m

2
 cho loại trung bình). 

Theo TCVN 2737-1995 cho phép giảm các giá trị hoạt tải khi tác dụng đồng thời 

lên các sàn nhà: 
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- Khi tính dầm, dầm khung, bản sàn, cột và móng chịu tải trọng từ một sàn, thì tải 

trọng sử dụng toàn phần ứng với mục 1,2,3,4,5 bảng 3 tiêu chuẩn đều đƣợc nhân với 

hệ số:   

1

1

0,4 0,6A

A

A
    (3.2) 

khi A>A1=9m
2
 với A là diện tích truyền tải. 

Đối với các phòng nêu ở các mục 6,7,8,9,10,12,14 trong bảng 3 tiêu chuẩn: 

2

2

0,5 0,5A

A

A
    (3.3) 

khi A>A2=36m
2
 với A là diện tích truyền tải. 

- Khi xác định lực dọc trong cột, vách và móng chịu tải trọng từ 2 sàn trở lên 

đƣợc phép giảm hoạt tải bằng hệ số giảm tải nhƣ sau: 

Nếu phòng có diện tích A>A1=9m
2
 thì  

1

1

0,4
0,4

A

n
n





   (3.4) 

Nếu phòng có diện tích A>A2=36m
2
 thì  

2
0,5

0,5
A

n





   (3.5) 

Trong đó: A1, A2 lấy nhƣ công thức (3.2), (3.3). 

  n – số tầng. 

Trong nhà cao tầng xác suất xuất hiện đồng thời tải trọng sử dụng trên toàn bộ 

các sàn là rất thấp và thực tế cho thấy có sự giảm dần ở các tầng trên. Tuy nhiên hoạt 

tải thƣờng không lớn so với tải trọng bản thân (20%) nên khi thiên về an toàn có thể 

không xét tới các hệ số giảm tải. Trong tính toán khung nhiều tầng nhiều nhịp, nhất là 

khung không gian còn cho phép không xét tới các phƣơng án chất hoạt tải bất lợi trên 

các sàn. 

Ảnh hưởng độ lệch tâm của tải trọng thẳng đứng: khi tính toán theo các sơ đồ 

khung – vách tải trọng thẳng đứng xem nhƣ tác động đúng tâm. Nhƣng thực tế tải 

trọng thẳng đứng tác động lệch tâm trong các trƣờng hợp do thay đổi tiết diện cột, do 

tải trọng sàn truyền vào tƣờng – vách một bên, do sai lệch tim trục trong thi công. 

Chọn chiều dày sàn nhà cao tầng 

Lý thuyết tính toán nhà cao tầng hiện nay đều dựa vào giả thiết xem sàn (dầm) là 

vách cứng trong mặt phẳng nằm ngang, nghĩa là xem sàn tuyệt đối cứng trong mặt 

phẳng của nó (mặt phẳng nằm ngang) và mềm ngoài mặt phẳng của nó (mặt phẳng 

thẳng đứng). Nếu nhà không bị xoắn thì chuyển vị ngang mọi điểm trên cùng một sàn 
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bằng nhau, chuyển vị ngang trên các tầng thì khác nhau. Đồng thời, thƣờng bố trí các 

đƣờng ống kỹ thuật trong sàn nên cần tăng chiều dày sàn so với nhà thấp tầng.  

Đối với sàn không dầm, để dễ bố trí cáp, tăng hiệu quả của cốt thép dự ứng lực 

thì chiều dày sàn phải chọn sao cho hợp lý nhất. 

Chọn chiều dày bản sản của nhà cao tầng bằng chiều dày sàn chọn theo những 

quy định thông thƣờng của nhà thấp tầng, nhân thêm hệ số =1,05÷1,25. (Chú ý về 

mặt cấu tạo sàn: bố trí cáp ứng lực, bố trí các đƣờng ống kỹ thuật trong sàn…). 

Chọn sơ bộ kích thƣớc cột khi hệ chịu lực là thuần khung: tính toán và chọn theo 

những quy định thông thƣờng của nhà thấp tầng. 

Kích thƣớc cột khi hệ chịu lực là khung – vách (lõi): cột hầu nhƣ chỉ chịu tải 

trọng đứng, còn tải trọng ngang do vách (lõi) chịu nên lực dọc lấy nhƣ sau: Ntt =N. 

Cột đƣợc xem nhƣ cấu kiện chịu nén đúng tâm, diện tích tiết diện ngang đƣợc 

xác định theo:   

tt
c

b s

N
A

R R



 (3.6) 

Trong đó: Rb – cƣờng độ chịu nén tính toán của bê tông; 

  Rs – cƣờng độ tính toán của cốt thép;  

  µ – hàm lƣợng cốt thép, µ  µmin, tự chọn. 

Kích thƣớc vách cứng: chiều dày vách đổ toàn khối chọn 200mm và 1/20 

chiều cao tầng.  

Kích thƣớc tiết diện dầm: tính toán và chọn theo những quy định thông thƣờng 

của nhà thấp tầng. 

3.2. Dao động riêng của hệ nhiều bậc tự do 

Xét hệ có một bậc tự do: xét một dầm đơn giản không trọng lƣợng mang khối 

lƣợng tập trung m chịu tác dụng của tải trọng động P(t), hệ có một bậc tự do là chuyển 

vị theo phƣơng đứng y(t) của khối lƣợng m. 

 

Hình 3. 1. Hệ một bậc tự do. 

Phƣơng trình vi phân dao động tổng quát của hệ có một bậc tự do: 

P(t)

P

P

Pc

ñ

qy(t)

m

A B
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( )My Cy Ky P t    (3.7) 

Trong đó:  M – khối lƣợng tập trung của hệ; 

  K – hệ số độ cứng; 

  C – hệ số cản. 

Xét dầm đơn giản mang n khối lƣợng tập trung, hệ chịu tác dụng của tải trọng động: 

P1(t), P2(t),… Pn(t). 

Xét điều kiện cân bằng lực đối với khối lƣợng thứ k (bỏ qua ảnh hƣởng của lực cản): 

1 1 2 2( ) ( ... ) ( )k k k k kn n km y t k y k y k y P t      (3.8) 

 

Hình 3. 2. Hệ nhiều bậc tự do. 

Viết cho tất cả các khối lƣợng của hệ:  

1 1 11 1 12 2 1 1

2 2 21 1 22 2 2 2

1 1 2 2

( ) ( ... ) ( )

( ) ( ... ) ( )

...............................................................

( ) ( ... ) ( )

n n

n n

n n n n nn n n

m y t k y k y k y P t

m y t k y k y k y P t

m y t k y k y k y P t

    

    

    

 (3.9) 

Viết dƣới dạng ma trận: 

       ( ) ( ) ( )M Y t K Y t P t   (3.10) 

trong đó: {P(t)} – véc tơ lực động; [M] – ma trận khối lƣợng; [K] – ma trận độ cứng; 

 ( )Y t  - véc tơ gia tốc;  ( )Y t  - véc tơ chuyển vị. 

 

1

2

0 0 0

0 0 0

0 0 0 n

m

m
M

m

 
 
 
 
 
 

;  

11 12 1

22 2

n

n

nn

k k k

k k
K

sym k

 
 
 
 
 
 

;  

1

2

( )

( )
( )

( )n

P t

P t
P t

P t

 
 
 

  
 
  

;  

 

1

2

( )

( )
( )

( )n

y t

y t
Y t

y t

 
 
 

  
 
  

;  

1

2

( )

( )
( )

( )n

y t

y t
Y t

y t

 
 
 

  
 
  

 

A B

P (t) P (t) P (t)
1 k n

m1 mk mn

y (t) y (t)
y (t)

1 k
n
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3.2.1. Xác định tần số dao động riêng  

3.2.1.1. Dao động tự do không cản của nhà cao tầng 

Đối với nhà cao tầng, mô hình tính là thanh congson có n điểm tập trung khối 

lƣợng m tại các cao trình sàn tầng. 

Phƣơng trình dao động tự do không cản viết dƣới dạng ma trận có dạng: 

     ( ) ( ) 0M Y t K Y t   (3.11) 

trong đó: [M] – ma trận khối lƣợng; [K] – ma trận độ cứng;  ( )Y t  - véc tơ gia tốc; 

 ( )Y t  - véc tơ chuyển vị. 

 

1

2

0 0 0

0 0 0

0 0 0 n

m

m
M

m

 
 
 
 
 
  ; 

 

11 12 1

22 2

n

n

nn

k k k

k k
K

sym k

 
 
 
 
 
  ; 

 

1

2

( )

( )
( )

( )n

P t

P t
P t

P t

 
 
 

  
 
   ;  

 

1

2

( )

( )
( )

( )n

y t

y t
Y t

y t

 
 
 

  
 
  

;  

1

2

( )

( )
( )

( )n

y t

y t
Y t

y t

 
 
 

  
 
    

      

Hình 3. 3. Mô hình tính toán. 

Nghiệm của (3.11) đƣợc chọn theo dạng:  

   ( ) sin( )Y t A t    (3.12) 

 - tần số dao động riêng; 

 - độ lệch pha. 

m1

mi

mj

mn

H

y (t)
1

y (t)
i

h j
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 A - véc tơ biên độ dao động riêng 

 

1

2

n

A

A
A

A

 
 
 

  
 
    

3.2.1.2. Xác định tần số dao động riêng từ ma trận cứng 

Thay (3.12) và đạo hàm cấp hai của nó theo thời gian vào (3.11) ta có phƣơng 

trình: 

       2 0K M A   (3.13) 

Vì  A biển diễn biên độ dao động của các khối lƣợng mk phải khác không, do đó 

định thức:  

   2 0K M   (3.14) 

Biểu thức (3.14) là phƣơng trình để xác định tần số dao động riêng i của công 

trình. 

Khai triển (3.14) sẽ đƣợc đa thức bậc n của 2
 

2

11 1 12 1

2

21 22 2 21

2

1 2

...

...
0

... ... ... ...

...

i n

i

n n nn i n

k m k k

k k m k

k k k m














 (3.15) 

Giải (3.15) sẽ đƣợc n nghiệm thực dƣơng và phân biệt biểu diễn các tần số dao 

động riêng i (i =1,2,…,n) (tần số dao động trong 2 giây). Sắp xếp các tần số này 

theo thứ tự từ nhỏ đến lớn 1 < 2 <…<n đƣợc gọi là véc tơ tần số riêng. 

Tất cả các ma trận khối lƣợng, ma trận độ cứng của hệ đều là các ma trận đối 

xứng và xác định dƣơng, vì vậy tất cả các nghiệm của phƣơng trình tần số đều là thực 

và dƣơng. 

 

1

2

...

n








 
 
 

  
 
  

 

Tần số dao động (tần số dao động trong một giây): 

2

i
if




  (3.16) 

Chu kỳ dao động (là thời gian cần thiết để thực hiện một dao động toàn phần): 
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2
i

i

T



  (3.17) 

f1  và T1 gọi là tần số và chu kỳ dao động cơ bản. 

3.2.1.3. Xác định dạng dao động chính 

Ứng với tần số dao động riêng i công trình sẽ thực hiện một dạng dao động 

chính thứ i. Để xác định dạng dao động chính thứ i, ta thay i vừa tìm đƣợc vào 

phƣơng trình (3.13) ta đƣợc: 

       2 0i iK M A   (3.18) 

trong đó  iA  là biên độ dao động trong dạng dao động chính thứ i. 

Để xác định các dạng dao động riêng, ta đƣa vào ma trận [Bi] tƣơng ứng với tần 

số dao động riêng i. Dạng dao động riêng ứng với tấn số dao động riêng i gọi là 

dạng dao động riêng thứ i. 

Đặt: 

     

    

2

0

i i

i i

B K M

B A

 


 (3.19) 

Muốn xác định các dạng dao động riêng, ta không nhất thiết phải tìm trực tiếp 

các giá trị biên độ của các khối lƣợng, mà chỉ cần tìm tỷ số biên độ của các khối lƣợng 

so với biên độ của một khối lƣợng nào đó, thƣờng so với biên độ của khối lƣợng thứ 

nhất.  

Đặt:  

1

  ( ,  = 1,2,..., )
ji

ji

i

A
i j n

A
   (3.20) 

trong đó: Aji – biên độ dao động của khối lƣợng thứ j, ứng với dạng dao động thứ i; 

A1i - biên độ dao động của khối lƣợng thứ 1, ứng với dạng dao động thứ i. 

Đƣơng nhiên 1i =1. Nhƣ vậy, dạng dao động riêng thứ i chính là véc tơ có các phần tử 

là các tỉ số ji đó: 

 

1

2 2

1

... ...

i

i i

i

ni ni



 


 

   
   
   

    
   
      

 (3.21) 

Để tìm các dạng dao động riêng, chia hai vế (3.18) cho hệ số A1i, thì phƣơng trình 

(3.18) viết lại nhƣ sau: 
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       2 0i iK M    (3.22) 

Hoặc:  

2

11 1 12 1

2
221 22 2 2

2

1 2

1 0...

0...

... ...... ... ... ...

0...

i n

ii n

nin n nn i n

k m k k

k k m k

k k k m







     
     

         
 

   
 

        

 (3.23) 

Từ phƣơng trình (3.23) ta giải hệ (n-1) phƣơng trình sẽ đƣợc dạng dao động riêng thứ 

i: 

 
1

* ( ) ( )

11 1

i i

i B B


         (3.24) 

Trong đó 

 

2

3*

...

i

i

i

ni








 
 
 

  
 
  

 (3.25) 

( )

11

iB   - ma trận 
( )iB    bỏ đi hàng một, cột một; 

1
( )

11

iB


    - ma trận nghịch đảo của ma trận 
( )

11

iB   ; 

( )

1

iB    - cột thứ nhất của ma trận 
( )iB    bỏ đi phần tử đầu tiên. 

Ta có: 

2

22 2 2

( )

11

2

2

...

... ... ...

...

i n

i

n nn i n

k m k

B

k k m





 
 

     
  

 

21

( )

1

1

...i

n

k

B

k

 
 

     
 
 

 

(3.26) 

Vậy lúc này: 

  *

1
i

i




 
  
 

 (3.27) 

Ma trận vuông biểu thị tất cả các dạng dao động riêng gọi là ma trận các dạng 

chính ký hiệu là []. 
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21 22 2

1 2

1 2

1 1 ... 1

...
...

... ... ... ...

...

n

n

n n nn

  
   

  

 
 
 

     
 
 
 

 (3.28) 

Các chỉ số của ji gồm chỉ số thứ nhất j: là chỉ khối lƣợng thứ j, và chỉ số thứ hai 

i: chỉ tần số hay dạng dao động riêng thứ i. 

Đặt [F] – ma trận mềm, 

 

11 12 1

21 22 2

1 2

...

...

... ... ... ...

...

n

n

n n nn

F

  

  

  

 
 
 
 
 
 

 (3.29) 

trong đó: ij là chuyển vị tại khối lƣợng i khi đặt lực đơn vị đặt tại khối lƣợng j gây ra. 

Ma trận độ cứng bằng nghịch đảo ma trận mềm [K] = [F]
-1

, ta có: 

   

1

11 12 1

1 21 22 2

1 2

...

...

... ... ... ...

...

n

n

n n nn

K F

  

  

  





 
 
  
 
 
 

 (3.30) 

Ví dụ: Một công trình có sơ đồ tính toán là một thanh congson có 3 khối lƣợng 

tập trung m1, m2, m3 (Hình 3.4). Cho biết ma trận khối lƣợng [M] và ma trận độ cứng 

[K]. Tính tần số dao động và dạng dao động. 

   

1 0 0 1 1 0

0 1,5 0 ;   600 1 3 2 .

0 0 2 0 2 5

M K

   
   

   
   
      

 

 

Hình 3. 4. Mô hình tính toán. 

m1

m2

m3

H/3

H/3

H/3 EI
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Phƣơng trình đặc trƣng dao động: 

   

2

2
2

2

1 1 0
600

1 3 1,5 2 0
600

0 2 5 2
600

i

i
i

i

K M








 

     

 
 

Hay   

3 2
2 2 2

3 2

5,5 7,5 2 0
600 600 600

5,5 7,5 2 0

i i i

C C C

       
        

     

      

Tìm đƣợc: C1 =0,3513; C2 =1,6066; C3 =3.542. 

Tính tần số dao động: 

Với C1 =0,3513 thì 1 1600 14,518C    và tần số dao động: 1
1 2,311

2
f




  ; 

Với C2 =1,6066 thì 2 2600 31,048C    và tần số dao động: 2
2 4,941

2
f




  ; 

Với C3 =3.542 thì 3 3600 46,1C    và tần số dao động: 3
3 7,337

2
f




  ; 

Các dạng dao động: 

     2

2

3

1 1 0 1 0

1 3 1,5 2 0

0 2 5 2 0

i

i i i i

i i

C

K M C

C

  



      
    

         
          

 

Đặt 

( )

11

3 1,5 2

2 5 2

ii

i

C
B

C

  
        

 

Các dạng dao động xác định theo: 

12 ( )

11

3

1

0

i i

i

B




    
      

  
 

Với C1 =0,3513 thì 
121 ( )

11

31

1 0,6485

0 0,3018

iB




      
         

    
; 

Với C2 =1,6066 thì 
122 ( )

11

32

1 0,6066

0 0,6790

iB




       
              

; 

Với C3 =3.542 thì 
123 ( )

11

33

1 2,5405

0 2,4382

iB




       
         

    
. 
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Dạng dao động thứ 1               Dạng dao động thứ 2             Dạng dao động thứ 3 

Hình 3. 5. Các dạng dao động của công trình. 

3.2.2. Xác định tần số dao động bằng các phần mềm Sap, Etabs 

Đối với nhà nhiều tầng, việc xác định tần số dao động riêng đối với công trình có 

n khối lƣợng tập trung rất khó khăn, chỉ có thể tính nhờ vào các phần mềm chuyên 

dùng với hỗ trợ của máy tính. 

Trình tự khai báo trong Etabs để tính tần số dao động: 

Hộp thoại Define  Marterial Properties: giá trị khối lƣợng riêng của bê tông 

(Mass per unit Volume) = 2,5 (tấn/m
3
). 

Hộp thoại Define  Mass source: ngoài giá trị tĩnh tải – trọng lƣợng bản thân 

kết cấu chịu lực và tải trọng các lớp cấu tạo, trong bài toán động còn xét thêm ảnh 

hƣởng của 50% giá trị hoạt tải. 

    

Hình 3. 6. hộp thoại khai báo Marterial Properties và Mass source. 

Khai báo sàn tuyệt đối cứng: chọn tất cả các sàn. Hộp thoại Assign  

Shell/Area  Rigid Diaphragm 

m1

m2

m3

EI

   =1
11

   =0.6486
21

   =0.3016
31

   =1
12

   =-0.6066
22

   =-0.6790
32

   =1
13

   =-2,5405
23

    =2,4382
33

mode 1 mode 2 mode 3
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Hình 3. 7. Hộp thoại Assign Diaphragm. 

   

Hình 3. 8. Hộp thoại Dynamic analysis. 

Tra tần số dao động riêng và phần trăm dao động theo các phƣơng trong Modal 

information, Modal participating Mass ratio. 

Trong đó Period là chu kỳ dao động riêng (T); UX, UY, UZ là giá trị véc tơ riêng 

dao động theo các phƣơng. 
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Hình 3. 9. Hộp thoại Modal participating Mass ratio. 

Tra MassX, MassY (khối lƣợng để tính toán gió động cho mỗi tầng) trong 

Buiding Output, Center mass Rigidity. 

XCM, YCM: tọa độ tâm khối lƣợng; 

XCCM, YCCM: tọa độ tâm hình học; 

XCR, YCR: tọa độ tâm cứng; 

MassX, MassY: khối lƣợng. 

 

Hình 3. 10. Hộp thoại Center mass Rigidity. 

Tra các giá trị véc tơ riêng trong Modal Information, Building Mode ứng với 

từng dạng dao động. 
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Một số dạng dao động (mode): 

 

         Dạng dao động 1                Dạng dao động 2                  Dạng dao động 2 

Hình 3. 11. Các dạng dao động của khung phẳng. 

Chú ý: điều chỉnh mô hình tính toán: khi lập mô hình, mặt định các trục cột đều đồng 

trục, trục dầm trùng với trục cột. Trong thực tế, trục các cột có thể không trùng nhau, 

cột lệch trục, trục dầm không trùng với trục cột. Để mô hình tính toán phù hợp với mô 

hình thật do đó ta phải điều chỉnh trục cột và trục dầm lại cho đúng. Trong Etabs có 

công cụ để phục vụ cho yêu cầu này: Assign  Frame/Line  Insertion Point  

chọn các thông số Cardinal Point, chú ý là không đánh dấu vào ô: Do not transform 

frame stiffness for offsets from centroid. 
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Hình 3. 12. Các dạng dao động của khung không gian. 

 

Hình 3. 13. Điều chỉnh trục của cột biên và dầm biên. 

3.3. Tải trọng gió tĩnh và động 

Tải trọng gió gồm hai thành phần: 
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- Thành phần tĩnh (gió tĩnh); 

- Thành phần động (gió động). 

Tác động của gió thể hiện dƣới dạng các ngoại lực phân bố và tăng dần theo 

chiều cao công trình. Thông thƣờng quy ƣớc từ mặt đất đến chiều cao 10m áp lực gió 

đƣợc xem là phân bố đều và càng lên cao biểu đồ áp lực gió có dạng đƣờng cong thoải 

(Hình 3.15). 

 

Hình 3. 14. Tuần hoàn của gió 

 

Hình 3. 15. Biểu đồ dạng áp lực gió. 
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Áp lực gió tính theo tác động thẳng góc với mặt ngoài ngôi nhà và công trình và 

đƣợc xem là tĩnh đối với nhà cao dƣới 40m. Khi chiều cao nhà trên 40m ngoài áp lực 

tĩnh còn phải xét tới thành phần động của gió là do xung vận tốc và lực quán tính của 

công trình gây ra. Xác định thành phần động của tải trọng gió và phản ứng của công 

trình do công trình do thành phần động của tải gió gây ra ứng với tuần dạng dao động. 

3.3.1. Gió tĩnh 

Theo TCVN 2737-1995 giá trị tiêu chuẩn thành phần tĩnh của tải trọng gió ở độ 

cao so với mốc chuẩn xác định theo công thức: 

0W W kc  (3.31) 

Trong đó:  W0 – giá trị áp lực gió lấy theo bản đồ phân vùng lãnh thổ; 

  k – hệ số tính đến sự thay đổi áp lực gió theo độ cao so với mốc chuẩn và 

dạng địa hình; 

  c – hệ số khí động. 

Giá trị thành phần tĩnh của gió phải xác định cho phù hợp với mô hình tính toán và vị 

trí đặt tải gió, có các trƣờng hợp sau: 

a) Mô hình tính toán là khung không gian (không có sàn) 

Tải trọng gió tác dụng lên cột khung:  

- Gió đẩy, cƣờng độ tính toán 

0   (daN/m)dW W kc B  (3.32) 

Trong đó:  – hệ số tin cậy; 

B – bề rộng đón gió của cột khung đang xét. 

- Gió hút, cƣờng độ tính toán 

'

0   (daN/m)hW W kc B  (3.33) 

b) Mô hình tính toán là khung không gian có sàn (khung sàn kết hợp) 

- Tải trọng gió tác dụng lên dầm sàn mỗi tầng: 

+ Gió đẩy, cƣờng độ tính toán 

0   (daN/m)dW W kc h  (3.34) 

+ Gió hút, cƣờng độ tính toán 

'

0   (daN/m)hW W kc h  (3.35) 

trong đó h =(h
n+1

+h
n
)/2 – bề rộng đón gió của tầng đang xét.  

Do ta giả thiết sàn tuyết đối cứng trong mặt phẳng của nó, nên để tiện nhập vào 

mô hình cho phép tính tổng gió đẩy và gió hút. 

- Tải trọng gió là lực tập trung tác dụng lên trọng tâm sàn mỗi tầng: tổng gió đẩy 

và gió hút có cƣờng độ tính toán  
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'

0 ( )   (daN)W W k c c hB   (3.36) 

Trong đó B – bề rộng đón gió của tầng đang xét. 

 

Hình 3. 16. Tải trọng gió là lực tập trung tác động lên trọng tâm sàn mỗi tầng. 

Điểm đặt lực gió tĩnh tại trọng tâm (tâm hình học) của sàn từng tầng (tọa độ 

XCM, YCM) trong Building Output. 

 

Hình 3. 17. Hộp thoại Center mass Rigidity. 

Khai báo lực gió tĩnh ứng với mỗi tầng (Story) trong Modify Lateral load: 

 

Hình 3. 18. Hộp thoại User Wind Load. 
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3.3.2. Gió động 

Trình tự các bƣớc tính gió động: 

- Tính gió động khi chiều cao công trình H > 40m; 

- Thiết lập sơ đồ tính gió động; 

- Mô hình tính gió động là thanh congson, có n điểm tập trung khối lƣợng m tại 

các cao trình sàn tầng; 

- Chia công trình thành n phần sao cho mỗi tầng có cùng áp lực gió lên bề  mặt 

công trình có thể coi nhƣ không đổi; 

- Vị trí tập trung các khối lƣợng m tại tâm khối lƣợng của từng tầng sàn; 

- Khối lƣợng tiêu chuẩn của từng sàn m đƣợc tính toán từ các tải trọng bao 

gồm: toàn bộ tĩnh tải và 50% hoạt tải; 

- Độ cứng của thanh congson lấy bằng độ cứng tƣơng đƣơng của công trình 

thật; có thể xác định độ cứng tƣơng đƣơng của thanh congson trên cơ sở tính 

toán sao cho chuyển vị ở đỉnh thanh congson và đỉnh công trình thật bằng 

nhau khi tác dụng ở đỉnh thanh congson và đỉnh công trình thật bằng một lực 

ngang bằng nhau. 

- Xác định các tần số dao động riêng của công trình, xếp theo thứ tự tăng dần 

và các dạng dao động riêng ứng với các tần số dao động riêng tƣơng ứng; 

- So sánh tần số dao động thứ 1 (f1) với tần số giới hạn fL (theo TCXD 229-

1999); 

- Nếu f1 > fL thì giá trị tiêu chuẩn của thành phần động của gió lên các phần tính 

toán của công trình xác định theo điều 4.2 của TCXD 229-1999; 

- Nếu f1 < fL thì giá trị tiêu chuẩn của thành phần động của gió lên các phần tính 

toán của công trình xác định theo điều 4.3 của TCXD 229-1999. Lúc này phải 

kể đến cả xung vận tốc gió và lực quán tính của công trình; 

- Xác định giá trị tiêu chuẩn thành phần động của gió tác động lên công trình. 

Tùy mức độ nhạy cảm của công trình đối với tác dụng động lực của tải trọng gió 

mà thành phần động của tải trọng gió chỉ cần kể đến tác động do thành phần xung của 

vận tốc gió hoặc cả với lực quán tính của công trình. 

3.3.2.1. Đối với công trình có f1 > fL: tần số dao động cơ bản f1 (Hz) lớn hơn giá trị giới 

hạn của tần số dao động riêng fL (lấy theo Bảng 9 – TCVN2737-1995 – Bảng 3.1) thì 

thành phần động của tải trọng gió chỉ kể đến xung vận tốc gió, khi đó giá trị tiêu chuẩn 

thành phần động của áp lực gió Wpj tác động lên phần thứ j của công trình đƣợc xác 

định theo: 

0( )   (daN,kN)pj j j j zj j jW W S W k c S      (3.37) 

Trong đó:  j – hệ số áp lực động của tải trọng gió, ở độ cao ứng với phần thứ j của 

công trình, không thứ nguyên, lấy theo Bảng 3.2; 

  c = 1,4; kzj - lấy theo Bảng 3.3. 

Sj là diện tích đón gió ở phần thứ j của công trình (m
2
). 

Bảng 3. 1. Giá trị giới hạn của tần số dao động riêng fL 

Vùng áp lực gió fL (Hz) 
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 = 0.3 (BTCT)  = 0.15 

I 1,1 3,4 

II 1,3 4,1 

II 1,6 5,0 

IV 1,7 5.6 

V 1,9 5,9 

Bảng 3. 2. Hệ số áp lực động j 

Chiều cao z (m) 
Hệ số áp lực động j đối với các dạng địa hình 

A B C 

5 0,318 0,517 0,754 

10 0,303 0,486 0,684 

20 0,289 0,457 0,621 

40 0,275 0,429 0,563 

60 0,267 0,414 0,532 

80 0,262 0,403 0,511 

100 0,258 0,395 0,496 

150 0,251 0,381 0,468 

200 0,246 0,371 0,450 

250 0,242 0,364 0,436 

300 0,239 0,358 0,425 

350 0,236 0,353 0,416 

480 0,231 0,343 0,398 

Bảng 3. 3. Bảng hệ số kzj kể đến sự thay đổi áp lực gió theo độ cao và dạng địa hình. 

Dạng địa hình độ cao 

z (m) 

A B C 

3 1,00 0,80 0,47 

5 1,07 0,88 0,54 

10 1,18 1,00 0,66 

15 1,24 1,08 0,74 
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20 1,29 1,13 0,80 

30 1,37 1,22 0,89 

40 1,43 1,28 0,97 

50 1,47 1,34 1,03 

60 1,51 1,38 1,08 

80 1,57 1,45 1,18 

100 1,62 1,51 1,25 

150 1,72 1,63 1,40 

200 1,79 1,71 1,52 

250 1,84 1,78 1,62 

300 1,84 1,84 1,70 

350 1,84 1,84 1,78 

400 1,84 1,84 1,84 

 - hệ số tƣơng quan không gian áp lực động của tải trọng gió ứng với các dạng 

dao động khác nhau của công trình, không thứ nguyên:  đƣợc lấy bằng 1. Nếu bề 

mặt đón gió công trình có dạng chữ nhật hƣớng song song với các trục cơ bản trong 

Hình 3.19, thì các giá trị của  lấy theo Bảng 3.4, trong đó các tham số  và  xác định 

theo Bảng 3.4, giá trị của  ứng với dạng dao động thứ 2 và thứ 3 là 2=3=1. 

 

Hình 3. 19. Hệ tọa độ xác định hệ số tƣơng quan . 

Bảng 3. 4. Hệ số tƣơng quan không gian áp lực động của tải trọng gió 1  

 (m) 
Hệ số 1 khi  bằng (m) 

5 10 20 40 80 160 350 

0,1 0,95 0,92 0,88 0,83 0,76 0,67 0,56 

b

h

a

O

z

y

x

Höôùng gioù
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5 089 0,87 0,84 0,80 0,73 0,65 0,54 

10 0,85 0,84 0,81 0,77 0,71 0,64 0,53 

20 0,80 0,78 0,76 0,73 0,68 0,61 0,51 

40 0,72 0,72 0,70 0,67 0,63 0,57 0,48 

80 0,63 0,63 0,61 0,59 0,56 0,51 0,44 

160 0,53 0,53 0,52 0,50 0,47 0,44 0,38 

0,1 0,95 0,92 0,88 0,83 0,76 0,67 0,56 

Bảng 3. 5. Các tham số  và  

Mặt phẳng tọa độ song song với bề mặt 

tính toán 

  

zoy b h 

zox 0,4a h 

xoy b a 

Chú ý: Đối với các công trình có bề mặt đón gió không phải là hình chữ nhật thì h lấy 

bằng chiều cao công trình, còn b và a lấy bằng kích thƣớc tƣơng ứng tại trọng tâm hình 

chiếu của bề mặt đón gió lên các mặt phẳng thẳng đứng, vuông góc với phƣơng luồng 

gió. 

3.3.2.2. Đối với công trình có tần số dao động cơ bản (Hz) nhỏ hơn giá trị của tần số 

dao động riêng giới hạn fL thì thành phần động của gió phải kể đến cả xung vận tốc gió 

và lực quán tính của công trình. Khi đó, số dạng dao động cần tính toán và giá trị tiêu 

chuẩn thành phần động của tải trọng gió Wp(ji) tác dụng lên phần thứ j của công trình 

ứng với dạng dao động thứ i đƣợc xác định: 

Khi có tần số dao động riêng cơ bản thứ s thỏa mãn: fs < fL < fs+1 thì cần tính toán 

thành phần động của tải trọng gió với s dạng dao động đầu tiên. 

Giá trị tiêu chuẩn thành phần động của tải gió (lực gió động) tác dụng lên phần 

thứ j của công trình ứng với dạng dao động thứ i, đƣợc xác định theo:  

( )   (daN,kN)p ji j j i jiW M     (3.38) 

Trong đó: Mj – khối lƣợng tập trung của phần công trình thứ j; 

i – hệ số động lực ứng với dạng dao động thứ i, không thứ nguyên, phụ thuộc 

vào thông số i và độ giảm lô ga của dao động: 

0

940
i

i

W

f


   (3.39) 
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 - hệ số độ tin cậy, đối với tải trọng gió lấy bằng 1,2 tƣơng ứng với nhà và công 

trình có thời gian sử dụng giả định là 50 năm. Khi thời gian sử dụng giả định khác đi 

thì giá trị tính toán của tải trọng gió phải thay đổi bằng cách nhân với hệ số β trong 

Bảng 3.6. 

fi – tần số dao động thứ i; W0 – giá trị áp lực gió tiêu chuẩn. 

ji – chuyển vị ngang tỉ đối của trọng tâm phần công trình thứ j ứng với dạng dao 

động riêng thứ i, không thứ nguyên. 

i – hệ số đƣợc xác định bằng cách chia công trình thành n phần, trong phạm vi 

mỗi phần tải trọng gió có thể coi nhƣ không đổi:  

1

2

1

n

ji Fj

j

i n

ji j

j

W

M
















 (3.40) 

Trong đó WFj – giá trị tiêu chuẩn thành phần động của gió tác dụng lên phần thứ j của 

công trình, ứng với các dạng dao động khác nhau khi chỉ kể đến ảnh hƣởng của xung 

vận tốc gió, có thứ nguyên là lực, xác định theo: 

  (daN,kN)Fj j j jW W S   (3.41) 

trong đó:  - khi tính toán đối với dạng dao động thứ 1, lấy =1, còn đối với dạng dao 

động còn lại lấy =1; Sj - diện tích đón gió ở phần thứ j của công trình (m
2
). 

 

Hình 3. 20. Đồ thị xác định hệ số động lực i. 

3.3.2.3. Giá trị tính toán thành phần động của tải trọng gió tính theo công thức 

  tinhtoanW W  (3.42) 
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trong đó: W – giá trị tiêu chuẩn của thành phần động của tải trọng gió hoặc áp lực gió 

đƣợc xác định theo các công thức (3.37), (3.38);  = 1,2 – hệ số tin cậy; β – hệ số điều 

chỉnh tải trọng gió theo thời gian sử dụng giả định của công trình, xác định theo Bảng 

3.6. Thực tế tính toán thƣờng chọn β=1. 

Bảng 3. 6. Hệ số β điều chỉnh tải trọng gió với thời gian sử dụng giả định của công trình khác 

nhau.  

Thời gian sử dụng giả định, năm.  5  10  20  30  40  50  

Hệ số điều chỉnh tải trọng gió, β  0,61  0,72  0,83  0,91  0,96  1  

Kết luận tính toán gió động: 

Trường hợp 1: khi f1 > fL , không cần xét đến số dạng dao động, giá trị tính toán 

thành phần động của tải trọng gió tác dụng lên tầng thứ j của công trình đƣợc xác định 

nhƣ sau: 

( ) 0( )   (daN,kN,T)tt

p j zj j jW W k c S    (3.43) 

Trường hợp 2: khi f1 < fL , cần tính toán tải trọng cho n dạng dao động của công trình, 

số n xác định theo điều kiện fn < fL < fn+1 . Giá trị tính toán thành phần động của tải 

trọng gió tác dụng lên tầng thứ j trong dạng dao động riêng thứ i đƣợc xác định nhƣ 

sau: 

1

( )
2

1

  (daN,kN,T)

n

ji j j

j

p ji j j ji jn

ji j

j

W

W M S

M

 

   












 (3.44) 

3.3.3. Tổ hợp nội lực (tải trọng) do tải trọng gió 

Nội lực và chuyển vị gây ra do thành phần tĩnh và động của tải trọng gió đƣợc xác 

định nhƣ sau: 

2

1

( )
s

t d

i

i

X X X


    (3.45) 

trong đó: X – mô men uốn (xoắn), lực dọc, lực cắt hoặc chuyển vị; 

X
t
 - mô men uốn (xoắn), lực dọc, lực cắt hoặc chuyển vị do thành phần tĩnh của 

tải trọng gió gây ra; 

Xi
d
 - mô men uốn (xoắn), lực dọc, lực cắt hoặc chuyển vị do thành phần động của 

tải trọng gió khi dao động ở dạng thứ i gây ra; 

s – số dạng dao động đƣợc tính toán. 

Chú ý: trong thực tế tính toán nhà cao tầng, nếu dùng cách tổ hợp tải trọng gió 

nhƣ trên chúng ta gặp nhiều khó khăn cũng nhƣ khối lƣợng tính toán nhiều, do đó có 
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thể tính gần đúng và đơn giản hơn bằng cách “tổ hợp tải trọng gió”. Vẫn dùng công 

thức tổ hợp (3.45) trong đó: 

X – tổng tải trọng gió; 

X
t
 – thành phần tĩnh của tải trọng gió; 

Xi
d
 – thành phần động của tải trọng gió khi dao động ở dạng thứ i gây ra; 

s – số dạng dao động đƣợc tính toán. 

3.3.4. Tính tần số dao động từ phần mềm Etabs 

Tra tần số dao động riêng và phần trăm dao động theo các phƣơng trong Modal 

information, Modal participating Mass ratio. 

Trong đó Period là chu kỳ dao động riêng (T); UX, UY, UZ là giá trị véc tơ riêng 

dao động theo các phƣơng (phần trăm dao động theo các phƣơng) 

Tra MassX, MassY (khối lƣợng để tính toán gió động cho mỗi tầng) trong 

Buiding Output, Center mass Rigidity. 

XCM, YCM: tọa độ tâm khối lƣợng; 

XCCM, YCCM: tọa độ tâm hình học; 

XCR, YCR: tọa độ tâm cứng; 

MassX, MassY: khối lƣợng. 

 

Hình 3. 21. Hộp thoại Modal participating Mass ratio. 

Tra các giá trị véc tơ riêng trong Modal Information, Building Mode ứng với 

từng dạng dao động. 

Tính tần số dao động riêng: f = 1/Period (Hz). 

Tra hệ số fL trong TCVN 229-1999 ứng với công trình bê tông cốt thép. 

So sánh những giá trị tần số đã tính đƣợc với fL để xác định nên tính toán thành 

phần động của tải trọng gió với bao nhiêu dạng dao động (tƣơng ứng với các tần số 

dao động). 
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Tính toán thành phần động của tải trọng gió theo TCVN 229-1999 để xác định 

lực gió động dƣới dạng lực tập trung tại cao trình sàn mỗi tầng. 

 

Hình 3. 22. Hộp thoại Center Mass Rigidity. 

 

Hình 3. 23. Hộp thoại Building Mode. 

Khai báo trong Etabs: 

Gió động đƣợc đƣa về những lực tập trung ở cao trình sàn mỗi tầng; 

Khai báo lực gió động tập trung trong Modify Lateral load: Define  Static 

Load Cases …Auto Lateral Load chọn User Defined. 

Gán tải trọng gió theo phƣơng X: 
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Chọn Modify Lateral load … 

 

Gán tải trọng gió theo phƣơng Y: 

 

Chọn Modify Lateral load … 
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Khi xác định tải trọng gió lên công trình cần xét đầy đủ các phƣơng và chiều bất 

lợi của gió. 

Khi mặt bằng nhà có hình chữ nhật kéo dài, tác dụng bất lợi của tải trọng gió chủ 

yếu theo phƣơng ngang nhà. 

Khi mặt bằng nhà có hình vuông hoặc gần vuông, cần xét gió theo phƣơng 

ngang, phƣơng dọc và cả phƣơng xiên. 

Khi mặt bằng nhà có hình dáng phức tạp cần phân tích độ cứng của nhà theo các 

phƣơng để xét sự bất lợi của gió. 

 

3.4. Tải trọng động đất 

3.4.1. Khái niệm chung về động đất 

Lớp vỏ Trái đất luôn luôn chuyển động theo thuyết kiến tạo địa chấn thì bề mặt 

Trái đất gồm một số lớp đá gốc dày trôi nổi trong lớp phun nham lỏng. Những thềm 

kiến tạo mới liên tục kéo dài ra những vùng biển trũng sâu có những dung nham nóng 

chảy đƣợc phun lên trên, phủ lên đáy biển và đó chính là nguyên nhân của hiện tƣợng 

trôi lục địa gây ra sự xô đẩy thềm lục địa và đáy biển. Trong những vùng này các lớp 

thềm lục địa xô đẩy lẫn nhau, sự dịch chuyển giữa chúng bị cản trở do lực ma sát giữa 

các mặt kiến tạo. Dọc những vùng tiếp xúc này, ứng suất kéo tăng dần chừng nào xảy 

ra nứt nẻ đột ngột do ứng suất này vƣợt quá giới hạn đàn hồi hoặc tới khi phá hủy khối 

lƣợng lớn đá gốc. Do đó chuyển động nên có giải phóng năng lƣợng biến dạng dẫn đến 

phá hủy vỏ trái đất theo một phƣơng nào đó và tạo thành vết nứt. Một phần năng lƣợng 

truyền đi dƣới dạng sóng va chạm theo mọi hƣớng, chuyển động sóng này gọi là động 

đất. Động đất hoặc địa chấn là những rung động tự nhiên của vỏ trái đất có phƣơng 

hƣớng và cƣờng độ thay đổi theo thời gian. 
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Trong thời gian động đất, chuyển động của nền đất làm phát sinh ra các lực quán 

tính ở các bộ phận công trình. Bởi vậy động đất không chỉ ảnh hƣởng trực tiếp tới nền 

móng công trình mà còn gây ra dao động, biến dạng kết cấu thân nhà dẫn tới nứt nẻ, 

hƣ hỏng, phá hoại cục bộ hoặc toàn bộ ngôi nhà. 

Động đất là hiện tƣợng rung động đột ngột mạnh của vỏ Trái đất do sự dịch 

chuyển các mãnh thạch quyển hoặc các đứt gãy trong vỏ Trái đất và đƣợc truyền qua 

những khoảng cách lớn dƣới dạng dao động đàn hồi. 

- Sóng địa chấn là sóng đàn hồi vật lý hình thành do việc giải phóng năng lƣợng 

từ điểm phát ra năng lƣợng động đất gọi là chấn tiêu. 

- Nối tâm trái đất với chấn tiêu lên mặt đất, đƣờng này gặp mặt đất nơi đó gọi là 

chấn tâm. 

 

Hình 3. 24. Đặc trƣng dao động tại chấn tâm và chấn tiêu. 

Có năm dạng chuyển động cơ bản: 

- Chuyển động phân ly: hai mảnh gần nhau tách dần ra; 

- Chuyển động dũi ngầm: mảnh nọ dũi xuống mảnh kia; 

- Chuyển động trƣờn: mảnh nỏ trƣờn lên mảnh kia; 

- Chuyển động va chạm đàn hồi: hai mảnh kể nhau thỉnh thoảng va vào nhau rồi 

sau đó trở lại vị trí ban đầu; 

- Chuyển động rút đồng quy: hai mảnh gần nhau rút xuống lớp nhung nham lỏng 

phía dƣới. 

Cƣờng độ động đất: để đánh giá cƣờng độ động đất ngƣời ta dựa vào hậu quả của 

nó đối với nhà và công trình hoặc năng lƣợng gây ra trận động đất ấy. Các thang sau 

đây đƣợc nhiều nƣớc sử dụng: 

Thang Mercalli cải tiến: do nhà địa chấn học Mercallỉ đã đề xuất, có 12 cấp. 

Cấp từ I đến IV là động đất yếu; Cấp V đến VI đã tác động đến giác quan con ngƣời, 

có chút ít thiệt hại; Cấp VII làm con ngƣời chạy ra khỏi nhà, hƣ hỏng nhẹ; Cấp VIII 

làm hƣ hỏng hàng loạt công trình; Cấp IX và X làm đổ hầu hết các nhà; Cấp XI gây 

Ñoä saâu

chaán tieâu H

Chaán tieâu

Tie
âu c

öï 

Taâm cöï D

Traïm quan saùt

Chaán taâm

Soùng maët
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thiệt hại phạm vi lớn; Cấp XII mang tính hủy diệt kèm theo sự thay đổi địa hình nơi có 

động đất. 

Thang MKS -64: thang cƣờng độ động đất MSK - 64 do ba nhà khoa học 

Medvedev, Sponhauer và Karnic đề xuất năm 1964. Thang này gồm 12 cấp, đƣợc sử 

dụng rộng rãi ở Nga, các nƣớc thuộc khối SNG, một số nƣớc Đông Âu, Việt Nam,… 

Ngoài việc đánh giá và phân loại tác động của động đất lên con ngƣời, môi trƣờng và 

các công trình xây dựng nhƣ các thang cƣờng độ động đất trƣớc đó (nhƣng chi tiết và 

cụ thể hơn), cƣờng độ động đất theo thang MSK - 64 còn đƣợc đánh giá qua hàm 

chuyển vị của một con lắc chuẩn hình cầu mô tả chuyển động địa chấn. Từ cấp 1 đến 

cấp 6 là động đất nhẹ không gây ảnh hƣởng lớn đến nhà và công trình; từ cấp 7 đến 

cấp 9 là động đất mạnh cần đƣợc xét đến trong thiết kế nhà, công trình; từ cấp 10 đến 

cấp 12 là động đất có mức hủy diệt. 

Thang Richter: thang đo cƣờng độ động đất bằng cách đánh giá gần đúng năng 

lƣợng đƣợc giải phóng ở chấn tiêu. Độ lớn M (magninude) của một trận động đất bằng 

logarit thập phân của biên độ cực đại A (µm) ghi tại một điểm cách chấn tâm 

D=100km trên máy đo địa chấn có chu kỳ dao động riêng T =0,8s.  

logM A  (3.46) 

Quan hệ giữa năng lƣợng E (egi) đƣợc giải phóng ở chấn tiêu với magnitude 

đƣợc xác định theo biểu thức: 

2log 9,9 1,9 0,024E M M    (3.47) 

Về mặt lý thuyết thang M, Richter bắt đầu bằng con số 0 và không có giới hạn 

trên. Nhƣng cho đến nay ngƣời ta chƣa đo đƣợc trận động đất nào có M đạt đến 9. 

Thang năng lƣợng Richter có 7 bậc đánh số từ 2 đến 8 độ Richter.  

Bảng 3. 7. Giữa thang Mercalli cải tiến và thang Richter có mối liên hệ nhƣ sau 

Than Richter M Thang Mercalli cải tiến MM 

2 I  II 

3 III 

4 IV  V 

5 VI  VII 

6 VII  VIII 

7 IX  X 

8 XI 
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Hình 3. 25. Bản đồ phân vùng gia tốc nền lãnh thổ Việt Nam, chu kỳ lặp 500 năm, nền loại A. 

3.4.2. Phản ứng của công trình dưới tác dụng của động đất 

Dƣới tác dụng của động đất, móng công trình (đƣợc giả thiết là một khối tuyệt 

đối cứng) chịu một di chuyển tịnh tiến ngang x0(t) cùng với nền đất. Kết quả, tại mỗi 

thời điểm, khối lƣợng mk sẽ thực hiện chuyển vị tƣơng đối xk(t)  so với móng. Chuyển 

vị tuyệt đối của khối lƣợng mk sẽ bằng (x0(t)+ xk(t)).  

Lực quán tính tác dụng lên khối lƣợng mk bằng: 

0[ ( ) ( )]qt

k k kF m x t x t    (3.48) 

Lực quán tính này đƣợc gọi là lực động đất tác dụng lên công trình tại điểm tập 

trung khối lƣợng mk. 
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Hình 3. 26. Mô hình tính toán của hệ kết cấu có nhiều bậc tự do chịu tác động động đất. 

3.4.3. Các phương pháp xác định tải trọng động đất 

Việc xác định tải trọng động đất (lực quán tính) tác dụng lên công trình một cách 

chính xác là một việc làm rất khó khăn và phụ thuộc nhiều vào tính chất chuyển động 

địa chấn, các tính chất động học công trình và đặc trƣng cơ lý của nền đất. Hiện nay 

trong tiêu chuẩn thiết kế kháng chấn của các nƣớc đều sử dụng một trong hai phƣơng 

pháp xác định tải trọng động đất sau đây: 

- Phƣơng pháp động lực: xác định trực tiếp trạng thái ứng suất – biến dạng các 

kết cấu chịu tải từ các gia tốc do ghi đƣợc chuyển động của nền đất khi động đất xảy 

ra. 

- Phƣơng pháp lực tĩnh: thay thế các lực động đất thực tác dụng lên công trình 

bằng lực tĩnh ảo có hiệu ứng tƣơng đƣơng nên còn gọi là phƣơng pháp tải trọng ngang 

thay thế. Việc xác định tải trọng động đất theo phƣơng pháp này tƣơng đối đơn giản và 

đã đƣợc sử dụng vào thiết kế các công trình nhà cửa từ trƣớc đến nay. 

Theo TCVN 9386-2012 ta có các phƣơng pháp phân tích sau đây: 

(1) Phƣơng pháp phân tích đàn hồi tuyến tính: 

- Phƣơng pháp “phân tích phổ phản ứng dạng dao động”; 

- Phƣơng pháp “phân tích tĩnh lực ngang tƣơng đƣơng”. 

(2) Phƣơng pháp phi tuyến: 

- Phƣơng pháp tĩnh phi tuyến; 
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- Phƣơng pháp phi tuyến theo thời gian (động). 

Phương pháp phân tích phổ phản ứng dạng dao động: xác định chu kỳ và dao 

động cho mỗi dạng dao động chính của hệ kết cấu. Tiếp đó là từ phổ phản ứng động 

đất cho trƣớc, xác định các phổ gia tốc cực đại ứng với chu kỳ dao động và hệ số cản 

tới hạn của mỗi dao động chính. Trên cơ sở này, bằng kỹ thuật phân tích dạng, xác 

định phản ứng lớn nhất của hệ kết cấu ở mỗi dạng dao động chính. Phản ứng toàn phần 

của hệ kết cấu đƣợc xác định theo phƣơng pháp tổ hợp thống kê các phản ứng lớn nhất 

ở các dạng dao động chính. Ƣu điểm chính của phƣơng pháp phổ phản ứng là tính toán 

nhanh, đơn giản và cho kết quả tính toán với độ chính xác có thể chấp nhận đƣợc. 

Phương pháp phân tích tĩnh lực ngang tương đương: là phƣơng pháp trong 

đó lực quán tính do động đất sinh ra tác động lên công trình theo phƣơng ngang đƣợc 

thay bằng các tĩnh lực ngang tƣơng đƣơng. Lực ngang này có tên là lực cắt đáy hoặc 

lực cắt ở chân công trình, đƣợc phân phối trở lại trên chiều cao công trình tại các vị trí 

có khối lƣợng tâp trung, thƣờng là cao trình bản sàn. Phƣơng pháp phân tích này có 

thể áp dụng cho các nhà mà phản ứng của nó không chịu ảnh hƣởng đáng kể bởi các 

dạng dao động bậc cao hơn dạng dao động cơ bản trong mỗi phƣơng chính. Phƣơng 

pháp tĩnh lực ngang tƣơng đƣơng không áp dụng cho các công trình có hình dạng 

không đều đặn hoặc có sự phân bố khối lƣợng và độ cứng không đều trong mặt bằng 

cũng nhƣ trên chiều cao. 

Phương pháp tĩnh phi tuyến (đẩy dần): đƣợc thực hiện dƣới điều kiện lực trọng 

trƣờng không đổi và tải trọng nằm ngang tăng một cách đơn điệu. Phƣơng pháp này có 

thể áp dụng để kiểm tra tính năng kết cấu của nhà hiện hữu và nhà đƣợc thiết kế mới 

với những mục đích sau: 

- Để kiểm tra hoặc đánh giá lại các tỷ số vƣợt cƣờng độ u/1 (xem 5.2.2.2.1, 

6.3.2, 7.3.2); 

- Để xác định các cơ cấu dẻo dự kiến và sự phân bố hƣ hỏng; 

- Để đánh giá tính năng kết cấu của nhà hiện hữu hoặc đƣợc cải tạo theo các mục 

tiêu của tiêu chuẩn liên quan; 

- Sử dụng nhƣ một phƣơng pháp thiết kế thay cho phƣơng pháp phân tích đàn 

hồi-tuyến tính có sử dụng hệ số ứng xử q. Trong trƣờng hợp đó, chuyển vị mục tiêu 

cho trong 4.3.3.4.2.6(1)P cần đƣợc sử dụng làm cơ sở thiết kế. 

Phương pháp phi tuyến theo thời gian: phản ứng phụ thuộc thời gian của kết 

cấu có thể xác định bằng cách phân tích theo lịch sử thời gian các phƣơng trình vi 

phân chuyển động của nó, sử dụng các giản đồ gia tốc biểu thị các chuyển động nền 

cho trong 3.2.3.1. 

3.4.4. Phương pháp xác định tải trọng động đất theo TCVN 9386-2012 

Để tính toán tải trọng động đất cần tiến hành xác định các thông số phục vụ cho việc 

tính tải trọng động đất theo TCVN 9386 -2012. 
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1- Xác định loại đất nền: có 7 loại đất nền A, B, C, D, E, S1 và S2. 

Các loại nền đất A, B, C, D và E đƣợc mô tả bằng các mặt cắt địa tầng, các tham 

số cho trong Bảng 3.1 và đƣợc mô tả dƣới đây, có thể đƣợc sử dụng để kể đến ảnh 

hƣởng của điều kiện nền đất tới tác động động đất. Việc kể đến ảnh hƣởng này còn có 

thể thực hiện bằng cách xem xét thêm ảnh hƣởng của địa chất tầng sâu tới tác động 

động đất. 

Bảng 3. 8. Các loại nền đất 

Loại Mô tả 

Các tham số 

Vs,30 

(m/s) 

NSPT 

(nhát/30 cm) 

Cu 

(Pa) 

A Đá hoặc các kiến tạo địa chất khác tựa đá, kể 

cả các đất yếu hơn trên bề mặt với bề dày lớn 

nhất là 5 m. 

> 800 - - 

B Đất cát, cuội sỏi rất chặt hoặc đất sét rất cứng 

có bề dày ít nhất hàng chục mét, tính chất cơ 

học tăng dần theo độ sâu. 

360 - 800 > 50 > 250 

C Đất cát, cuội sỏi chặt, chặt vừa hoặc đất sét 

cứng có bề dày lớn từ hàng chục tới hàng 

trăm mét. 

180 - 360 15 - 50 70 - 250 

D Đất rời trạng thái từ xốp đến chặt vừa (có 

hoặc không xen kẹp vài lớp đất dính) hoặc có 

đa phần đất dính trạng thái từ mềm đến cứng 

vừa. 

< 180 < 15 < 70 

E Địa tầng bao gồm lớp đất trầm tích sông ở 

trên mặt với bề dày trong khoảng 5 m đến 20 

m có giá trị tốc độ truyền sóng nhƣ loại C, D 

và bên dƣới là các đất cứng hơn với tốc độ 

truyền sóng Vs lớn hơn 800 m/s.  

   

S1 Địa tầng bao gồm hoặc chứa một lớp đất sét 

mềm/bùn (bụi) tính dẻo cao (Pl lớn hơn 40) 

và độ ẩm cao, có chiều dày ít nhất là 10 m. 

< 100 

(tham 

khảo) 

- 10 - 20 

S2 Địa tầng bao gồm các đất dễ hóa lỏng, đất sét 

nhạy hoặc các đất khác với các đất trong các 

loại nền A-E hoặc S1. 

   

Nền đất cần đƣợc phân loại theo giá trị của vận tốc sóng cắt trung bình vs,30 (m/s) 

nếu có giá trị này. Nếu không, có thể dùng giá trị NSPT. 

Vận tốc sóng cắt trung bình, vs,30, đƣợc tính toán theo biểu thức sau: 

,30

1

30
s N

i

i i

v
h

v




 

(3.49) 
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trong đó: 

hi, vi là chiều dày (m) và vận tốc sóng cắt (tại mức biến dạng cắt bằng 10
-5

 hoặc 

thấp hơn) của lớp thứ i trong tổng số N lớp tồn tại trong 30 m đất trên bề mặt. 

Đối với các địa điểm có điều kiện nền đất thuộc một trong hai loại nền đặc biệt S1 

và S2 cần phải có nghiên cứu đặc biệt để xác định tác động động đất. Đối với những 

loại nền này, đặc biệt là đối với nền S2, cần phải xem xét khả năng phá huỷ nền khi 

chịu tác động động đất. 

CHÚ THÍCH: Cần đặc biệt lưu ý nếu trầm tích là nền loại S1. Điển hình của loại nền đất này là giá trị 

vs rất thấp, độ cản bên trong nhỏ và phạm vi mở rộng bất thường về ứng xử tuyến tính. Vì thế, có thể 

tạo ra những hiệu ứng dị thường về sự khuếch đại chấn động nền và tương tác nền-công trình (xem 

Chương 6, Phần 2 – TCVN9386-2012). Trường hợp này, cần nghiên cứu đặc biệt để xác định tác động 

động đất nhằm thiết lập quan hệ giữa phổ phản ứng với chiều dày và giá trị vs của lớp sét/ bùn và sự 

tương phản về độ cứng giữa lớp này và các lớp đất nằm dưới. 

2- Xác định tỷ số agR/g 

Căn cứ vào bản đồ phân vùng gia tốc nền chu kỳ lặp lại 500 năm cho nền loại A 

lãnh thổ Việt Nam cho trong Phụ lục G về phân vùng gia tốc nền lãnh thổ Việt Nam 

(TCVN 9386-2012), hoặc căn cứ phân vùng gia tốc nền theo địa danh hành chính Phụ 

lục H (TCVN 9386-2012) để xác định tỉ số agR/g (trong đó: agR là đỉnh gia tốc nền 

tham chiếu ở địa điểm xây dựng công trình, g là gia tốc trọng trƣờng, g=9,81m/s
2
). Tỉ 

số agR/g cũng có thể lấy theo số liệu đƣợc cung cấp bởi cơ quan chuyên môn có thẩm 

quyền. 

Ghi Chú: Để tránh nhầm lẫn khi xác định lực cắt đáy Fb (thông qua tổng khối lượng công trình m và 

tham số tung độ của phổ thiết kế  1dS T  tại chu kỳ 
1T ) ,  trong quy trình tính toán này sử dụng tỉ số 

agR/g và phổ thiết kế không thứ nguyên  dS T  xem mục (xem 4.3.3.2.2-TCVN 9386-2012).  

3- Xác định hệ số tầm quan trọng I 

Công trình xây dựng đƣợc chia thành 5 cấp tùy thuộc vào khả năng gây nguy hại 

cho tính mạng con ngƣời trong trƣờng hợp công trình bị sụp đổ,… hệ quả kinh tế và xã 

hội mà nó gây ra. 

Để xác định hệ số tầm quan trọng xem trong (Error! Reference source not 

ound.Bảng 3.9). Hệ số này xem xét đến mức độ cũng nhƣ tính chất quan trong của 

công trình mà chia thành 5 cấp khác nhau: Đặc biệt, cấp I, cấp II, cấp III và cấp IV. 

Không thiết kế chịu động đất nhƣ nhau đối với mọi công trình mà công trình khác 

nhau thiết kế chịu động đất khác nhau. Tùy theo mức độ tầm quan trọng của công trình 

đang xem xét để áp dụng hệ số tầm quan trọng I thích hợp. Trƣờng hợp có thể có 

tranh chấp về mức độ tầm quan trọng, giá trị I do chủ đầu tƣ quyết định. 

Bảng 3. 9. Mức độ và hệ số tầm quan trọng 

Mức độ quan trọng Công trình 
Hệ số tầm quan 

trọng I  
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Đặc 

biệt 

Công trình có tầm 

quan trọng đặc 

biệt, không  cho 

phép hƣ hỏng do 

động đất 

- Đập  

chịu áp chiều cao > 100 m); 

- Nhà máy điện có nguồn nguyên tử; 

- Nhà để nghiên cứu sản xuất thử các chế phẩm sinh vật 

kịch độc, các loại vi khuẩn, mầm bệnh thiên nhiên và 

nhân tạo (chuột dịch, dịch tả, thƣơng hàn,...); 

- Công trình cột, tháp cao hơn 300 m; 

- Nhà nhiều tầng cao hơn 60 tầng. 

Thiết kế với gia 

tốc lớn nhất có thể 

xảy ra 

I 

Công trình có tầm 

quan trọng sống 

còn đối với việc 

bảo vệ cộng đổng, 

chức năng không 

đƣợc gián đoạn 

trong quá trình 

xảy ra động đất 

- Công trình thƣờng xuyên đông ngƣời có hệ số sử dụng 

cao: công trình mục 1-2.a, 1-2.b, 1-2.d, 1-2.h, 1-2.k. 1-

2.1, 1-2.m có số tầng, nhịp, diện tích sử dụng hoặc sức 

chứa phân loại cấp I; 

- Công trình mà chức năng không đƣợc gián đoạn sau 

động đất: công trình công cộng I.2.C diện tích sử dụng 

phân loại cấp I; 

- Công trình mục 2.9.a, 2.9.b; công trình mục 5.1.a, 5-1.b 

phân loại cấp I; 

- Kho chứa hoặc tuyến ống có liên quan đến chất độc hại, 

chất dễ cháy, dễ nổ: công trình mục 2.5.a, 2-5.b, mục 2-

5.c phân loại cấp I, II; 

- Nhà nhiều tầng cao từ 20 đến 60 tầng, công trình dạng 

tháp cao từ 200 m đến 300 m. 

1,25 

II 

Công trình có tầm 

quan trọng trong 

việc ngăn ngừa 

hậu quả động đất, 

nếu bị sụp đổ gây 

tổn thất lớn về 

ngƣời và tài sản 

- Công trình thƣờng xuyên đông ngƣời, có hệ số sử dụng 

cao: công trình mục 1.2.a, 1-2.b, 1-2.d, 1.2.h, 1-2.k, 1-2. 

I, 1,2.mcó nhịp, diện tích sử dụng hoặc sức chứa phân 

loại cấp II; 

- Trụ sở hành chính cơ quan cấp tỉnh, thành phố, các 

công trình trọng yếu của các tỉnh, thành phố đóng vai trò 

đầu mối nhƣ: công trình mục 1- 2.đ, 1- 2.g, 1- 2.h có 

nhịp, diện tích sử dụng phân loại cấp I, II; 

- Các hạng mục quan trọng, lắp đặt các thiết bị có giá trị 

kinh tế cao của các nhà máy thuộc công trình công 

nghiệp mục 2-1 đến 2-4, từ 2- 6 đến 2-8, từ 2-10 đến 12; 

công trình năng lƣợng mục 2-9.a, 2-9.b ; công trình giao 

thông 3-3, 3-5; công trình thủy lợi 4-2; công trình hầm 3-

4; công trình cấp thoát nƣớc 5-1 tất cả thuộc phân loại 

cấp I, II; 

- Các công trình quốc phòng, an ninh; 

- Nhà nhiều tầng cao từ 9 đến 19 tầng, công trình dạng 

tháp cao từ 100 m đến 200 m. 

1,00 

III 

Công trình không 

thuộc mức độ đặc 

biệt và mức độ I, 

II, IV. 

- Nhà ở mục 1-1, nhà làm việc mục 1-2.đ, nhà triển lãm 

nhà văn hóa, câu lạc bộ, nhà biểu diễn, nhà hát, rạp chiếu 

bóng, rạp xiếc phân loại cấp III; 

- Công trình công nghiệp mục 2-1 đến 2-4, từ 2- 6 đến 2-

8, từ 2-10 đến 2-12 phân loại cấp 3 diện tích sử dung từ 

1.000 m
2
 đến 5000 m

2
; 

- Nhà cao từ 4 tầng đến 8 tầng, công trình dạng tháp cao 

từ 50 m đến 100 m; 

- Tƣờng cao hơn 10 m. 

0,75 
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IV Công trình có tầm 

quan trọng thứ 

yếu đối với sự an 

toàn sinh mạng 

con ngƣời 

- Nhà tạm cao không quá 3 tầng; 

- Trại chăn nuôi gia súc 1 tầng; 

- Kho chứa hàng hóa diên tích sử dung không quá 1.000 

m
2
; 

- Xƣởng sửa chữa, công trình công nghiệp phụ trợ; thứ tự 

mục 2-1 đến 2-4, từ 2-6 đến 2-8, từ 2-10 đến 2-12 phân 

loại cấp IV; 

- Công trình mà sự hƣ hỏng do động đất ít gây thiệt hại 

về ngƣời và thiết bị quý giá. 

Không yêu cầu 

tính toán kháng 

chấn. 

4- Xác định gia tốc đỉnh đất nền thiết kế ag 

Gia tốc đỉnh nền thiết kế ag  ứng với trạng thái giới hạn cực hạn xác định theo 

công thức 

g gR Ia a   (3.50) 

TCVN 9386-2012 quy định mức độ động đất nhƣ sau: 

- Động đất mạnh ag ≥ 0,08g, phải tính toán và cấu tạo kháng chấn; 

- Động đất yếu 0,04g ≤ ag < 0,08g, chỉ cần áp dụng các biện pháp cấu tạo kháng 

chấn; 

- Động đất rất yếu ag < 0,04g, không cần thiết kế kháng chấn. 

5- Xác định hệ số ứng xử q của kết cấu 

Hệ số ứng xử q là hệ số xét đến khả năng có thể tiêu tán năng lƣợng (tính dẻo) 

của kết cấu, hệ số ứng xử q của kết cấu BTCT đƣợc lấy nhƣ sau: 

Hệ khung hoặc hệ khung tƣơng đƣơng (hỗn hợp khung - vách), có thể xác định 

gần đúng nhƣ sau (cấp dẻo trung bình): q = 3,3 - nhà một tầng; q = 3,6 - nhà nhiều 

tẩng, khung một nhịp; q = 3,9 - nhà nhiều tầng, khung nhiều nhịp hoặc kết cấu hỗn 

hợp tƣơng đƣơng khung.  

Hệ vách cứng hoặc vách cứng có lỗ cửa: q = 3,6 - hệ kết cấu hỗn hợp tƣơng 

đƣơng vách cứng, hoặc hệ vách cứng có lỗ (hệ tƣờng có dầm liên kết); q = 3,0kw - hệ 

tƣờng/vách cứng chỉ có hai tƣờng/vách cứng (không phải là vách cứng có lỗ); q = 

3,1kw - các hệ vách cứng không phải là vách cứng có lỗ. 

trong đó: 

 w 0

0 w w

0,5 1 / 3 1;

/i i

k

h l





   

 
 (3.51) 

với ,  wi wih l  lần lƣợt là chiều cao và độ dày của tƣờng thứ i. 

3.4.4.1. Phương pháp phân tích phổ phản ứng dạng dao động 

1- Phổ phản ứng đàn hồi theo phương nằm ngang 

Chuyển động động đất tại một điểm cho trƣớc trên bề mặt đƣợc biểu diễn bằng 

phổ phản ứng gia tốc đàn hồi, đƣợc gọi tắt là “phổ phản ứng đàn hồi”. 
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(1) Với các thành phần nằm ngang của tác động động đất, phổ phản ứng đàn hồi Se(T) 

đƣợc xác định bằng các công thức sau (xem Hình 3.27): 

0 : ( ) . . 1 .( .2,5 1)B e g

B

T
T T S T a S

T


 
     

 
 (3.52) 

: ( ) . . .2,5B C e gT T T S T a S    (3.53) 

: ( ) . . .2,5. C
C D e g

T
T T T S T a S

T


 
    

 
 (3.54) 

2

.
4 : ( ) . . .2,5. C D

D e g

T T
T T s S T a S

T


 
    

 
 (3.55) 

trong đó: Se(T) là phổ phản ứng đàn hồi; 

T là chu kỳ dao động của hệ tuyến tính một bậc tự do;  

ag là gia tốc nền thiết kế trên nền loại A (ag = I.agR); 

TB là giới hạn dƣới của chu kỳ, ứng với đoạn nằm ngang của phổ phản ứng gia 

tốc; 

TC là giới hạn trên của chu kỳ, ứng với đoạn nằm ngang của phổ phản ứng gia 

tốc; 

TD là giá trị xác định điểm bắt đầu của phần phản ứng dịch chuyển không đổi 

trong phổ phản ứng;  

S là hệ số nền; 

 là hệ số điều chỉnh độ cản với giá trị tham chiếu  = 1 đối với độ cản nhớt 5%, 

xem (3) của điều này. 

(2) Giá trị của chu kỳ TB, TC và TD và của hệ số nền S mô tả dạng phổ phản ứng đàn 

hồi phụ thuộc vào loại nền đất, nếu không xét tới địa chất tầng sâu (xem 3.1.2(1)). 

CHÚ THÍCH 1: Đối với 5 loại nền đất A, B, C, D, và E, giá trị các tham số S, TB, TC và TD được 

cho trong Bảng 3.9, các dạng phổ được chuẩn hóa theo ag với độ cản 5% được cho ở Hình 3.28. 

 

Hình 3. 27. Dạng của phổ phản ứng đàn hồi. 
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Bảng 3. 10. Giá trị của các tham số mô tả các phổ phản ứng đàn hồi 

Loại nền đất S TB (s) TC (s) TD (s) 

A 1,0 0,15 0,4 2,0 

B 1,2 0,15 0,5 2,0 

C 1,15 0,20 0,6 2,0 

D 1,35 0,20 0,8 2,0 

E 1,4 0,15 0,5 2,0 

CHÚ THÍCH 2: Đối với các nền đất Loại S1 và S2, cần có các nghiên cứu riêng để xác định các 

giá trị tƣơng ứng của S, TB, TC và TD. 

(3) Hệ số điều chỉnh độ cản  có thể xác định bằng biểu thức: 

 = 10/(5 + ) ≥ 0,55 (3.56) 

trong đó: 

 là tỷ số cản nhớt của kết cấu, tính bằng phần trăm. 

(4) Trƣờng hợp đặc biệt, khi dùng tỷ số cản nhớt khác 5%, giá trị này đƣợc cho trong 

phần có liên quan của tiêu chuẩn này. 

(5) Phổ phản ứng chuyển vị đàn hồi SDe(T), nhận đƣợc bằng cách biến đổi trực tiếp 

phổ phản ứng gia tốc đàn hồi Se(T) theo biểu thức sau: 

2

( ) ( ).
2.

De e

T
S T S T



 
  

 
 (3.57) 

 

Hình 3. 28. Phổ phản ứng đàn hồi cho các loại nền đất từ A đến E (độ cản 5%). 

(6) Thông thƣờng, cần áp dụng biểu thức (3.59) cho các chu kỳ dao động không vƣợt 

quá 4,0s. Đối với các kết cấu có chu kỳ dao động lớn hơn 4,0s có thể dùng một định 

nghĩa phổ chuyển vị đàn hồi hoàn chỉnh hơn. 

CHÚ THÍCH: Với phổ phản ứng đàn hồi tham khảo Chú thích 1 của (1), một định nghĩa như thế được 

trình bày trong Phụ lục tham khảo A dưới dạng phổ phản ứng chuyển vị. Đối với những chu kỳ dài 

hơn 4s, phổ phản ứng gia tốc đàn hồi Se(T) có thể lấy từ phổ phản ứng chuyển vị đàn hồi dựa vào biểu 

thức (3.57). 
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2- Phổ phản ứng đàn hồi theo phương thẳng đứng 

(1)P Thành phần thẳng đứng của tác động động đất phải đƣợc thể hiện bằng phổ 

phản ứng đàn hồi, Sve(T), đƣợc xác định bằng cách sử dụng các biểu thức nhƣ sau: 

0 : ( ) . 1 .( .3,0 1)B ve vg

B

T
T T S T a

T


 
     

 
 (3.58) 

: ( ) . .3,0B C ve vgT T T S T a     (3.59) 

: ( ) . .3,0. C
C D ve vg

T
T T T S T a

T
    (3.60) 

2

.
4 : ( ) . .3,0. C D

D ve vg

T T
T T s S T a

T
    (3.61) 

CHÚ THÍCH: Đối với 5 loại nền đất A, B, C, D và E, giá trị các tham số TB, TC và TD mô tả 

các phổ thẳng đứng được cho trong Bảng 3.8. Không áp dụng các giá trị này cho các loại nền đất đặc 

biệt S1 và S2. 

Bảng 3. 11. Giá trị các tham số mô tả phổ phản ứng đàn hồi theo phƣơng thẳng đứng 

avg / ag TB (s) TC (s) TD (s) 

0,90 0,05 0,15 1,0 

Chuyển vị nền thiết kế: Trừ phi có nghiên cứu riêng dựa trên thông tin sẵn có, 

giá trị chuyển vị nền thiết kế dg ứng với gia tốc nền thiết kế có thể tính bằng biểu thức 

sau: 

dg = 0,025.ag.S.TC.TD (3.62) 

với ag, S, TC và TD nhƣ đã định nghĩa trong 1. 

3- Phổ thiết kế dùng cho phân tích đàn hồi 

(1) Khả năng kháng chấn của hệ kết cấu trong miền ứng xử phi tuyến thƣờng cho 

phép thiết kế kết cấu với các lực động đất bé hơn so với các lực ứng với phản ứng đàn 

hồi tuyến tính. 

(2) Để tránh phải phân tích trực tiếp các kết cấu không đàn hồi, ngƣời ta kể đến 

khả năng tiêu tán năng lƣợng chủ yếu thông qua ứng xử dẻo của các cấu kiện của nó 

và/hoặc các cơ cấu khác bằng cách phân tích đàn hồi dựa trên phổ phản ứng đƣợc chiết 

giảm từ phổ phản ứng đàn hồi, vì thế phổ này đƣợc gọi là “phổ thiết kế". Sự chiết giảm 

đƣợc thực hiện bằng cách đƣa vào hệ số ứng xử q. 

(3) Hệ số ứng xử q biểu thị một cách gần đúng tỷ số giữa lực động đất mà kết cấu 

sẽ phải chịu nếu phản ứng của nó là hoàn toàn đàn hồi với tỷ số cản nhớt 5% và lực 

động đất có thể sử dụng khi thiết kế theo mô hình phân tích đàn hồi thông thƣờng mà 

vẫn tiếp tục bảo đảm cho kết cấu một phản ứng thỏa mãn các yêu cầu đặt ra. Giá trị 

của hệ số ứng xử q trong đó có xét tới ảnh hƣởng của tỷ số cản nhớt khác 5% của các 

loại vật liệu và hệ kết cấu khác nhau tùy theo cấp dẻo kết cấu tƣơng ứng đƣợc cho 
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trong các phần khác nhau của tiêu chuẩn này. Giá trị của hệ số ứng xử q có thể khác 

nhau theo các hƣớng nằm ngang khác nhau của kết cấu, mặc dù sự phân loại cấp dẻo 

kết cấu phải nhƣ nhau trong mọi hƣớng. 

(4) Đối với các thành phần nằm ngang của tác động động đất, phổ thiết kế Sd(T) 

đƣợc xác định bằng các biểu thức sau: 

2 2,5 2
0 : ( ) . . .

3 3
B d g

B

T
T T S T a S

T q
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 (3.66) 

trong đó: 

ag, S, TC, TD nhƣ đã định nghĩa trong 1; 

Sd(T) là phổ thiết kế; 

q là hệ số ứng xử; 

 là hệ số ứng với cận dƣới của phổ thiết kế theo phƣơng nằm ngang,  = 0,2. 

(5) Đối với thành phần thẳng đứng của tác động động đất, phổ thiết kế cho bởi 

các biểu thức từ (3.65) đến (3.68) với gia tốc nền thiết kế avg theo phƣơng thẳng đứng 

đƣợc thay bằng giá trị ag; S lấy bằng 1,0 còn các tham số khác nhƣ đã định nghĩa trong 

2. 

(6) Đối với thành phần thẳng đứng của tác động động đất, hệ số ứng xử q nói 

chung có thể lấy nhỏ hơn hoặc bằng 1,5 cho mọi loại vật liệu và hệ kết cấu. 

(7) Việc lấy giá trị q lớn hơn 1,5 theo phƣơng thẳng đứng cần đƣợc lý giải thông 

qua phân tích phù hợp. 

(8) Phổ thiết kế đƣợc xác định nhƣ trên không thích hợp cho thiết kế công trình 

có hệ cách chấn đáy hoặc có hệ tiêu tán năng lƣợng. 

Xây dựng hàm phổ thiết kế đàn hồi theo phương nằm ngang: xây dựng hàm 

phổ phản ứng để gán vào phần mềm Etabs tính động đất. Hàm phổ theo phƣơng ngang 

đƣợc tính nhƣ sau: 

No Period T Sd 

  

g m/s
2
 

0  T  TB  0  T  0.2 0 0.0647 0.6347 

 0.01 0.0655 0.6426 
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 0.05 0.0688 0.6749 

 0.075 0.0708 0.6945 

 0.1 0.0728 0.7142 

 0.125 0.0748 0.7338 

TB  T  TC  0.2  T  0.6 0.2 0.0809 0.7936 

 0.3 0.0809 0.7936 

 0.4 0.0809 0.7936 

 0.5 0.0809 0.7936 

TC  T  TD  0.6  T  2 0.6 0.0809 0.7936 

 0.7 0.0693 0.6798 

 0.8 0.0607 0.5955 

 0.9 0.0539 0.5288 

 1.0 0.0485 0.4758 

 1.2 0.0404 0.3963 

 1.4 0.0347 0.3404 

 1.6 0.0303 0.2972 

 1.8 0.027 0.2649 

TD  T  2  T 2.0 0.0243 0.2384 

 2.5 0.0169 0.1658 

 3 0.0169 0.1658 

 3.5 0.0169 0.1658 

 4 0.0169 0.1658 

 

4- Phương pháp phân tích phổ phản ứng dạng dao động theo TCVN 9386-

2012 
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(1) Phƣơng pháp phân tích này cần đƣợc áp dụng cho nhà không thỏa mãn những 

điều kiện đã nêu trong 4.3.3.2.1(2) khi ứng dụng phƣơng pháp phân tích tĩnh lực 

ngang tƣơng đƣơng. 

(2) Phải xét tới phản ứng của tất cả các dạng dao động góp phần đáng kể vào 

phản ứng tổng thể của nhà. 

(3) Các yêu cầu cho trong mục (2) có thể thỏa mãn nếu đạt đƣợc một trong hai 

điều kiện sau: 

- Tổng các khối lƣợng hữu hiệu của các dạng dao động đƣợc xét chiếm ít nhất 90 

% tổng khối lƣợng của kết cấu; 

- Tất cả các dạng dao động có khối lƣợng hữu hiệu lớn hơn 5% của tổng khối 

lƣợng đều đƣợc xét đến. 

CHÚ THÍCH: Khối lượng hữu hiệu mk ứng với dạng dao động k, được xác định sao cho 

lực cắt đáy Fbk, tác động theo phương tác động của lực động đất, có thể biểu thị dưới dạng 

Fbk = Sd(Tk)mk. Có thể chứng minh rằng tổng các khối lượng hữu hiệu (đối với tất cả các dạng 

dao động và đối với một hướng cho trước) là bằng khối lượng kết cấu. 

(4) Khi sử dụng mô hình không gian, những điều kiện trên cần đƣợc kiểm tra cho 

mỗi phƣơng cần thiết. 

(5) Nếu các yêu cầu quy định trong (3) không thể thỏa mãn (ví dụ trong nhà và 

công trình mà các dao động xoắn góp phần đáng kể) thì số lƣợng tối thiểu các dạng 

dao động k đƣợc xét trong tính toán khi phân tích không gian cần thỏa mãn cả hai điều 

kiện sau: 

3k n  (3.67) 

và 

Tk ≤ 0,20 s (3.68) 

trong đó: 

k là số dạng dao động đƣợc xét tới trong tính toán; 

n là số tầng ở trên móng hoặc đỉnh của phần cứng phía dƣới; 

Tk là chu kỳ dao động của dạng thứ k. 

Quy trình tính toán: 

Bước 1: Xác định các chu kỳ và dạng dao động riêng của nhà, sử dụng các phần 

mềm phân tích kết cấu thông dụng hiện nay nhƣ: SAP2000, ETABS…Tính toán các 

chu kỳ dao động riêng và dạng dao động riêng cần thiết của công trình (số chu kỳ và 

dạng dao động riêng cần thiết là k xác định theo mục nêu trên); 

Bước 2: Xác định phổ thiết kế không thứ nguyên Sd(Tk) của nhà và công trình 

ứng với từng dạng dao động theo các công thức từ (3.63) đến (3.66) bằng cách thay thế 

chu kỳ dao động riêng T bằng Tk, trong đó k là dạng dao động riêng thứ k tƣơng ứng 

theo phƣơng X trên mặt bằng nhà; 
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Bước 3: Xác định tổng lực cắt tại chân công trình tƣơng ứng với dạng dao động 

thứ k theo phƣơng X theo công thức sau 

Fbk = Sd(Tk)mk (3.69) 

trong đó: Sd(Tk) là phổ thiết kế không thứ nguyên đƣợc xác định bƣớc 2 

 mk là trọng lƣợng hữu hiệu hay hiệu dụng (theo phƣơng X trên mặt bằng) tƣơng 

ứng với dạng dao động thứ k, xác định theo công thức sau 

2

,

1

2

,

1

n

k j j

j

k n

k j j

j

X m

m

X m





 
 
 




 (3.70) 

trong đó: n là tổng bậc tự do (số tầng) xét đến theo phƣơng X; 

Xk,j là giá trị chuyển vị tỉ đối theo phƣơng X của trọng tâm phần công trình thứ j 

ứng với dạng dao động thứ k; 

mj  là trọng lƣợng tập trung tại tầng thứ j của công trình. 

Khối lượng hiệu dụng của dạng dao động biểu thị phần khối lượng trong tổng 

khối lượng của kết cấu phản ứng lại tác động động đất trong mỗi dạng dao động i. 

Bước 4: Phân phối tải trọng ngang lên các cao trình tầng của tổng lực cắt tại chân 

công trình tƣơng ứng với dạng dao động thứ k theo phƣơng X  nhƣ sau: 

,

,

,

1

k i ii

X k bk n

k j j

k

X m
F F

X m





 

(3.71) 

trong đó: ,

i

X kF  là lực ngang tác dụng lên tầng thứ j theo phƣơng X ứng với dạng dao 

động riêng thứ k; 

im  và jm  là trọng lƣợng tập trung tại tầng thứ i và j của công trình; 

,k iX  và ,k jX  giá trị chuyển vị theo phƣơng X tại điểm đặt trọng lƣợng thứ i và j 

của dạng dao động thứ k. 

Bước 5: Tổ hợp các phản ứng dạng dao động 

Phản ứng ở hai dạng dao động i và j (kể cả các dạng dao động tịnh tiến và xoắn) 

có thể xem là độc lập với nhau, nếu các chu kỳ Ti và Tj thỏa mãn điều kiện sau: 

Tj ≤ 0,9 . Ti (3.72) 

Khi tất cả các dạng dao động cần thiết (xem (3) - (5)) đƣợc xem là độc lập với 

nhau, thì giá trị lớn nhất EE của hệ quả tác động động đất có thể lấy bằng: 

2

E EiE E   (3.73) 

trong đó: 
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EE là hệ quả tác động động đất đang xét (lực, chuyển vị, v.v…); 

EEi là giá trị của hệ quả tác động động đất này do dạng dao động thứ i gây ra. 

Nếu phản ứng ở hai dạng dao động i và j được xem là phụ thuộc lẫn nhau nếu 

các chu kỳ Ti và Tj thỏa mãn điều kiện 

0,9 / 1,0/ 0,9j iT T   (3.74) 

Trong trƣờng hợp phản ứng của hai dạng dao động i và j là không độc lập với 

nhau theo điều kiện (3.74) thì giá trị lớn nhất của tác động động đất EE sẽ lấy bằng 

1 1

k k

E ij i j

i j

E r E E
 

   (3.75) 

trong đó ijr  đƣợc xác định nhƣ sau 

 

     

3/2

2
2 2 2 2 2

8

1 4 1 4

i j i j

ij

i j i j

r
    

       




    
 (3.76) 

với /j iT T   và i  và j là hệ số cản nhớt lấy bằng 5%. 

Ghi chú: Đối với phương Y trên mặt bằng, quy trình tính toán cũng tiến hành 

tương tự như đối với phương X cho cả phương pháp phân tích tĩnh lực ngang tương 

đương và phương pháp phân tích phổ phản ứng. 

Phương pháp nhập tải trong phầm mềm Etabs: 

Phương pháp 1. Tải trọng động đất được tính toán bán tự động trong Etabs. 

Trong phƣơng pháp này, ta phải tính toán các giá trị của phổ phản ứng gia tốc và 

lƣu vào 1 file *.txt, nội dung của file này nhƣ sau 

 

Bạn khai báo phổ phản ứng gia tốc trong Etabs theo các bƣớc sau đây: 

Vào menu Define -> Response Spectrum Functions, cửa số Define Response 

Spectrum Functions sẽ xuất hiện 

http://i94.photobucket.com/albums/l99/hoangvantmb/0205-DefSpectrum5-1.png
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Trong mục Choose Function Type to Add, chọn Spectrum from File. Click Add New 

Function, cửa sổ Response Spectrum Function Definition sẽ xuất hiện 

 

Trong mục Values are, chọn Period vs Value, click Browe để chọn file 

http://i94.photobucket.com/albums/l99/hoangvantmb/0201-DefSpectrum-1.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0202-DefSpectrum2-1.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0201-DefSpectrum-1.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0202-DefSpectrum2-1.png
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Sau khi chọn file, click Display Graph để Etabs đọc và biếu diễn phổ phản ứng gia tốc 

 

Bạn có thể chọn Convert to User Defined để Etabs chép dữ liệu từ file này vào file *.EDB. 

Khai báo xong phổ phản ứng gia tốc, nhiệm vụ tiếp theo là khai báo trƣờng hợp tải 

trong động đất. 

http://i94.photobucket.com/albums/l99/hoangvantmb/0203-DefSpectrum3.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0204-DefSpectrum4.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0203-DefSpectrum3.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0204-DefSpectrum4.png
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Vào menu Define -> Response Spectrum Case, cửa số Define Response Spectra sẽ 

xuất hiện. 

   

Click Add New Spectrum, cửa sổ Response Spectrum Case Data sẽ xuất hiện. Trong 

mục Input Response Spectra, chọn phƣơng tƣơng ứng và nhập giá trị ở ô Scale Factor với 

giá trị phụ thuộc vào đơn vị đang sử dụng. Lƣu ý rằng đơn vị mặc định của phổ phản ứng gia 

tốc là m/s
2
, nên nếu đang dùng đơn vị mm, bạn phải nhập giá trị 1000 vào ô Scale Factor. 

Tiếp tục khai báo cho các phƣơng khác, và từ đây chúng ta có thể đƣa tải trọng 

vào tổ hợp nhƣ các trƣờng hợp tải trọng khai báo thông thƣờng. 

Phương pháp 2: Tải trọng động đất được tính toán tự động hoàn toàn trong 

Etabs 

 

Do TCVN 9386-2012 đƣợc biên dịch từ EuroCode 8, nên ta có thể sử dụng 

phƣơng pháp khai báo tải trọng động đất theo tiêu chuẩn EuroCode 8 để Etabs tính 

toán tải trọng động đất một cách tự động hoàn toàn. Trong phƣơng pháp này, chúng ta 

phải khai báo giá trị của đỉnh gia tốc nền, loại đất nền, hệ số ứng xử của kết cấu. 

http://i94.photobucket.com/albums/l99/hoangvantmb/0206-DefSpectrum6.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0207-DefSpectrum7.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0206-DefSpectrum6.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0207-DefSpectrum7.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0206-DefSpectrum6.png
http://i94.photobucket.com/albums/l99/hoangvantmb/0207-DefSpectrum7.png
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Các bƣớc tiến hành: Lựa chọn tiêu chuẩn EuroCode 8 cho việc tính toán tải trọng động 

đất. 

Khai báo các thông số 

 

Trong hộp thoại trên:  Mục Direction and Eccentricity dùng để khai báo 

phƣơng của lực và độ lệch tâm ngẫu nhiên. Ví dụ trong trƣờng hợp tải trong động đất 

theo phƣơng X, ta chọn X Dir + Eccen Y với ý nghĩa rằng tải trọng theo phƣơng X, và 

kể đến độ lệch tâm ngẫu nhiên. Giá trị của độ lệch tâm đƣợc khai trong: Ecc. Ratio, 

giá trị này áp dụng chung cho tất cả các tầng. Đối với trƣờng hợp độ lệch tâm giữa các 

tầng là khác nhau, ta khai báo trong phần Override Diaph. Eccen. Mục Time 

Period dùng để khai báo chu kỳ dao động của hệ kết cấu. Lựa chọn Approxomate áp 

dụng cho trƣờng hợp tính toán gần đúng chu kỳ dao động, giá trị khai báo là chiều cao 

của công trình. Lựa chọn Program Calc có nghĩa là Etabs sẽ tính toán chu kỳ dao 

động của kết cấu. Lựa chọn User Defined dùng cho trƣờng hợp ngƣời dùng nhập trực 

tiếp giá trị chu kỳ dao động của kết cấu. Mục Story Range dùng để khai báo các tầng 

sẽ chịu tải trọng động đất. Mục Parameters dùng để khai báo các tham số liên quan 

đến việc xác định tải trọng động đất. Ground Acceleration, ag là giá trị của gia tốc 

nền, đã đƣợc bao gồm hệ số tầm quan trọng của công trình. Spectrum Type là dạng 

của phổ phản ứng gia tốc, tùy thuộc vào vận tốc sóng mặt mà sử dụng dạng phổ nào 

(quy định trong EuroCode 8). Qua so sánh mục 3.2.2.2 trong tiêu chuẩn EuroCode 8 

và mục 3.2.2.2 trong tiêu chuẩn TCVN 9386-2012, Spectrum Type có giá trị là 1 là 

phù hợp với tiêu chuẩn Việt Nam. Group Type là dạng của nền đất, phụ thuộc vào chỉ 

số SPT trung bình ở 30m đầu tiên để xác định loại nền đất. Lower Bound Facor, 

Beta là chỉ số cận dƣới của phổ. 
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3.4.4.2. Phương pháp phân tích tĩnh lực ngang tương đương 

(1) Phƣơng pháp phân tích này có thể áp dụng cho các nhà mà phản ứng của nó 

không chịu ảnh hƣởng đáng kể bởi các dạng dao động bậc cao hơn dạng dao động cơ 

bản trong mỗi phƣơng chính. 

(2) Yêu cầu (1) của điều này đƣợc xem là thỏa mãn nếu kết cấu nhà đáp ứng 

đƣợc cả hai điều kiện sau: 

a) Có các chu kỳ dao động cơ bản T1 theo hai hƣớng chính nhỏ hơn các giá trị 

sau: 

1

4.

2,0

CT
T

s


 


 (3.77) 

trong đó TC là giới hạn trên của chu kỳ, ứng với đoạn nằm ngang của phổ phản 

ứng gia tốc; 

b) Thỏa mãn những tiêu chí về tính đều đặn theo mặt đứng cho trong 4.2.3.3 

(TCVN9386-2012) nhƣ sau: 

- Đối với nhà đƣợc xếp loại đều đặn theo mặt đứng cần thỏa mãn tất cả những 

điều kiện sau đây: 

- Tất cả các hệ kết cấu chịu tải trọng ngang nhƣ vách, lõi, tƣờng hoặc khung, phải 

liên tục từ móng tới mái của nhà hoặc tới đỉnh của vùng có giật cấp của nhà nếu có 

giật cấp tại các độ cao khác nhau. 

- Cả độ cứng ngang lẫn khối lƣợng của các tầng riêng rẽ phải giữ nguyên không 

đổi hoặc giảm từ từ, không thay đổi đột ngột từ móng tới đỉnh nhà đang xét. 

- Trong các nhà khung, tỷ số giữa độ bền thực tế và độ bền yêu cầu theo tính toán 

của tầng không đƣợc thay đổi một cách không cân xứng giữa các tầng liền kề. Về mặt 

này, các trƣờng hợp riêng của khung có khối xây chèn đƣợc đề cập trong 4.3.6.3 2. 

- Khi có giật cấp thì áp dụng các quy định bổ sung sau: 

+ Đối với các giật cấp liên tiếp mà vẫn giữ đƣợc tính đối xứng trục, sự giật cấp 

tại bất kỳ tầng nào cũng không đƣợc lớn hơn 20% kích thƣớc của mặt bằng kề dƣới 

theo hƣớng giật cấp (xem Hình 3.29.a và 3.29.b); 

+ Đối với giật cấp một lần nằm trong phần thấp hơn 15% chiều cao H của hệ kết 

cấu chính kể từ móng, kích thƣớc chỗ lùi vào không đƣợc lớn hơn 50% kích thƣớc mặt 

bằng ngay phía dƣới (xem Hình 3.29.c). Trong trƣờng hợp này, kết cấu của vùng đáy 

trong phạm vi hình chiếu đứng của các tầng phía trên cần đƣợc thiết kế để chịu đƣợc ít 

nhất 75% các lực cắt ngang có thể sinh ra ở vùng này trong một công trình tƣơng tự 

nhƣng có đáy không mở rộng. 

+ Nếu các giật cấp không giữ đƣợc tính đối xứng, tổng kích thƣớc của các giật 

cấp ở mỗi mặt tại tất cả các tầng không đƣợc lớn hơn 30% kích thƣớc mặt bằng tầng 
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trệt hoặc mặt bằng trên đỉnh của phần cứng phía dƣới và kích thƣớc của mỗi giật cấp 

không đƣợc lớn hơn 10% kích thƣớc mặt bằng liền dƣới (xem Hình 3.29.d). 

a) b) giật cấp nằm trên mức 0,15H 

 

                c) giật cấp nằm dƣới mức 0,15H        d) 

 

                           
1 3 0,50

L L

L


           

2 0,30
L L

L


 ; 1 2

1

0,10
L L

L


  

Hình 3. 29. Các tiêu chí về tính đều đặn của nhà có giật cấp. 

Lực cắt đáy động đất: 

- Theo mỗi phƣơng nằm ngang đƣợc phân tích, lực cắt đáy động đất Fb phải đƣợc 

xác định theo biểu thức sau: 

Fb = Sd (T1) m  (3.78) 

trong đó: 

Sd (T1) là tung độ của phổ thiết kế tại chu kỳ T1 (xem 3.4.4.1(3)); 

T1 là chu kỳ dao động cơ bản của nhà do chuyển động ngang theo phƣơng đang 

xét; 

m là tổng khối lƣợng của nhà ở trên móng hoặc ở trên đỉnh của phần cứng phía 

dƣới (tĩnh tải lấy toàn bộ, hoạt tải lấy 50%); 

 là hệ số hiệu chỉnh, lấy nhƣ sau:  = 0,85 nếu T1 ≤ 2. TC với nhà có trên 2 tầng 

hoặc  = 1,0 với các trƣờng hợp khác. 

CHÚ THÍCH: Hệ số  tính đến thực tế là trong các nhà có ít nhất 3 tầng và 3 bậc tự do 

theo mỗi phương nằm ngang, khối lượng hữu hiệu của dạng dao động cơ bản là trung bình 

nhỏ hơn 15% so với tổng khối lượng nhà. 



-89- 

 

- Để xác định chu kỳ dao động cơ bản T1  của nhà, có thể sử dụng các biểu thức 

của các phƣơng pháp động lực học công trình (ví dụ phƣơng pháp Rayleigh). 

- Đối với nhà có chiều cao không lớn hơn 40 m, giá trị T1  (tính bằng giây) có thể 

tính gần đúng theo biểu thức sau: 

T1 = Ct H 
3/4 (3.79) 

trong đó: 

Ct = 0,085 đối với khung thép không gian chịu mômen; 

Ct = 0,075 đối với khung bêtông không gian chịu mômen và khung thép có giằng 

lệch tâm;  

Ct = 0,050 đối với các kết cấu khác; 

H là chiều cao nhà, tính bằng m, từ mặt móng hoặc đỉnh của phần cứng phía 

dƣới. 

- Đối với các kết cấu có tƣờng chịu cắt bằng bêtông hoặc khối xây, giá trị Ct 

trong biểu thức (3.81) có thể lấy bằng: 

Ct = 0,075/ cA  (3.80) 

trong đó: 

Ac =  [Ai . (0,2 + (lwi / H))
2
] (3.81) 

và: 

Ac là tổng diện tích hữu hiệu của các tƣờng chịu cắt trong tầng đầu tiên của nhà, 

tính bằng mét vuông; 

Ai là diện tích tiết diện ngang hữu hiệu của tƣờng chịu cắt i theo hƣớng đang xét 

trong tầng đầu tiên của nhà, tính bằng mét vuông; 

H là chiều cao nhà, tính bằng m, từ mặt móng hoặc đỉnh của phần cứng phía 

dƣới; 

lwi là chiều dài của tƣờng chịu cắt ở tầng đầu tiên theo hƣớng song song với các 

lực tác động, tính bằng mét, với điều kiện: lwi /H không đƣợc vƣợt quá 0,9. 

- Một cách khác có thể xác định T1 (s) theo biểu thức sau: 

T1 = 2 . d  (3.82) 

trong đó: 

d là chuyển vị ngang đàn hồi tại đỉnh nhà, tính bằng mét, do các lực trọng trƣờng 

tác dụng theo phƣơng ngang gây ra. 

Phân bố lực động đất nằm ngang: 

- Các dạng dao động cơ bản theo các phƣơng nằm ngang đƣợc xét của nhà có thể 

đƣợc xác định bằng các phƣơng pháp động lực học công trình hoặc có thể lấy gần 

đúng bằng các chuyển vị ngang tăng tuyến tính dọc theo chiều cao của nhà. 
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- Tác động động đất phải đƣợc xác định bằng cách đặt các lực ngang Fi vào tất cả 

các tầng i ở hai mô hình phẳng 

.
.

.

i i
i b

j j

s m
F F

s m



 (3.83) 

trong đó: 

Fi là lực ngang tác dụng tại tầng thứ i; 

Fb là lực cắt đáy do động đất tính theo (3.80); 

si, sj lần lƣợt là chuyển vị của các khối lƣợng mi, mj trong dạng dao động cơ bản 

(các thành phần chuyển vị si, sj theo phƣơng X, phƣơng Y chính là các véc tơ riêng UX, 

UY trong Etabs) ;  

mi, mj là khối lƣợng của các tầng tính nhƣ phần sau. 

- Lực nằm ngang Fi xác định theo điều này phải đƣợc phân bố cho hệ kết cấu 

chịu tải ngang với giả thiết sàn cứng trong mặt phẳng của chúng. 

 

Hình 3. 30. Phân phối lực động đất lên tầng thứ i. 

Khối lượng công trình m: 

Các hiệu ứng quán tính của tác động động đất thiết kế phải đƣợc xác định có xét 

đến các khối lƣợng liên quan tới tất cả các lực trọng trƣờng xuất hiện trong tổ hợp tải 

trọng sau: 

Gk,j "+" E,i . Qk,i (3.84) 

trong đó: 

E,i là hệ số tổ hợp tải trọng đối với tác động thay đổi thứ i; 

Fb

Fi
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Các hệ số tổ hợp E,i xét đến khả năng là tác động thay đổi Qk,i không xuất hiện 

trên toàn bộ công trình trong thời gian xảy ra động đất. Các hệ số này còn xét đến sự 

tham gia hạn chế của khối lƣợng vào chuyển động của kết cấu do mối liên kết không 

cứng giữa chúng. 

E,i  =  . 2,i (3.85) 

trong đó: 
2,i  là hệ số tổ hợp đối với các giá trị gần nhƣ thƣờng xuyên của tải 

trọng tạm thời i. Các giá trị 2,i cho trong Bảng 3.12. 

Bảng 3. 12. Các giá trị 2,i  đối với nhà 

Tác động 2,i 

Tải trọng đặt lên nhà, loại  

Loại A: Khu vực nhà ở, gia đình 0,3 

Loại B: Khu vực văn phòng 0,3 

Loại C: Khu vực hội họp 0,6 

Loại D: Khu vực mua bán 0,6 

Loại E: Khu vực kho lƣu trữ 0,8 

Loại F: Khu vực giao thông, trọng lƣợng xe ≤ 30 kN 0,6 

Loại G: Khu vực giao thông, 30 kN ≤ trọng lƣợng xe ≤ 160 kN 0,3 

Loại H: Mái 0 

Các giá trị  cho trong Bảng 3.13. 

Bảng 3. 13. Giá trị của  để tính toán E,i 

Loại tác động thay đổi Tầng  

Các loại từ A - C* Mái 

Các tầng đƣợc sử dụng đồng thời 

Các tầng đƣợc sử dụng độc lập 

1,0 

0,8 

0,5 

Các loại từ D-F* và kho 

lƣu trữ 

 1,0 

* Các loại tác động thay đổi đƣợc định nghĩa trong Bảng 3.12. 

Chú ý: Động đất có thể tác động lên nhà theo phƣơng bất kỳ trong không gian. 

Nhà cao tầng thƣờng đƣợc thiết kế với hình dáng mặt bằng và mặt đứng đơn giản, tải 

trọng động đất đƣợc xem nhƣ tác động theo hai phƣơng theo hai trục dọc và ngang của 

nhà. Tuy nhiên, khi mặt bằng nhà phức tạp cần chọn phƣơng tính toán bất lợi nhất.  

Tác động của tải trọng động đất theo phƣơng thẳng đứng của nhà cao tầng có thể 

không xét tới. Theo tiêu chuẩn, đối với các kết cấu công xon nằm ngang hoặc xiên, kết 
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cấu vòm, dàn khẩu độ từ 24m trở lên xây dựng trong vùng động đất còn phải tính toán 

theo phƣơng thẳng đứng. 

3.4.5. Số dạng dao động cần xét đến trong tính toán động đất 

Trong tính toán, nhà cao tầng lấy bao nhiêu dạng dao động tùy thuộc mức độ 

tham gia của dạng dao động đó vào dạng dao động chung của công trình, thông thƣờng 

chỉ xét 3 dạng dao động chính đầu tiên vì nó ảnh hƣởng lớn nhất tới phản ứng toàn 

phần của hệ kết cấu, số dạng dao động xem xét sẽ tăng thêm với kết cấu có chu kỳ dao 

động riêng cơ bản lớn hơn 1,5s và kết cấu có tỷ số chiều cao trên chiều rộng lớn hơn 5. 

Việc tổ hợp các phản ứng của các dạng dao động chính thƣờng đƣợc thực hiện 

theo phƣơng pháp căn bậc hai của tổng bình phƣơng. 

Đối với nhà cao tầng sau khi tính đƣợc lực động đất tác động vào sàn thứ k ứng 

với n dạng dao động đầu tiên là Fk1, Fk2,…, Fkn, ta tổ hợp các giá trị trên để xác định 

lực động đất tác dụng vào sàn thứ k. 

2 2 2

1 2 ...k k k knF F F F     (3.86) 

3.4.6. Tổ hợp các hệ quả của các thành phần tác động động đất 

3.4.6.1. Tổ hợp các hệ quả các thành phần tác động động đất theo phương ngang 

Nhƣ đã biết, tác động động đất có thể xuất hiện theo bất kỳ hƣớng nào trong 

không gian nên việc giả thiết lực động đất tác động dọc theo các trục chính của nhà 

chỉ mang tính quy ƣớc. Vì lý do này các tiêu chuẩn thiết kế kháng chấn thƣờng kiến 

nghị phải tổ hợp các hệ quả tác động động đất theo phƣơng ngang (nội lực và chuyển 

vị) đƣợc xác định một cách độc lập theo cả hai phƣơng vuông góc với nhau. Tiêu 

chuẩn TCVN 9386:2012 quy định các thành phần ngang của tác động động đất phải 

tác động đồng thời theo cả hai hƣớng chính của nhà và không phụ thuộc vào phƣơng 

pháp tính toán. Việc tổ hợp các thành phần ngang của tác động động đất có thể thực 

hiện theo một trong hai cách nhƣ sau 

1- Cách thứ nhất 

Trƣớc hết phản ứng của kết cấu đối với mỗi thành phần ngang của tác động động 

đất đƣợc xác định một cách độc lập bằng cách sử dụng các quy tắc tổ hợp đối với các 

phản ứng dạng dao động chính. Tiếp sau đó, giá trị lớn nhất của mỗi hệ quả tác động 

lên kết cấu do hai thành phần ngang của tác động động đất đƣợc xác định bằng cách 

lấy căn bậc hai của tổng các bình phƣơng các giá trị hệ quả tác động do mỗi thành 

phần ngang gây ra: 

2 2

maxEd Edx EdyE E E    (3.87) 

trong đó: EEdmax là các giá trị hệ quả (mô men uốn, mô men xoắn, lực cắt, lực dọc, 

chuyển vị) tác động lớn nhất do tác động đồng thời của các lực động đất ngang trong 

cả hai phƣơng chính gây ra; 
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EEdx và EEdy tƣơng ứng là các giá trị hệ quả tác động do các lực động đất tác động 

theo phƣơng x-x và y-y gây ra. 

Nói chung nếu dùng kết quả xác định theo (3.90) để tổ hợp với các hệ quả do các 

loại tải trọng khác gây ra, ta sẽ đƣợc các giá trị phản ứng quá thiên về an toàn. Do đó 

các tiêu chuẩn thiết kế kháng chấn cho phép dùng cách tổ hợp thứ hai sau đây. 

2- Cách thứ hai 

Trong thực tế, lực động đất tác động theo hai phƣơng ngang vuông góc với nhau 

không phải lúc nào cũng cùng pha với nhau, do đó có thể sử dụng một phƣơng án tổ 

hợp khác trong đó lấy 100% hệ quả tác động động đất theo một phƣơng kết hợp với 

30% hệ quả tác động động đất theo phƣơng vuông góc. Cụ thể nhƣ sau 

" "0,30 ;      0,30 " "Ed Edx Edy Ed Edx EdyE E E E E E     (3.88) 

trong đó: Dấu của mỗi thành phần trong các tổ hợp kể trên phải lấy theo hệ quả tác 

động riêng đang xét bất lợi nhất. 

Đối với các công trình nhà thỏa mãn các tiêu chí về tính đều đặn trong mặt bằng, 

trong đó các tƣờng hoặc các hệ giằng độc lập theo hai phƣơng ngang chính là các cấu 

kiện kháng chấn chính duy nhất, thì tác động động đất dọc theo hai trục ngang chính 

vuông góc của kết cấu có thể đƣợc giả thiết tác động độc lập và không áp dụng cách tổ 

hợp trên. 

3.4.6.2. Tổ hợp các thành phần của tác động động đất theo phương đứng và ngang 

Theo tiêu chuân TCVN 9386-2012, nếu gia tốc chuyển động địa chấn theo 

phƣơng thẳng đứng aVg lớn hơn 0,25g (2,5 m/s
2
) cần phải xét tới thành phần thẳng 

đứng của tác động động đất trong các trƣờng hợp sau: 

Các bộ phận kết cấu nằm ngang hoặc gần nhƣ nằm ngang có nhịp bằng hoặc lớn 

hơn 20 m; Các thành phần kết cấu dạng côngxôn nằm ngang hoặc gần nhƣ nằm ngang 

dài hơn 5 m; Các thành phần kết cấu ứng lực trƣớc nằm ngang hoặc gần như nằm 

ngang; Các dầm đỡ các cột; Các kết cấu có cách chấn đáy. 

Khi các bộ phận kết cấu trên phải xét tới các thành phần tác động động đất theo 

phƣơng ngang, có thể sử dụng ba tổ hợp sau để tính toán các hệ quả tác động 

" "0,30 " "0,30

0,30 " " " "0,30

0,30 " "0,3 " "

Ed Edx Edy Edz

Ed Edx Edy Edz

Ed Edx Edy Edz

E E E E

E E E E

E E E E

   


  


  

 (3.89) 

EEdz là biểu thị các hệ quả tác động do tác dụng của thành phần thẳng đứng của 

tác động động đất thiết. 

Lực động đất trên mỗi tầng đƣợc gán vào tâm cứng của mỗi tầng đó. 
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3.4.6.3. Các tổ hợp tác động động đất với các tác động khác 

Giá trị thiết kế Ed của các hệ quả tác động do động đất gây ra phải đƣợc xác định 

theo công thức:  

. 2, ,

1 1

" " " " " "d k j Ed i k i

j i

E G P A Q
 

      (3.90) 

trong đó: Gk,j là giá trị đặc trƣng của tĩnh tải; 

 Qk,i là giá trị đặc trƣng của hoạt tải; 

 AEd là giá trị thiết kế của tác động động đất; 

 
2,i  đƣợc xác định theo (Bảng 3.11) 

 P là giá trị thiết kế của tác động ứng lực trƣớc; 

"+" có nghĩa là “tổ hợp với”. 

Ví dụ:  

Cho công trình tại Thành phố Tuy Hòa – Tỉnh Phú Yên. 

Công trình khung BTCT toàn khối 6 tầng, với chiều cao mỗi tầng là 3,9m, nền sử 

dụng móng cọc ép BTCT tựa lên nền loại C. Gia tốc đỉnh nền tham chiếu agR = 0,069g. 

Mức độ tầm quan trọng của công trình: Cấp I. Kết quả phân tích dao động theo 

phƣơng X đƣợc thể hiện nhƣ sau: 

 

STT 
Tầng 

mj     

(kNs
2
/m) 

Chu kỳ của 4 dạng dao động đầu tiên (s) 

Mode 1 Mode 2 Mode 3 Mode 4 

T1 = 0,619 T2 = 0,145 T3 = 0,064 T4 = 0,0402 

1 1 1039,8 0,0034 0,0257 -0,0391 0,0556 

2 2 1039,8 0,0131 0,0669 -0,0562 0,0165 

3 3 1039,8 0,0259 0,0831 -0,0079 -0,0531 

4 4 1039,8 0,0401 0,0378 0,047 0,0004 

5 5 1039,8 0,0543 -0,0041 0,0324 0,0509 

6 6 1039,8 0,0676 -0,0546 -0,0407 -0,0288 

Yêu cầu:  

1. Xác định sơ đồ tính khi tính toán dao động của công trình. Công trình có bao 

nhiêu bậc tự do động? Giải thích?; 

2. Tính toán lực động đất phân bố lên mỗi tầng theo phƣơng X theo phƣơng pháp 

phân tích tĩnh lực ngang tƣơng đƣơng?; 

3. Tính toán lực động đất phân bố lên mỗi tầng theo phƣơng X theo phƣơng pháp 

phân tích phổ phản ứng?. 

Giải quyết vấn đề: 

1. Sơ đồ tính của công trình khi dao động:       
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Số bậc tự do động của công trình: 6 bậc tự do       

Giải thích:           

+ Xem sàn tuyệt đối cứng trong mặt phẳng ngang và toàn bộ khối lƣợng của mỗi 

tầng tập trung ở mức sàn. 

+ Chuyển vị dọc trục đƣợc xem là bé so với chuyển vị ngang của công trình. 

+ Kết cấu chịu lực theo phƣơng đứng (cột, vách) đƣợc bảo toàn độ cứng ngang và 

không có khối lƣợng. 

2. Tính toán lực động đất phân bố lên mỗi tầng theo phƣơng X theo phƣơng pháp phân 

tích tĩnh lực ngang tƣơng đƣơng. 

* Đặc điểm công trình             

- Địa điểm xây dựng:   Tỉnh, thành: Phú Yên 

      Quận, huyện: Tuy Hòa 

      Loại nền đất: C       

- Hệ số tầm quan trọng: 1 =   1,25       

* Các thông số dẫn xuất:             

Thông số Ký hiệu Giá trị Đơn vị 

- Gia tốc nền quy đổi agRo 0,0690 
 

- Gia tốc nền agR 0,6769 m/s
2
 

- Gia tốc nền thiết kế ag 0,8461 m/s
2
 

- Thông số xác định phổ với đất 

nền loại C 

S 1,15 
 

TB 0,2 s 

TC 0,6 s 

 
TD 2 s 

- Hệ số ứng xử q 3,9 
 

- Hệ số xác định cận dƣới β 0,2 
 

- Hệ số điều chỉnh  1 
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STT Tầng mi (kN.s
2
/m) si mi.si FXi (kN)   

1 6 1039,8 0,0676 70,2878 1248,2  

2 5 1039,8 0,0543 56,4590 1002,6  

3 4 1039,8 0,0401 41,6944 740,4 
 

4 3 1039,8 0,0259 26,9298 478,2 

5 2 1039,8 0,0131 13,6209 241,9   

6 1 1039,8 0,0034 3,5352 62,8 
 

TỔNG    212,5269 3774,0 

3. Tính toán lực động đất phân bố lên mỗi tầng theo phƣơng X theo phƣơng pháp phân 

tích phổ phản ứng.  

Bảng xác định lực động đất phân phối lên các tầng theo phương X, dạng dao động 

thứ 1 

Chu kỳ dao động, T (s) 0,62        

Giá trị phổ phiết kế, Sd (m/s
2
) 0,6050                

STT Tầng mk (kN.s
2
/m) sj mk.skj mk.skj

2
 FXi (kN) 

1 1   1039,8 0,0034 3,5352 0,0120 43,8 

2 2   1039,8 0,0131 13,6209 0,1784 168,8 

3 3   1039,8 0,0259 26,9298 0,6975 333,7       

4 4   1039,8 0,0401 41,6944 1,6719 516,6 

5 5   1039,8 0,0543 56,4590 3,0657 699,5 

6 6   1039,8 0,0676 70,2878 4,7515 870,8 

TỔNG 
 

  6238,6   212,5269 10,3771 2633,2 

Khối lượng hữu hiệu(kN.s
2
/m) 4352,6516 

Phần trăm khối lượng hữu hiệu(%) 69,7701 

 Lƣu ý: Nếu =0,85 khi T1 ≤ 2Tc kết quả tính toán vẫn đƣợc 

chấp nhận 
 

* Bảng xác định lực động đất phân phối lên các tầng theo phương X     

Chu kỳ dao động, T (s) 0,62 
 
      

Giá trị phổ phiết kế, Sd (m/s
2
) 0,6050        

Tổng khối lƣợng, m (kNs
2
/m) 6238,6        

Lực cắt đáy, Fbx (kN) 3774,0                   
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Bảng xác định lực động đất phân phối lên các tầng theo phương 

X, dạng dao động thứ 2 

Chu kỳ dao động, T (s) 0,14 

Giá trị phổ phiết kế, Sd (m/s
2
) 0,6307     

STT Tầng mk (kN.s
2
/m) sj mk.skj mk.skj

2
 FXi (kN) 

1 1 1039,8 0,0257 26,6698 0,6841 158,1 

2 2 1039,8 0,0669 69,5599 4,6536 412,3 

3 3 1039,8 0,0831 86,4041 7,1802 512,1 

4 4 1039,8 0,0378 39,3029 1,4857 232,9 
      

5 5 1039,8 -0,0041 -4,2630 0,0175 -25,3 

6 6 1039,8 -0,0546 -56,7709 3,0997 -336,5 

TỔN

G 
  6238,6 

 160,9029 17,1206 953,7 

Khối lượng hữu hiệu(kN.s
2
/m) 1512,1942  

Phần trăm khối lượng hữu hiệu(%) 24,2395  

Các dạng dao động cần phân tích: 

- Tổng phần trăm khối lƣợng hữu hiệu của 2 mode dao động đầu tiên theo 

phƣơng X: 

%W = 69,7701+24,2395=94,0096 %>90 %. 

- Phần trăm khối lƣợng hữu hiệu của mỗi mode dao động theo phƣơng X lớn hơn 

5%  

Vậy sử dụng 2 mode đầu tiên có ảnh hƣởng lớn nhất đến phản ứng của kết cấu để tính 

phổ phản ứng và không cần sử dụng mode 3 và 4. 

3.5. Tổ hợp tải trọng 

Đối với nhà cao tầng: hoạt tải đứng có thể chỉ xét trƣờng hợp chất đầy lên tất cả 

các tầng mà không phải thực hiện việc bố trí các trƣờng hợp bất lợi của hoạt tải để tổ 

hợp (xem gần đúng). 

Các trƣờng hợp tải trọng: 

(1) Tĩnh tải toàn bộ (chất đầy các tầng); 

(2) Hoạt tải đứng (chất đầy các tầng); 

(3) Gió X (cả gió tĩnh + gió động); 

(4) Gió XX (cả gió tĩnh + gió động), ngƣợc chiều với gió X; 

(5) Gió Y (cả gió tĩnh + gió động); 
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(6) Gió YY (cả gió tĩnh + gió động), ngƣợc chiều với gió Y; 

(7) Động đất theo phƣơng X; 

(8) Động đất theo phƣơng XX; 

(9) Động đất theo phƣơng Y; 

(10) Động đất theo phƣơng YY; 

1- Nếu công trình không tính đến động đất 

TH1: 1(1) + 1(2); 

TH2: 1(1) + 1(3); 

TH3: 1(1) + 1(4); 

TH4: 1(1) + 1(5); 

TH5: 1(1) + 1(6); 

TH6: 1(1) + 0,9[(2) + (3)]; 

TH7: 1(1) + 0,9[(2) + (4)]; 

TH8: 1(1) + 0,9[(2) + (5)]; 

TH9: 1(1) + 0,9[(2) + (6)]; 

TH10: 1(1) + 0,9(2) + 0,9sin45
o
[(3)+(5)]; 

TH11: 1(1) + 0,9(2) + 0,9sin45
o
[(3)+(6)]; 

TH12: 1(1) + 0,9(2) + 0,9sin45
o
[(4)+(5)]; 

TH13: 1(1) + 0,9(2) + 0,9sin45
o
[(4)+(6)]; 

TH14(TH bao): ENVE[TH1, TH2,…, TH13]. 

2- Nếu công trình tính đến động đất 

TH1: 1(1) + 1(2); 

TH2: 1(1) + 1(3); 

TH3: 1(1) + 1(4); 

TH4: 1(1) + 1(5); 

TH5: 1(1) + 1(6); 

TH6: 1(1) + 0,9[(2) + (3)]; 

TH7: 1(1) + 0,9[(2) + (4)]; 

TH8: 1(1) + 0,9[(2) + (5)]; 

TH9: 1(1) + 0,9[(2) + (6)]; 

TH10: 1(1) + 0,9(2) + 0,9sin45
o
[(3)+(5)]; 

TH11: 1(1) + 0,9(2) + 0,9sin45
o
[(3)+(6)]; 

TH12: 1(1) + 0,9(2) + 0,9sin45
o
[(4)+(5)]; 
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TH13: 1(1) + 0,9(2) + 0,9sin45
o
[(4)+(6)]; 

TH14: 0.9(1) + 0,8(2) + (7); 

TH15: 0.9(1) + 0,8(2) + (8); 

TH16: 0.9(1) + 0,8(2) + (9); 

TH17: 0.9(1) + 0,8(2) + (10); 

TH18: 0.9(1) + 0,8(2) + (7) +0,3(9); 

TH19: 0.9(1) + 0,8(2) + (7) +0,3(10); 

TH20: 0.9(1) + 0,8(2) + (9) +0,3(7); 

TH21: 0.9(1) + 0,8(2) + (9) +0,3(8); 

TH(n): ………………………………………..; 

TH(n+1)(TH bao): ENVE [TH1, TH2,…,TH(n)]. 

3.6. Các hiệu ứng bậc hai (hiệu ứng P - ) 

Khi các kết cấu mềm, dễ biến dạng, ví dụ nhƣ khung BTCT chịu các lực ngang, 

các chuyển vị ngang phát sinh sẽ làm tăng mô men lật. Sự gia tăng mô men uốn này 

xảy ra là do tải trọng thẳng đứng P tác động lên khung cũng bị dịch chuyển theo sự 

biến dạng của khung. Hiệu ứng này đƣợc gọi là hiệu ứng P - , hoặc gọi là hiệu ứng 

bậc hai. Hiệu ứng này càng lớn nếu chuyển vị ngang và/hoặc tải trọng thẳng đứng 

càng lớn. Ở kết cấu rất mềm, hiện tƣợng này sẽ có thể làm kết cấu mất ổn định và gây 

ra sụp đổ. Đa số các kết cấu làm việc đàn hồi – dẻo đều có chuyển vị ngang lớn và 

kèm theo đó là các hiệu ứng bậc hai lớn. 

 

Hình 3. 31. Hiệu ứng  P -  của mô hình côngxôn. 

3.7. Ví dụ tính toán 

Thực hành tính toán tải trọng động đất tác dụng lên công trình 
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Sau đây trình bày hai cách phân tích tĩnh lực ngang tƣơng đƣơng và phổ phản 

ứng dạng dao động cho cùng một bài toán. Từ đó đƣa ra các nhận xét về kết quả tính. 

 

Xét bài toán có mô hình kết cấu thỏa các điều kiện để phân tích bằng phƣơng pháp 

tĩnh lực ngang tƣơng đƣơng. 

Các chu kì dao động cơ bản T1 theo hai hai hƣớng nhỏ hơn các giá trị sau: 






s

T
T

C

0,2

.4
1  

Thõa mãn nhƣng tiêu chí về tình đều đặn theo mặt đứng. 

a. Phương pháp tĩnh lực ngang tương đương 

Các bảng sau là kết quả tính phân tích chu kì dao động, khối lƣợng và chuyển vị 

tầng: 

Bảng 3. 14. Các chu kì dao động cơ bản 

Chu kì dao động  cơ bản (s) 
T1x T1y 

1.11 1.509 
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Bảng 3. 15. Khối lƣợng và chuyển vị tầng theo dạng dao động cơ bản. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Giả sử có số liệu tính động đất cho công trình nhƣ sau. 

1 

 

Loại đất nền C 

 

 

Gia tốc nền tham chiếu 

(g) 

S TB(s) Tc(s) Td(s) 

1.15 0.20 0.60 2.00 

agR = 0.0848g γ1= 1.25 

 qh = 1.50 

Từ đó xây dựng phổ phản ứng dạng dao động thiết kế cho công trình nhƣ sau: 

 

Tính lực cắt đáy móng thiết kế theo công thức sau: 

Phoå phaûn öùng ñaøn hoài theo phöông ngang

0

0.25

0.5

0.75

1

1.25

1.5

1.75

2

2.25

0 1 2 3 4 5

T

S
e

Story displacements

T1x T1y

Story mj(Kg) Story sj sj

1 379081 1 -0.0004 0.0006

2 477552 2 -0.0012 0.0016

3 477552 3 -0.0021 0.0029

4 477552 4 -0.0033 0.0045

5 477552 5 -0.0046 0.0061

6 477552 6 -0.0061 0.0077

7 477552 7 -0.0077 0.0094

8 477552 8 -0.0094 0.0109

9 477552 9 -0.0111 0.0124

10 477552 10 -0.0128 0.0138

11 477552 11 -0.0146 0.0151

12 477552 12 -0.0163 0.0162

13 477552 13 -0.0181 0.0172

14 477552 14 -0.0198 0.0181

15 477552 15 -0.0214 0.0189

M = 7064809
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     1( )b dF S T M                                                                                                                 

trong đó: 

Sd (T1) - Tung độ của phổ thiết kế tại chu kỳ T1; 

T1 - Chu kỳ dao động cơ bản do chuyển động ngang theo phƣơng đang xét; 

   - Hệ số hiệu chỉnh, lấy nhƣ sau:  

 = 0,85 nếu T1  2TC  với nhà > 2 tầng;  = 1,0 với các trƣờng hợp khác.  

M - Tổng khối lƣợng nhà ở trên móng để tính lực cắt đáy móng Fb , xác định 

bằng: 

 



1i

i,ki,E

1j

j,k QGM                                    

Gk,j - tĩnh tải tính toán thứ j ;      Qk,i - hoạt tải tính toán thứ i;  

            E,i - hệ số tổ hợp tải trọng đối với tác động thay đổi thứ i;  

Hoạt tải đặt lên nhà 2   E = x 2 

  Loại A:  Khu vực nhà ở, gia đình 0,3 0,8 0,24 

  Loại B:  Khu vực văn phòng 0,3 0,8 0,24 

  Loại C:  Khu vực hội họp 0,6 0,8 0,48 

  Loại D:  Khu vực mua bán 0,6 1,0 0,6 

  Loại E:  Khu vực kho lƣu trữ 0,8 1,0 0,8 

Theo phương X 

Từ chu kì dao động cơ bản theo phƣơng X: T1x=1.109, tính đƣợc 

0783.1),( 1 Xd TS  

Lực cắt đáy móng: 

)(7617983170648090783.1 NFbX   

Phân phối lực cắt đáy cho các tầng theo công thức sau: 

k k
k b

j j

s m
F F

s m
 


                                                                                                 

trong đó:  

Fk -  lực ngang tác dụng tại tầng thứ k; 

Fb - lực cắt đáy do động đất; 

sk , sj - chuyển vị của các khối lƣợng mk , mj  trong dạng dao động cơ bản; 

mk , mj    khối lƣợng của các tầng.  

Từ công thức Fk và số liệu trong bảng 2, tính đƣợc lực ngang phân phối lên tầng 

nhƣ sau: 
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Phân phối tải ngang theo phƣơng X lên từng tầng: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Theo phương Y 

Từ chu kì dao động cơ bản theo phƣơng Y: T1Y =1.509, tính đƣợc 

7925.0),( 1 Yd TS  

Lực cắt đáy móng: 

)(5598861170648097925.0 NFbY 
 

 

 

 

 

 

TĨNH LỰC NGANG TƯƠNG ĐƯƠNG THEO  PHƯƠNG X

0
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FbX = 7617.983 KN

Story mj(Kg) sj mjsj FkX (KN)

1 379081 -0.0004 -151.6325 16.3

2 477552 -0.0012 -573.0624 61.4

3 477552 -0.0021 -1002.859 107.5

4 477552 -0.0033 -1575.921 168.9

5 477552 -0.0046 -2196.739 235.5

6 477552 -0.0061 -2913.067 312.3

7 477552 -0.0077 -3677.15 394.2

8 477552 -0.0094 -4488.988 481.2

9 477552 -0.0111 -5300.827 568.2

10 477552 -0.0128 -6112.665 655.2

11 477552 -0.0146 -6972.259 747.4

12 477552 -0.0163 -7784.097 834.4

13 477552 -0.0181 -8643.69 926.5

14 477552 -0.0198 -9455.529 1013.6

15 477552 -0.0214 -10219.61 1095.5

M = 7064809 -71068.1
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                Bảng 3. 16. Phân phối tải ngang theo phƣơng Y lên từng tầng. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Phương pháp phân tích phổ dạng dao động 

Theo phƣơng pháp này, phải xét đến tất cả dạng dao động góp phần đáng kể vào 

phản ứng tổng thể của nhà, trong tính toán thực hành, có thể sử dụng các điều kiện 

sau: 

3

0,2k

k n

T s

 



                                                                                                                            

trong đó: 

k  số dạng dao động đƣợc xét tới trong tính toán; 

n  số tầng ở trên móng hoặc đỉnh của phần cứng phía dƣới; 

TĨNH LỰC NGANG TƯƠNG ĐƯƠNG THEO PHƯƠNG Y
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FbY = 5598.861 KN

Story mj(Kg) sj mjsj FkY (KN)

1 379081 0.0006 227.4487 17.2

2 477552 0.0016 764.0831 57.7

3 477552 0.0029 1384.901 104.6

4 477552 0.0045 2148.984 162.3

5 477552 0.0061 2913.067 220.0

6 477552 0.0077 3677.15 277.6

7 477552 0.0094 4488.988 338.9

8 477552 0.0109 5205.316 393.0

9 477552 0.0124 5921.644 447.1

10 477552 0.0138 6590.217 497.6

11 477552 0.0151 7211.035 544.5

12 477552 0.0162 7736.342 584.1

13 477552 0.0172 8213.894 620.2

14 477552 0.0181 8643.69 652.6

15 477552 0.0189 9025.732 681.5

M = 7064809 74152.49
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Tk chu kỳ dao động của dạng thứ k (chu kỳ dao động bé nhất đƣợc xét đến tính 

toán).  

Nhà 15 tầng   6.11153 k , chọn 12k . Phân tích với 12 dạng dao động 

đầu tiên. 

Bảng 3. 17. Chu kì dao động 

Mode 1 2 3 4 5 6 7 8 9 10 11 12 

Period 1.510 1.297 1.110 0.436 0.375 0.248 0.212 0.189 0.126 0.121 0.110 0.088 

Có thể thấy dạng dao động thứ 12 có chu kì 0.008s < 0.2s. 

Bảng 3. 18. Tải trọng ngang theo phƣơng X lên từng tầng. 

FbX =  5903.8 KN 

Stoty FkX   

15 944.16   

14 842.98   

13 660.52   

12 508.29   

11 399.34   

10 335.48   

9 307.39   

8 300.57   

7 301.92   

6 301.91   

5 292.56   

4 266.2   

3 217.8   

2 149.63   

1 75.09   
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Bảng 3. 19. Tải trọng ngang theo phƣơng Y lên từng tầng 

FbY =  4599.1 KN 

Stoty    

15 763.83   

14 655.9   

13 498.41   

12 385.02   

11 313.52   

10 268.28   

9 239.8   

8 226.68   

7 224.4   

6 224.15   

5 220.7   

4 210.43   

3 182.94   

2 127.96   

1 57.08   

 

c. So sánh kết quả từ 2 phương pháp 

TẢI NGANG TƯƠNG ĐƯƠNG PHƯƠNG Y
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Một số nhận xét: 

Từ kết quả phân tích trên cụ thể cho công trình trên, có một số nhận xét nhƣ sau: 

- Có sự sai khác về kết quả tính theo 2 phƣơng pháp trên. 

Bảng 3. 20. So sánh lực cắt đáy 

Đại lƣợng Sai số

(KN) TLNTĐ PDĐ  (%)

FbX 7618.0 5903.8 22.5

FbY 5598.9 4599.1 17.9

Phƣơng pháp

 

- Quy luật phân phối tải ngang lên từng tầng theo hai phƣơng pháp là rất khác 

nhau, theo phƣơng pháp phân tích tĩnh lực ngang tƣơng đƣơng, tải ngang phân bố lên 

từng tầng có dạng tăng gần tuyến tính, còn theo phƣơng pháp phân tích phổ dao động 

thì không. 
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Chương 4 

 TÍNH TOÁN KẾT CẤU NHÀ CAO TẦNG 

4.1. Khái niệm chung 

4.1.1. Giả thiết tính toán 

Tính toán kết cấu nhà cao tầng là việc xác định trạng thái ứng suất - biến dạng 

trong từng hệ, từng bộ phận cho đến từng cấu kiện chịu lực dƣới tác động của mọi loại 

tải trọng. Ớ đây chúng ta chủ yếu xét đến phản ứng của hệ kết cấu thẳng đứng khung, 

vách, lõi dƣới tác động của các loại tải trọng ngang. 

Hầu nhƣ trong các loại nhà cao đến 30 tầng đều kết hợp sử dụng cả 3 hệ chịu lực 

khung - vách - lõi. Việc lựa chọn hệ chịu lực và giả thiết tính toán làm sao vừa phù 

hợp với thực tế bố trí, cấu tạo các kết cấu chịu lực còn phải thoả mãn điều kiện về sự 

cùng làm việc của các hệ kết cấu có hình dạng, kích thƣớc, độ cứng khác nhau. Mỗi 

giả thiết thƣờng chỉ phù hợp với từng mô hình tírih toán, không có giả thiết chung cho 

mọi sơ đồ tính toán. Giả thiết nào phản ánh đƣợc mối quan hệ truyền lực giữa các hộ 

với nhau thông qua giải pháp thiết kế, cấu tạo cụ thể trong cồng nghệ xây lắp sẽ đƣợc 

xem là phù hợp và cho ta những kết quả đáng tin cây. Cũng cần phân biệt giữa độ 

chính xác trong sơ đồ kết cấu với độ chính xác trong mô hình toán học, hai vấn để này 

không phải luôn thống nhất. Tuy nhiên có thể nêu một số giả thiết thƣờng đuợc sử 

dụng trong tính toán nhà cao tầng sau đây: 

Giả thiết ngôi nhà làm việc nhƣ một thanh cồng xon có độ cứng uốn tƣơng 

đƣơng độ cứng của các hệ kết cấu hợp thành. Giả thiết này đơn giản nhƣng không 

hoàn toàn phản ánh đúng thực tế chịu lực của cả hệ. Giả thiết này thuận tiện cho việc 

xác định các đặc trƣng động của công trình. 

Giả thiết mỗi hệ kết cấu chỉ có thể tiếp thu một phần tải trọng ngang tỷ lệ với độ 

cứng uốn (xoắn) của chúng, nhƣng đƣợc liên kết chặt chẽ với các hệ khác qua các 

thanh giằng liên kết khớp hai đầu. Độ cứng của các thanh giằng có giá trị lớn để có thể 

xem nhƣ không bị biến dạng co hoặc dãn dài. Các giằng ngang này chính là mô hình 

của hệ kết cấu dầm sàn có độ cứng lớn vô cùng trong mặt phẳng nằm ngang. 

Giả thiết về các hệ chịu lực cùng có một dạng đuờng cong uốn. Giả thiết này chỉ 

thích hợp cho các nhà chỉ có một hệ khung hoặc vách hoặc lõi. Còn đối với nhà hộ 

khung - vách - lõi thì đƣờng cong uốn của mỗi hệ khác nhau, trong cùng một sơ đồ 

tính toán. 

4.1.2. Ảnh hưởng của kết cấu sàn đến sự làm việc của các hệ chịu lực thẳng đứng 

Với giả thiết sàn cứng tuyệt đối trong mặt phẳng, chỉ là sự tƣơng đối. Trong thực 

tế xây dựng kết cấu sàn nhà có nhiều loại: Sàn bê tông đổ liền khối, sàn bê tông lắp 

ghép, sàn bê tông thép, sàn nhiều lớp từ các vật liệu khác nhau. Mỗi loại sàn đều có 

liên kết cấu tạo riêng nhƣng không phải lúc nào cũng có khả năng làm việc nhƣ một 
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kết cấu liền khối, không chỉ có các chuyển vị thẳng hoặc xoay mà khổng có biến dạng 

góc. Với kết cấu sàn có dầm bê tông đổ liền khối dùng giả thiết sàn cứng tuyệt đối là 

phù hợp. 

Trong nhà cao tầng thƣờng dùng các lƣới cột kích thƣớc lớn từ 6 đến l0m, nhƣng 

chiều cao tầng lại hạn chế đến mức có thể. Sự trái ngƣợc này thƣờng đuợc giải quyết 

bằng việc ứng dụng các kết cấu sàn không dầm hay gọi là sàn phẳng. Bản sàn đƣợc kê 

trực tiếp lên các đầu cột, tƣờng, vách, lõi và thƣờng dùng bê tông ứng lực trƣớc để 

tăng khả năng chống uốn, võng, và nứt. Đã có những nghiên cứu chứng tỏ, ứng với các 

giá trị độ cứng nhất định của sàn phẳng cần phải xét tới biến dạng của sàn trong tính 

toán. 

Vai trò của sàn cứng đặc biệt quan trọng khi nhà có hệ khung vách hoặc khung - 

lõi. Ví dụ trong hệ khung - vách, nhà sẽ có đƣờng cong uốn nhƣ trên (hình 4.1c). 

Đƣờng cong uốn của hệ khung có dạng trên hình (4.la) tại chân ngàm có lực cắt và góc 

nghiêng lớn nhất. Ngƣợc lại, tƣờng cứng hoặc lõi cứng có đƣờng cong uốn nhƣ thanh 

công xon, và góc nghiêng lớn nhất lại ở vị trí đỉnh tƣờng. Song để đạt đƣợc sự đồng 

điệu trong biến dạng uốn cho toàn hệ thì trong các liên kết sẽ xuất hiện những phản 

ứng, nội lực khác nhau về giá trị và vị trí (hình 4.1c). Kích thƣớc chiều dài các mũi tên 

chỉ độ lớn của các phản lực. Và nhờ vai trò của hệ giằng ngang mà hệ khung dƣờng 

nhƣ đẩy ngang hệ vách cứng ở phía trên và co nó lại ở phía dƣới. Kết quả lực cắt sinh 

ra do tải trọng ngang đƣợc hệ khung tiếp thu phần lớn ở phía trên còn vách, lõi tiếp thu 

phần còn lại ở phía dƣới. 

 

Hình 4. 1. a) Khung; b) Vách (lõi); c) Sơ đồ biên dạng của hệ thống qua các liên kết (giằng) 

đặt ở các mức sàn. 

Trong các ngôi nhà lõi hoặc hộp thì không những độ cứng của sàn mà khi có các 

tầng cứng (dạng dàn hoặc dầm kiểu Virendel có chiều cao bằng chiều cao tầng) ảnh 

hƣởng rõ rệt đến đƣờng cong uốn và các giá trị và dạng biểu đồ mômen uốn. 
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Hình 4. 2. a) Sơ đồ kết cấu chịu tải trọng ngang; b, c) Sơ đồ liên kết và tải trọng thành phần. 

Trong trƣờng hợp tổng quát, khi chấp nhận những giả thiết nêu trên thì mọi bộ 

phận kết cấu bố trí rời rạc trong công trình đều cùng chịu lực và tuân theo một quy luật 

nhất định trong một hệ kết cấu thống nhất, kể cả trƣờng hợp các vách, lõi, khung bị 

giảm yếu ở những tầng dƣới (hình 4.2). Trong sơ đồ này, tải trọng ngang tác động vào 

công trình có thể đƣợc xem nhƣ tổng các thành phần tải trọng do các kết cấu đơn vị 

tiếp nhận tƣơng ứng với độ cứng uốn của chúng. 

4.1.3. Sơ đồ tính toán 

Căn cứ vào những giả thiết tính toán có thể phân chia thành các sơ đồ tính toán 

theo nhiều cách khác nhau: 

Sơ đồ phẳng tính toán theo hai chiều 

Công trình đƣợc mô hình hoá dƣới dạng những kết cấu phẳng theo hai phƣơng 

mặt bằng chịu tác động của tải trọng trong mặt phẳng của chúng. Giữa các hệ đƣợc 

giằng với nhau bởi các dãy liên kết khớp hai đầu và ở ngang mức sàn các tầng (hình 

4.3). 

Hình 4. 3. a) Mặt bằng kết cấu hệ khung - vách; b) Sơ đồ tính toán theo phƣơng trục y  c) Sơ 

đổ tính toán theo phƣơng trục x. 

Các sơ đồ tính toán trên đây đƣợc dùng phổ biến cho hệ kết cấu khung - vách 

phẳng. Trong trƣờng hợp dùng các vách hình chữ L, H, T, v.v... thiên về an toàn vẫn 
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có thể chỉ xét tới một cánh của vách theo một trong hai phƣơng cùng trong mặt phẳng 

khung đang xét. 

Đôi khi trong hệ khung - vách - lõi với tổng độ cứng của lõi nhỏ hơn tổng độ 

cứng vách và khung, cũng có thể sử dụng sơ đồ tính toán theo 2 phƣơng. 

Sơ đồ tính toán không gian 

Công trình đƣợc mô hình nhƣ một hệ khung và tấm không gian chịu tác động 

đồng thời của ngoại lực theo phƣơng bất kỳ (hình 4.4) 

  1) Khung phẳng;  2) Vách cứng liên tục;  

   3) Vách liền khung; 4) Lõi kết hợp với vách dọc, ngang. 

Hình 4. 4. Hệ khung - vách - lỗi trong ngôi nhà có mặt bằng gây khúc cần tính toán theo sơ 

đổ không gian. 

Sơ đồ tính toán ba chiều thƣờng sử dụng cho tính toán nhà có mặt bằng phức tạp. 

Dùng sơ đồ này để tính toán có thể cho ta hình ảnh về trạng thái ứng suất biến dạng 

của từng hệ kết cấu với những liên kết theo 3 chiều. Tuy nhiên đòi hỏi khối lƣợng tính 

toán khá lớn, nhất là khi số tầng lớn. 

Theo các giả thiết về liên kết và các quan niệm về khả năng tiếp thu các tải trọng 

ngang của từng hệ, các hệ chịu lực khác nhau đều có thể đƣa về một trong ba sơ đồ 

tính toán là sơ đồ khung, sơ đồ khung - giằng và sơ đồ giằng. 

Trong sơ đồ khung - giằng (hình 4.5a) ta quan niệm sự cùng chịu tải trọng ngang 

của cấc hộ tuân theo quy luật tỷ lệ thuận với độ cứng của từng hệ theo từng phƣơng tác 

động của tải trọng. 

 

Hình 4. 5. Các sơ đồ tính toán. 
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Trong thực tế trong các hệ vách, lõi mặc dù không thể thiếu các khung phẳng 

nhƣng thiên về an toàn ta có thể bỏ qua phần tải trọng ngang do hệ khung tiếp thu nên 

ta gọi đây là sơ đồ giằng (hình 5.5b). Nhƣ vậy các hệ lõi, hộp đều đƣợc tính toán nhƣ 

hệ giằng. 

4.1.3. Các phương pháp tính toán 

Dựa theo các sơ đồ tính toán chúng ta có thể sử dụng nhiều phƣơng pháp khác 

nhau trong cơ học kết cấu và trong toán học để xác định các nội lực và chuyển vị trong 

hệ và từng cấu kiện kết cấu chịu lực. 

Các phƣơng pháp trong cơ học kết cấu nhƣ phƣơng pháp lực, phƣơng pháp 

chuyển vị, phƣơng pháp lực - chuyển vị vẫn đƣợc sử dụng có hiệu quả và cho những 

kết quả tin cậy cho từng trƣờng hợp cụ thể. Các phƣơng pháp biến phân, sai phân hữu 

hạn để giải các hệ phƣơng trình vi phân bậc cao cũng vậy còn đƣợc sử dụng để giải 

các sơ đồ giằng, khung giằng phức tạp. 

Trong số các phƣơng pháp tính toán nhà cao tầng, phƣơng pháp phần tử hữu hạn 

(PTHH) đƣợc sử dụng rộng rãi hơn cả vì hầu hết trong các phần mềm chƣơng trình 

tính toán thực hiện trên máy tính đều xuất phát từ phƣơng pháp này. 

Các kết cấu ngôi nhà đƣợc chia thành những phần tử nhỏ dạng thanh hay bản, và 

số phần tử có thể là hàng nghìn tuỳ theo số tầng nhà. Do vậy số lƣợng các ẩn số là các 

nội lực và chuyển vị cũng tăng theo ít nhất là 3 lần số phần tử. Nhờ có máy tính, khi 

khối lƣợng tính toán số học không còn là vấn đề trở ngại nữa, thì việc giải các phƣơng 

tình đại số tuyến tính bậc cao cũng đƣợc giải quyết nhanh chóng và chính xác. Những 

phần mềm mạnh hiện nay cho phép chúng ta đi sâu nghiên cứu trạng thái ứng suất biến 

dạng của các hệ kết cấu phức tạp với các sơ đồ tính toán không gian phù hợp với sự 

làm việc thực của công trình. Tuy nhiên kết quả của bài toán còn phụ thuộc vào kỹ 

năng của ngƣời sử dụng các chƣơng trình, nên những kết quả nhận đƣợc từ máy luôn 

phải đƣợc kiểm tra theo các điều kiện: 

Cân bằng lực. 

Tính liên tục của các chuyển vị. 

Sự phù hợp với các tiêu chuẩn quy phạm thiết kế hiện hành. 

Các bƣớc tính toán 

Căn cứ vào giải pháp kiến trúc và bố trí mặt bằng các kết cấu chịu lực có thể tiến 

hành tính toán theo các bƣớc sau đây: 

Chọn sơ đồ tính toán. 

Xác định các loại tải trọng. 

Xác định các đặc trƣng hình học và độ cứng của kết cấu. 

Phân phối tải trọng ngang vào các hệ chịu lực. 

Xác định nội lực, chuyển vị trong từng hệ từng cấu kiện. 
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Kiểm tra các điều kiện bền, chuyển vị và các đặc trƣng động. 

Kiểm tra ổn định cục bộ và ổn định tổng thể công trình. 

4.2. Xác định nội lực hệ vách cứng theo phương pháp Khandzi 

Các hệ kết cấu đứng chịu tải của công trình liên kết với nhau bằng các kết cấu 

sàn nằm ngang tạo thành một hệ không gian. Nhƣng việc tính toán có thể đƣa về dạng 

bài toán phẳng nếu tiến hành đƣợc việc phân phối tải trọng ngang theo độ cứng tƣơng 

đối của mỗi cấu kiện chịu tải. 

Xác định chuyển vị của mỗi vách cứng trên mặt bằng nhà 

 

Hình 4. 6. Xác định chuyển vị vách cứng 

 Đối với hệ trục XOY thì: Tọa độ điểm O bất kỳ là O (a0, b0) 

 Tọa độ trọng tâm vách cứng thứ i bất kỳ là I (ai, bi) 

 Dƣới tác động của tải trọng ngang theo phƣơng y: qy cách điểm O một đoạn cx 

(Hình 4.6), tại điểm O bất kỳ trên mặt bằng, nhà sẽ bị xoay quanh trục thẳng đứng một 

góc φ và chuyển dịch một khoảng là u và v theo phƣơng trục X và Y. 

 Theo giả thiết, mọi vách cứng đều đƣợc liên kết với nhau bởi các sàn cứng nên 

chuyển vị của chúng đƣợc xác định bởi các chuyển vị của điểm O. 

 Chuyển vị tại tâm uốn của một hệ vách cứng thứ i nào đó sẽ là: 

 
0( )i iu u b b tg    (4.1) 

 0( )i iv v a a tg    (4.2) 

     Với tg   

 i   (4.3) 

Tâm uốn: Tâm uốn là một điểm trên mặt bằng nhà, nếu hợp lực của tải trọng 

ngang đi qua tâm uốn sẽ không gây ra góc xoay trên mặt bằng nhà (φ = 0), nghĩa là 

nhà không bị xoắn. 

Đối với nhà có các hệ vách cứng có tiết diện hở hoặc kín, các trục chính không 

song song với các trục X và trục Y. 

Công thức tổng quát xác định tọa độ tâm uốn: 

    o y xi i xyi i xy xyi i yi ia A I a I b A I a I b        (4.4) 

    o x yi i xyi i xy xyi i xi ib A I b I a A I b I a        (4.5) 
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Trong đó:  

 

2

x
x

x y xy

I
A

I I I



 

(4.6) 

 

2

y

y

x y xy

I
A

I I I



 

(4.7) 

 

2

xy

xy

x y xy

I
A

I I I



 

(4.8) 

Các Ix, Iy và Ixy lần lƣợt là mô men quán tính của nhà. 

Định nghĩa “mô men quán tính của ngôi nhà”: Mô men quán tính theo trục Ix, Iy 

và mô men quán tính ly tâm Ixy của ngôi nhà là tổng mô men quán tính của tất cả các 

vách cứng. 

Do đó: 

 ; ;x xi y yi xy xyiI I I I I I      (4.9) 

Mô men quán tính xoắn của ngôi nhà Iω xác định theo: 

       
2 2

2xi i o yi i o xyi i o i o iI I a a I b b I a a b b I             (4.10) 

4.2.1. Phân phối tải trọng vào vách cứng thứ i 

4.2.1.1. Khi tải trọng tác dụng theo phương Y 

Dƣới tác động của tải trọng ngang theo phƣơng y: qy cách điểm O một đoạn cx 

(Hình 4.6). Tải trọng truyền vào vách cứng thứ i sẽ phân phối theo tỷ lệ đối với độ 

cứng và các chuyển vị tƣơng ứng (hoặc mô men quán tính của các vách cứng tƣơng 

ứng). 

 Tải trọng truyền vào các vách cứng thứ i do qy gây ra đƣợc xác định theo: 

     0 0 /xi y y xyi x yi x xyi i yi iq q A I A I c I a a I b b I         (4.11) 

     0 0 /yi y y xi x xyi x xi i xyi iq q A I A I c I a a I b b I         (4.12) 

 i y x xiM q c K  (4.13) 

 Để đơn giản cách ghi và tính toán theo các công thức trên ta đặt: 

 xxi x yi xy xyiK A I A I   (4.14) 

 yyi y xi xy xyiK A I A I   (4.15) 

 xyi x xyi xy xiK A I A I   (4.16) 

 yxi y xyi xy yiK A I A I   (4.17) 

    0 0

x

xyi i yi i

i

I a a I b b
K

I




  
  

(4.18) 

    0 0

y

xi i xyi i

i

I a a I b b
K

I




  
  

(4.19) 

 Các hệ số K… trên gọi là hệ số phân phối tải trọng vào các vách cứng thứ i. 

 Chỉ số thứ nhất viết dƣới hệ số Kxxi; Kyyi; Kxyi; Kyxi ứng với hƣớng ngoại lực, 

trong các hệ số Kωxi; Kωyi ứng với ảnh hƣởng xoắn trên mặt bằng ngôi nhà. 
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 Chỉ số thứ hai trong các hệ số trên ứng với hƣớng tác động của tải trọng vào vách 

cứng thứ i. 

Nếu tính chính xác thì: 

 1xxi yyiK K    (4.20) 

 0xyi yxi xi yiK K K K         (4.21) 

4.2.1.2. Phân phối tải trọng vào các vách cứng thứ i có xét tới ảnh hưởng uốn dọc 

 Cần phải xét tới ảnh hƣởng của uốn dọc và uốn ngang đồng thời, một cách gần 

đúng có thể dùng các hệ số ηx, ηy, ηω để hiệu chỉnh tải trọng truyền vào các vách cứng 

đƣợc xác định theo các công thức trong chƣơng 5. 

 Tóm lại: Khi tải trọng tác dụng theo phƣơng Y(qy) cách điểm O một đoạn cx 

(Hình 4.7) thì tải trọng này đƣợc phân phối cho từng vách cứng thứ i xác định theo: 

  yxxi y i y x xiq q K c K     (4.22) 

  yyyi y i x x yiq q K c K     (4.23) 

 i y x xiM q c K   (4.24) 

4.2.1.3. Khi tải trọng tác dụng theo phương X 

 Khi tải trọng tác dụng theo phƣơng x, qx cách điểm O một đoạn cy (Hình 4.7) thì 

tải trọng này đƣợc phân phối cho từng vách cứng thứ i xác định theo: 

  xxxi x i y y xiq q K c K     (4.25) 

  xyyi x i y y yiq q K c K     (4.26) 

 i x y yiM q c K    (4.27) 

 

Hình 4. 7. Tải trọng tác dụng theo từng phƣơng 

4.2.1.4. Khi xét tải trọng tác dụng theo hai phương  

Khi xét tải trọng tác dụng theo hai phƣơng qx và qy (Hình 4.8): ta tiến hành tính 

toán cho từng trƣờng hợp tải trọng qx và qy riêng, sau đó dùng phƣơng pháp tổ hợp. 

 
Hình 4. 8. Tải trọng tác dụng theo hai phƣơng. 
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4.2.1.5. Xác định tâm uốn cho trường hợp đặc biệt 

Khi các trục chính song song với trục nhà, có 0xy xyiI I   thì tâm uốn xác 

định theo: 

 
xi i xyi i

o

x

I a I b
a

I



 

 
(4.28) 

 
yi i xyi i

o

y

I b I a
b

I



 

 
(4.29) 

Hệ số phân phối tải trọng: 

 
; ; ;

yi xyi xyixi
xxi yyi xyi yxi

y x y x

I I II
K K K K

I I I I
     

(4.30) 

    0 0

x

xyi i yi i

i

I a a I b b
K

I




  
  

(4.31) 

    0 0

y

xi i xyi i

i

I a a I b b
K

I




  
  

(4.32) 

Khi các trục chính của các tƣờng cứng song song với trục nhà, có các Ixyi = 0 thì 

tâm uốn xác định theo: 

 
xi i

o

x

I a
a

I



 
(4.33) 

 
yi i

o

y

I b
b

I



 
(4.34) 

 
Hình 4. 9. Trục chính các tƣờng song song trục nhà. 

 Hệ số phân phối tải trọng: 

 
; ; 0

yi xi
xxi yyi xyi yxi

y x

I I
K K K K

I I
     

(4.35) 

  0

x

i yi

i

b b I
K

I





   

(4.36) 

y

xa

Ix1(I  )y1

Ix2(I  )y2

Ixn(I  )yn

Ix3(I  )y3

Ixi (I  )yi

i

ao

a3

O

bo b3
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  0

y

i xi

i

a a I
K

I





   

(4.37) 

Ngôi nhà chỉ có một hệ tƣờng cứng thì toàn bộ tải trọng do hệ này chịu. 

4.2.2. Phân phối mô men vào vách cứng thứ i 

 Nếu biết đƣợc tổng mô men uốn Mx, My và tổng lực cắt ngang Qx, Qy do tải trọng 

ngang gây ra, ta có thể phân phối nội lực đó vào các vách cứng thứ i tƣơng tự nhƣ 

phân phối tải trọng. 

 Với tổng mô men tác dụng theo phƣơng Y(Mx) tại tầng bất kỳ thì mô men uốn tác 

dụng lên vách cứng thứ i xác định theo: 

  yyxi x i x x yiM M K c K     (4.38) 

  yxyi x i y x xiM M K c K     (4.39) 

 Với tổng mô men tác dụng theo phƣơng X(My) tại tầng bất kỳ thì mô men uốn 

tác dụng lên vách cứng thứ i xác định theo: 

  xyxi y i x y yiM M K c K     (4.40) 

  xxyi y i y y xiM M K c K     (4.41) 

4.3. Xác định nội lực nhà cao tầng bằng phần mềm thông dụng 

Nhà cao tầng với mô hình kết cấu là một hệ siêu tĩnh bậc cao cùng với những đặc 

điểm về kết cấu phức tạp nhƣ: hệ kết cấu khung vách cứng và lõi cứng, hệ kết cấu hình 

ống, hệ kết cấu hình hộp.. .kết hợp với việc phải tính toán các tải trọng phức tạp nhƣ 

động đất, gió động.. .làm cho việc tính toán kết cấu của nhà cao tầng trở nên khó khăn 

và gần nhƣ không thể thực hiện bằng phƣơng pháp thủ công. 

Trong ngành xây dựng, Etabs là một phần mềm phân tích và thiết kế kết cấu 

đƣợc sử dụng với nhiều tính năng ƣu việt nhƣ: 

 Sử dụng hệ lƣới và các lựa chọn bắt điểm giống AutoCAD. 

 Xuất và nhập sơ đồ hình học từ môi trƣờng AutoCAD (file *.DXF) 

 Tăng tốc nhập liệu nhà cao tầng bằng khái niệm tầng tƣơng tự - similar story. 

 Có khả năng chia ảo phần tử, làm tăng tốc quá trình phân tích tính toán. 

 Tự động xác định trọng bản thân cấu kiện, khối lƣợng và trọng lƣợng các tầng. 

 Tự động xác định tâm hình học, tâm cứng và tâm khối lƣợng công trình. 

 Tự động xác định chu kì và tần số dao động riêng của công trình. 

Dƣới đây sẽ trình bày phƣơng pháp ứng dụng phần mềm Etabs trong phân tích 

kết cấu nhà cao tầng thông qua mô hình cụ thể. 

4.3.1. Dữ liệu bài toán 

Một công trình có mặt bằng nhƣ hình vẽ, gồm 15 tầng và 1 tầng hầm, chiều cao 

của tầng là 3,5m; tầng hầm cao 3m. Giả thiết tƣờng gạch xây trên tất cả các dầm, 

tƣờng dày 200, 
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Tải trọng: tĩnh tải của các lớp hoàn thiện lên sàn 0,15 T/m
1
. Hoạt tải tính toán sàn 

làm việc 0,24 T/m
2
; hoạt tải sàn mái 0,09 T/m

2
. Tĩnh tải do tƣờng tác dụng lên dầm: 

1,05 T/m. 

Chọn sơ bộ kích thƣớc tiết diện: sàn dày 150; dầm bxh = 300x600; vách dày 250. 

Vật liệu: bê tông cấp độ bền chịu nén B25, cốt thép CII. 

Bảng 4. 1. Kích thƣớc cột 

Base ÷ story 3 Story 3 ÷ story 

6 

Story 6 ÷ story 

9 

Story 9 ÷ story 

12 

Story 12 ÷ story 

16 

800x800 700x700 600x600 500x500 600x600 

 

 
Hình 4. 10. Mặt bằng công trình. 

4.3.2. Trình tự thực hiện 

BƢỚC 1: CHỌN ĐƠN VỊ 

Rê chuột đến thanh trạng thái góc bên phải của màn hình, click chọn đơn vị T-m 

BƢỚC 2: TẠO HỆ LƢỚI 

1. Click vào menu File ⇒ New Model... 

Hộp thoại New Model Initialization xuất hiện: chọn Default.ebd 

2. Chọn Default.ebd  
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Hộp thoại Building Plan Gird System and Data Definition xuất hiện, nhập thông 

số nhƣ hình vẽ.  

 

3. Click chọn Custom Gird Spacing ⇒ Edit Gird…  

Hộp thoại Define Grid Data xuất hiện, click chọn Spacing rồi nhập giá trị nhƣ 

hình: 

 

4. Click OK 2 lần để đóng hộp thoại Building Plan Gird System and Data 

Definition.  

Sau khi đóng hộp thoại Building Plan Grid System and Data Definition trên màn 

hình xuất hiện hai cửa sổ làm việc, click chuột vào một điểm bất kỳ tại cửa sổ 3-D 

View, dùng các phím mũi tên để hiệu chỉnh góc nhìn.  

BƢỚC 3: KHAI BÁO VẬT LIỆU  

1. Click vào menu Define ⇒ Material Properties, hộp thoại Define Material xuất 

hiện.  
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2. Chọn CONC ⇒ Modify/show Material… Hộp thoại Material Property Data 

xuất hiện; nhập thông số nhƣ hình vẽ 

BƢỚC 4: KHAI BÁO TIẾT DIỆN DẦM - CỘT  

1. Click vào menu Define ⇒ Frame sections..., Hộp thoại Define Frame 

Properties xuất  

hiện.   

 

2. Chọn tất cả các tiết diện có sẵn, click Delete Property để xóa.  

3. Tại dòng Add I/Wide Flange chọn Add Rectangular, hộp thoại Rectangular 

Section  xuất hiện, nhập số liệu nhƣ hình:  

Khai báo tiết diện dầm kích thƣớc 300x600: nhập số liệu nhƣ hình  
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 Làm tƣơng tự với các tiết diện cột: C800x800, C700x700, C600x600, 

C500x500, C400x400.  

BƢỚC 5: KHAI BÁO TIẾT DIỆN SÀN - VÁCH  

1. Click vào menu Define ⇒ Wall/Slab/Deck Section...  

Hộp thoại Define Wall/Slab/Deck Section xuất hiện  

 

2. Click chọn SLAB1 ⇒ Modify/Show Section..., hộp thoại Wall/Sab Section 

xuất hiện, nhập số liệu nhƣ hình:  
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3. Click OK để đóng hộp thoại, tiếp tục click vào Wall1 ⇒ Modify/Show 

Section... để khai báo tiết diện vách. Nhập số liệu nhƣ hình:  

 

BƢỚC 6: KHAI BÁO TẢI TRỌNG  

1. Click vào menu Define ⇒ Static Load Cases... hộp thoại Define Static Load 

Cases  

xuất hiện, khai báo tải trọng nhƣ hình sau:  
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2.  Click OK để đóng hộp thoại.  

BƢỚC 7: KHAI BÁO TẢI TRỌNG THAM GIA DAO ĐỘNG  

1.  Click vào menu Define ⇒ Mass Source ⇒ From Loads  

2.  Khai báo TT hệ số 1, HT hệ số 0,5 nhƣ hình sau: 

 

BƢỚC 8: VẼ VÁCH  

1.  Click chọn khung cửa sổ Plan View; rê chuột đến thanh trạng thái bên dƣới 

góc phải màn hình click chọn chế độ Similar stories.  

2.  Click công cụ vẽ vách Draw Wall trên thanh công cụ Draw. Trên hộp thoại 

Properties of Object mục Property chọn “VACH”.  

3.  Click lần lƣợt từng điểm trên lƣới ta vẽ đƣợc vách nhƣ hình sau:  
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BƢỚC 9: VẼ CỘT  

Để vẽ cột đƣợc dễ dàng và nhanh chóng, ta tạm thời ẩn một số đƣờng lƣới phụ và 

phần tử vách vừa vẽ.  

1.  Click vào menu View/Set Building View Options... hộp thoại Set Building 

View Options xuất hiện, click bỏ Wall (Area)  

 

2.  Click chuột phải chọn Edit Gird Data... hộp thoại Coordinate Systems xuất 

hiện, chọn  

Modify/Show System...  

3.  Click chọn Hide tại cột Visibility để tạm thời ẩn đi các đƣờng lƣới phụ  
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4. Click OK 2 lần để đóng các hộp thoại.  

5. Click chuột phải chọn Edit Story Data... hộp thoại Story Data xuất hiện, tại các 

cột  

Master Story và Similar To ta chọn nhƣ hình sau:  

 

6. Tại cửa sổ Plan View tại Story 16 click chọn công cụ vẽ cột Create Colums 

trên thanh công cụ Draw.  

Hộp thoại Properties of Object xuất hiện, tại mục Property chọn tiết diện 

C400x400.  
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7. Click chọn 1 điểm từ góc bên trái đến góc bên phải để tạo thành khung cửa sổ 

chữ nhật bao trùm các vị trí cột.  

8. Di chuyển xuống Story12, chọn tiết diện D500x500 rồi vẽ theo cách tƣơng tự.  

9. Lần lƣợt di chuyển đến các tầng Story9, Story6, Story3 để vẽ các cột có tiết 

diện tƣơng ứng.  

BƢỚC 10: VẼ DẦM  

1. Click chuột phải chọn Edit Story Data... hộp thoại Story Data xuất hiện, click 

Reset để đƣa tất cả các tầng về Similar to Story16.  

2. Click chọn công cụ vẽ nhanh dầm Create Lines in Region or at Clicks trên 

thanh công cụ Draw.  

Hộp thoại Properties of Object xuất hiện, tại mục Property chọn tiết diện 

D300x600.  

3. Click chọn 1 điểm từ góc bên trái đến góc bên phải để tạo thành khung cửa sổ 

chữ nhật bao trùm các đƣờng lƣới. Kết quả ta đƣợc hệ dầm nhƣ hình sau:  

 

BƢỚC 11: VẼ SÀN  

1. Click công cụ vẽ nhanh sàn Create Areas at Click trên thanh công cụ Draw.  

Hộp thoại Properties of Object xuất hiện, tại mục Property chọn tiết diện “SAN”.  

2. Click chọn 1 điểm từ góc bên trái đến góc bên phải để tạo thành khung cửa sổ 

chữ nhật bao trùm các vị trí sàn.  

3. Xóa các ô sàn tại vị trí thang máy.  

BƢỚC 12: HIỆU CHỈNH MÔ HÌNH  
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1. Click chuột phải chọn Edit Gird Data... hộp thoại Coordinate Systems xuất 

hiện, chọn  

Modify/Show System...  

2.  Click chọn Show tại cột Visibility để hiển thị lƣới 1’ và 4’’.  

3. Click chọn công cụ vẽ dầm Draw Lines trên thanh công cụ Draw, chọn tiết 

diện D300x600.  

4. Click vẽ bổ sung  đoạn dầm đi qua thang máy từ điểm lƣới 1’-B đến 1’-C và 

đoạn dầm 4’’B đến 4’’C.  

5.  Click chọn công cụ vẽ sàn hình chữ nhật Draw Rectangular Areas,  

Hộp thoại Properties of Object xuất hiện, tại mục Property chọn tiết diện “SAN”.  

6.  Rê chuột từ góc trái đến góc phải của ô sàn tạo thành khung hình chữ nhật để 

vẽ các ô sàn nhỏ. Kết quả ta đƣợc mô hình nhƣ hình vẽ:  

 

BƢỚC 13: GÁN TẢI TRỌNG TƢỜNG TRÊN DẦM  

1. Click vào menu Select ⇒ chọn by Line Object Type...  

Hộp thoại Select Line Object Type xuất hiện, chọn Beam ⇒ OK  

 

 2. Để bỏ chọn dầm tầng mái (Story16) ta click vào menu Select ⇒ chọn Deselect 

⇒ by  
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Story Level...  

Hộp thoại Select Story Level xuất hiện, chọn Story16 ⇒ OK 

3. Click vào menu Assign ⇒ Frame/Line Loads ⇒ Distributed...  

Hộp thoại Frame Distributed Loads xuất hiện, khai báo giá trị nhƣ hình vẽ  

 

BƢỚC 14: GÁN TẢI TRỌNG PHÂN BỐ TRÊN SÀN  

1. Click vào menu Select ⇒ chọn by Area Object Type...  

Hộp thoại Select Area Object Type xuất hiện, chọn Floor ⇒ OK  

2. Click vào menu Assign ⇒ Shell/Area Loads ⇒ Uniform...  

Hộp thoại Uniform Surface Loads xuất hiện, gán giá trị nhƣ hình vẽ  

 

3. Click vào menu Select ⇒ Get Previous Selection để chọn lại những ô sàn vừa 

đƣợc chọn trƣớc đó.   

4. Click vào menu Assign ⇒ Shell/Area Loads ⇒ Uniform...  



-129- 

 

Hộp thoại Uniform Surface Loads xuất hiện, gán giá trị nhƣ hình vẽ  

 

5.  Trên thanh trạng thái chuyển từ chế độ Similar Stories sang One Story.  

Trên cửa sổ Plan View, di chuyển đến Story16 rồi chọn tất cả các ô sàn ở tầng 

này.  

6.  Click vào menu Assign ⇒ Shell/Area Loads ⇒ Uniform...  

Gán giá trị hoạt tải (HT) là 0,09 T/m2 

BƢỚC 15: GÁN TÊN CHO VÁCH  

 Nếu ngƣời sử dụng muốn chƣơng trình xuất ra kết quả nội lực để tính toán cốt 

thép cho vách cứng thì nên đặt tên cho từng vách riêng lẽ.  

 Nếu ngƣời sử dụng muốn chƣơng trình xuất ra kết quả nội lực để tính toán cốt 

thép móng cho vách cứng thì nên đặt tên cho các vách cùng một tên.  

1.  Click vào menu Select ⇒ chọn by Area Object Type...  

Hộp thoại Select Area Object Type xuất hiện, chọn Wall ⇒ OK  

2.  Click vào menu Assign ⇒ Shell/Area ⇒ Pier Label...  

Hộp thoại Pier Names xuất hiện, gán tên vách là V1 ⇒ OK.  

BƢỚC 16: CHIA PHẦN TỬ SÀN  

1.  Click vào menu Select ⇒ chọn by Area Object Type...  

Hộp thoại Select Area Object Type xuất hiện, chọn Floor ⇒ OK  

2.  Click vào menu Assign ⇒ Shell/Area ⇒ Area Object Mesh Options...  

Hộp thoại Area Object Auto Mesh Options xuất hiện.  

3. Chọn chế độ Auto Mesh Object into Structural Elements ⇒ Chọn Futher 

Subdivide  

Auto Mesh with Maximum Elemen Size of nhập giá trị là 1.  
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BƢỚC 17: CHIA NHỎ PHẦN TỬ VÁCH  

Để tính toán cốt thép cho vách cứng và móng ta tiến hành chia nhỏ vách cứng.  

1.  Click chọn phần tử vách trục 1’’, 4’, B2, B5.  

2.  Click vào menu Edit ⇒ Mesh Areas, hộp thoại Mesh Selected Areas xuất 

hiện, nhập giá trị cần chia. 

3.  Thao tác tƣơng tự cho các vách khác. 

BƢỚC 18: GÁN ĐIỀU KIỆN BIÊN CHO KẾT CẤU  

1.  Trên cửa sổ Plan View, di chuyển đến tầng hầm Base rồi chọn tất cả các chân 

cột.  

2.  Click vào menu Assign ⇒ Joint/Point ⇒ Restraints (Supports)…  

Hộp thoại Assign Restraints xuất hiện  

 3.  Click chọn biểu tƣợng liên kết ngàm ⇒ OK  

 

BƢỚC 19: KHAI BÁO SÀN TUYỆT ĐỐI CỨNG  
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1.  Click vào menu Select ⇒ chọn by Area Object Type...  

Hộp thoại Select Area Object Type xuất hiện, chọn Floor ⇒ OK  

2.  Click vào menu Assign ⇒ Shell/Area ⇒ Diaphragms...  

Hộp thoại Assign Diaphragms xuất hiện. 

 

3.  Click chọn D1 ⇒ OK để đóng hộp thoại.  

BƢỚC 20: THỰC HIỆN TÍNH TOÁN  

Click vào menu Analyze ⇒ Run Analysis.  

BƢỚC 21: XUẤT KẾT QUẢ - TÍNH TOÁN TẢI TRỌNG GIÓ  

1.  Click vào menu Display ⇒ Show Tables...  

Hộp thoại Choose Tables for Display xuất hiện, click chọn Modal Information và 

Building Output  

 

 Khi đó trên màn hình sẽ xuất hiện hộp thoại cung cấp cho ngƣời sử dụng những 

bảng kết quả của bài toán.  

2.  Click chọn Modal Participating Mass Ratios  
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 Chú thích:  

 Mode: 12 dạng dao động của bài toán.  

 Period: chu kỳ (T) ứng với các dạng dao động.  

3.  Tiếp tục click vào Building Modes  

 

Chú thích:  

UX: dịch chuyển theo phƣơng trục X ứng với các dạng dao động (Mode).  

UY: dịch chuyển theo phƣơng trục Y ứng với các dạng dao động (Mode).  

4.  Tiếp tục click chọn Center Mass Rigidity  
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Chú thích:  

MassX, MassY: khối lƣợng tập trung tại các tầng.  

Dựa vào các kết quả trên ta thực hiện tính toán để ra đƣợc tổng tải trọng gió tác 

dụng lên công trình.  

Tổng tải trọng gió (tĩnh + động): đƣợc xác định nhƣ chƣơng 3 

Tầng Tổng tải gió lên phƣơng OX 

(T) 

Tổng tải gió lên phƣơng OY 

(T) 

Story 2 

Story 3 

Story 4 

Story 5 

Story 6 

Story 7 

Story 8 

Story 9 

Story 10 

Story 11 

Story 12 

Story 13 

Story 14 

Story 15 

Story 16 

14.61 

16.58 

18.23 

19.38 

20.32 

21.12 

21.87 

22.42 

22.91 

23.37 

23.71 

23.96 

24.2 

24.41 

21.72 

18.18 

20.51 

22.3 

23.7 

24.73 

25.72 

26.59 

27.28 

27.92 

28.48 

28.93 

29.29 

29.64 

29.94 

26.82 

BƢỚC 22: NHẬP TẢI GIÓ VÀO MÔ HÌNH TÍNH TOÁN  

1. Click vào biểu tƣợng  Lock/Unlock Model trên thanh công cụ.  
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2. Click vào menu Define ⇒ Static Load Cases... hộp thoại Define Static Load 

Cases xuất hiện, khai báo tải trọng nhƣ hình sau:  

 

3. Click chọn GX (gió cùng chiều theo phƣơng trục X) ⇒ Chọn Modify Lateral 

Load..., hộp thoại User Wind Load xuất hiện, nhập giá trị tại cột FX:  

 

Click OK để kết thúc việc nhập tải gió GX.  

4. Click chọn GXX (gió ngƣợc chiều theo phƣơng trục X) ⇒ Chọn Modify 

Lateral Load..., hộp thoại User Wind Load xuất hiện, nhập giá trị tại cột FX:  
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Click OK để kết thúc việc nhập tải gió GXX  

5. Click chọn GY (gió cùng chiều theo phƣơng trục Y) ⇒ Chọn Modify Lateral 

Load..., hộp thoại User Wind Load xuất hiện, nhập giá trị tại cột FY:  

  

Click OK để kết thúc việc nhập tải gió GY.  

6. Click chọn GYY (gió ngƣợc chiều theo phƣơng trục Y) ⇒ Chọn Modify 

Lateral Load..., hộp thoại User Wind Load xuất hiện, nhập giá trị tại cột FY:  



-136- 

 

 

Click OK 2 lần để kết thúc việc nhập tải gió. 

BƢỚC 23: NHẬP TẢI ĐỘNG ĐẤT VÀO MÔ HÌNH TÍNH TOÁN  

Trong trƣờng hợp công trình có xét đến tải trọng động đất. Các bƣớc tính toán và 

nhập tải vào mô hình tƣơng tự nhƣ chƣơng 3. 

BƢỚC 23: TỔ HỢP TẢI TRỌNG  

Tùy trƣờng hợp công trình có tính toán động đất hay không mà có những tổ hợp 

tải trọng khác nhau đƣợc thể hiện trong chƣơng 3. Dƣới đây là các bƣớc nhập tổ hợp 

tải trọng. 

1. Click vào menu Define ⇒ Load Combinations... hộp thoại Define Load 

Combinations xuất hiện, chọn Add New Combo...  

2.  Hộp thoại Load Combination Data xuất hiện, khai báo TH1 nhƣ sau:  
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3.  Thực hiện tƣơng tự để khai báo các tổ hợp khác. 

4.  Khai báo tổ hợp THBAO nhƣ hình sau:  

 

BƢỚC 24: THỰC HIỆN TÍNH TOÁN VÀ XEM KẾT QUẢ  

Click vào menu Analyze ⇒ Run Analysis để thực hiện tính toán. Sau khi chƣơng 

trình giải xong ngƣời sử dụng cần xem giá trị kết quả và xuất thành file dữ liệu để thực 

hiện tính toán cốt thép.  

BƢỚC 25: XEM BIỂU ĐỒ VÀ GIÁ TRỊ NỘI LỰC CỦA PHẦN TỬ THANH - 

VÁCH  

1.  Trên khung Plan-View click  để di chuyển đến tầng cần xem kết quả.  

2.  Click vào menu Display ⇒ Show Member Forces/Stress Diagram ⇒  

Frames/Pier/Spandrel Forces...  

Hộp thoại Member Forces Diagram for Frame...xuất hiện  
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3.  Tại dòng Load chọn loại tải trọng hay tổ hợp cần xem nội lực.  

4.  Trong mục Component:  

Click chọn Moment 3-3 để xem biểu đồ và giá trị moment của dầm.  

Click chọn Shear 2-2 để xem biểu đồ và giá trị lực cắt của dầm.  

5.  Trong mục Options để hiện thị giá trị trên biểu đồ ta click chọn Show Values 

on Diagram.  

6.  Trong mục Include chọn Frames nếu muốn xem nội lực phần tử thanh, chọn 

Pier nếu muốn xem nội lực phần tử vách.  

BƢỚC 26: XUẤT FILE KẾT QUẢ  

1.  Click vào menu Display ⇒ Show Tables... hộp thoại Chose Tables for Display 

xuất hiện.  

 

2.  Click chọn Select Cases/Combos... để chọ trƣờng hợp tải hoặc tổ hợp cần 

xem.  

3.  Click chọn mục Displacements để xuất bảng kết quả chuyển vị.  

4.  Click chọn mục Reactions để xuất bảng kết quả phản lực.  

5.  Click chọn mục Building Output để xuất bảng kết quả khối lƣợng và độ cứng.  

6.  Click chọn mục Frame Output để xuất bảng kết quả nội lực phần tử thanh.  

7.  Click chọn mục Wall Output để xuất bảng kết quả nội lực phần tử vách. 

 

  



-139- 

 

Chương 5 

 KIỂM TRA SỰ LÀM VIỆC CỦA NHÀ CAO TẦNG 

Kết cấu nhà cao tầng cần phải đƣợc tính toán và kiểm tra về độ bền, biến dạng, 

độ cứng, ổn định và dao động. Nội lực và biến dạng của kết cấu nhà cao tầng đƣợc 

tính toán theo phƣơng pháp đàn hồi. Các cấu kiện dầm có thể đƣợc điều chỉnh theo 

quy luật liên quan đến sự phân bố lại nội lực do biến dạng dẻo. 

5.1. Kiểm tra ổn định tổng thể 

Khi ngôi nhà đã bị uốn, dƣới tác động của tải trọng thẳng đứng, nội lực và biến 

dạng của ngôi nhà sẽ tăng lên. Nếu trọng lƣợng của ngôi nhà lớn và độ cứng của ngôi 

nhà không đủ thì biến dạng sẽ tăng nhanh và dẫn đến mất ổn định tổng thể. Trọng 

lƣợng có thể gây ra mất ổn định tổng thể ngôi nhà gọi là trọng lƣợng cực hạn (Gkp). 

Để xác định trọng lƣợng cực hạn của nhà, dựa vào các giả thiết sau: 

- Mô hình tính toán nhà là một thanh công xôn ngàm vào móng 

- Độ cứng không thay đổi theo chiều cao 

- Trọng khối nhà phân bố đều theo thể tích ngôi nhà 

- Biến dạng của các sàn trong mặt phẳng nằm ngang không đáng kể và có thể 

bỏ qua. 

Điều kiện cần thiết để công trình không mất ổn định tổng thể đã đƣợc kiểm 

nghiệm qua thực tế là: 

1,5
kp

tc

G

G
  (5.1) 

Trong đó:  

G
tc
 = 1,1G   (5.2) 

với G là trọng lƣợng phần trên mặt đất của ngôi nhà. 

Đối với công trình bằng BTCT, trọng lƣợng cực hạn của ngôi nhà xác định theo: 

2

0

2

0

2

0

2,3

2,3

2,3

b x
x

b y

y

b

E I
G

H

E I
G

H

E I
G

H












 (5.3) 

trong đó:  
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2 2

0 0 0 0

; ;

2

x xi y yi xy xyi

xi i yi i xyi i i

I I I I I I

I I a a I b b I a a b b I i 

  

       

  

   
 (5.4) 

Eb – mô đun biến dạng ban đầu của bê tông 

H0 – chiều cao nhà (phần trên mặt đất). 

Thông số γ phụ thuộc vào vị trí tâm uốn và các yếu tố mặt bằng nhà nên đƣợc gọi 

là đặc trƣng mặt bằng nhà. 

Nếu nhà chỉ có một lõi cứng và cho mô đun trƣợt : G = 0,4Eb thì: 

0,4 b xoanE I
G


  (5.5) 

Trọng lƣợng cực hạn của công trình phụ thuộc nhiều vào vị trí trọng tâm nhà và 

vị trí tâm uốn của nhà. 

- Nếu các tâm này trùng nhau thì trọng lƣợng cực hạn của nhà lấy bằng: 

min

x

kp y

G

G G

G

 
 


 
 
 

 (5.6) 

- Nếu các tâm này không trùng nhau thì nhà sẽ mất ổn định theo dạng uốn 

xoắn. 

Trọng lƣợng cực hạn của nhà Gkp cho dạng mất ổn định theo uốn – xoắn: 

phụ thuộc vào khoảng cách từ tâm uốn đến trọng tâm nhà: 

2 2

oi oiX Y    (5.7) 

Trong đó: Xoi; Yoi – tọa độ trọng tâm của mặt bằng nhà đang xét đối với hệ trục 

có tâm trùng với tâm uốn. 

Nếu 

2

0,1



  thì trọng lƣợng cực hạn có thể xác định gần đúng theo: 

Gkp = αGmin (5.8) 

trong đó α là hệ số xác định theo đồ thị, phụ thuộc vào 
2


và trọng lƣợng cực hạn 

trung bình Gtb:  
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1

3
tb x yG G G G    (5.9) 

 

 Hình 5. 1. Đồ thị xác định α. 

 Đặc trƣng mặt bằng nhà γ xác định theo: 

 2 2 2

F F

x y df df

F F







 
 

 
(5.10) 

 

Hình 5. 2. Xác định đặc trƣng mặt bằng nhà. 

Triển khai tích phân: 

 
/2 /2

2 2 2

/2 /2

3 3 3 3

3 2 2 3 2 2

oi i oi i

i oi i oi i

X a Y b

F X a Y b

i i i i i i
oi oi oi oi

df X Y dxdy

b a a a b b
X X Y Y



 

 

 

          
                 

             

  
 (5.11) 
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Ta có:   

2 2 2 2 2( ) /12

i

i i oi oi i i

F

df a b X Y a b        
(5.12) 

Do đó: 

 2 2 2

2 2 2 2( ) /12F F
oi oi i i

x y df df

X Y a b
F F







       

 
 

(5.13) 

Nếu tâm uốn trùng với trọng tâm nhà thì: 

2 2( ) /12i ia b      (5.14) 

Nếu mặt bằng nhà bao gồm nhiều phần hợp lại thì: 

2 2 2 2 2

1

( ) /12

i

n

i i oi oi i i

F

df a b X Y a b        (5.14) 

2 2 2 2

1

1
( ) /12

n

i i oi oi i i

i

a b X Y a b
F

       


 (5.15) 

Nhận xét: Đặc trƣng mặt bằng nhà γ càng lớn thì trọng lƣợng cực hạn của ngôi 

nhà càng giảm nghĩa là ổn định ngôi nhà càng giảm. Do đó khi thiết kế cố gắng giảm 

tối đa khoảng cách từ tâm uốn đến trọng tâm nhà. 

5.2. Kiểm tra gia tốc dao động 

Từ phƣơng trình động học ta có chuyển vị : Y = Asin(ωt + ); với ω – là tần số 

dao động riêng; – độ lệch pha, A – là biên độ dao động. 

Vận tốc:   Yʹ = ωAcos(ωt +) 

Gia tốc: 

Yʺ = -ω
2
Asin(ωt + ) (5.16) 

Gọi f – là chuyển vị ngang lớn nhất tại đỉnh nhà khi sin(ωt +) = -1. 

Khi đó gia tốc đạt giá trị lớn nhất tại đỉnh nhà: 

Yʺ = ω
2
f (5.17) 

Nhằm đảm bảo sinh hoạt bình thƣờng của con ngƣời sống trong nhà qui phạm 

qui định: gia tốc cực đại Yʺ = ω
2
f ≤ [yʺ]gh = 150 mm/s

2
. 
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5.3. Xác định chuyển vị của nhà cao tầng 

Các giá trị chuyển vị ngang đỉnh kết cấu (độ võng đỉnh nhà) cần đƣợc hạn chế 

bởi tỷ lệ giữa chuyển vị và chiều cao nhà theo các tiêu chuẩn TCVN 198:1997 Nhà 

cao tầng – Thiết kế kết cấu bê tông cốt thép toàn khối. 

- Kết cấu khung BTCT: f/H ≤ 1/500 

- Kết cấu khung – vách:  f/H ≤ 1/750 

- Kết cấu tƣờng BTCT: f/H ≤ 1/1000 

Ở đây f và H là chuyển vị ngang đỉnh kết cấu và chiều cao tính toán ngôi nhà. 

Dƣới tác động của tải trọng gió chuyển vị ngang của kết cấu gồm hai thành phần: 

thành phần thứ nhất ytĩnh do gió tĩnh; thành phần thứ hai hay là biên độ dao động của 

kết cấu do tác động của gió động gây ra yđộng; bởi vậy chuyển vị lớn nhất tại tiết diện 

bất kỳ sẽ là: y = ytĩnh + yđộng 

Nếu ký hiệu các chuyển vị tĩnh ftĩnh và động fđộng  của độ võng f thì: 

f = ftĩnh + fđộng   (5.18) 

Tƣơng tự nhƣ trên ta có góc nghiêng của kết cấu chịu lực: 

φ = φtĩnh + φđộng (5.19) 

Với mô hình thanh công xôn tính toán cho ngôi nhà ta có thể đƣa ra những công 

thức tính độ võng, góc nghiêng cho tiết diện bất kỳ cách mặt đất một đoạn z sau đây:  
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(5.23) 

trong đó:  

 Bj – độ cứng ngôi nhà (Bx và By) tính theo các trục thẳng góc với các hƣớng gió; 

ηj – các hệ số ηx hoặc ηy xác định theo các công thức sau: 
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(5.24) 

k – hàm của hệ tọa độ z, xác định theo các công thức sau hoặc theo bảng 5.1: 

 2 3 4 5

5

1
0,012 0,23 0,5 0,1

12
k u u u u u     

 
(5.25a) 
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(5.25c) 
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(5.25d) 

trong đó:  

0

z
u

H
  (5.26) 

Bảng 5.1.  

u = z/H0 k5 k6 k7 k8 

1,0 0,0535 0,1294 0,0608 0,1608 

0,9 0,0474 0,1132 0,0608 0,1607 

0,8 0,0413 0,0972 0,0608 0,1597 

0,7 0,0353 0,0814 0,0605 0,1567 

0,6 0,0292 0,0660 0,0598 0,1512 

0,5 0,0233 0,0519 0,0584 0,1426 

0,4 0,0176 0,0376 0,0554 0,1302 

0,3 0,0123 0,0254 0,0508 0,1137 

0,2 0,0076 0,0150 0,0438 0,0926 

0,1 0,0037 0,0070 0,0335 0,0667 

0 0,0011 0,0018 0,0192 0,0358 

 Các giá trị tải trọng q1, q2, q3 xác định theo các công thức tính sẵn cho các độ 

cao và vùng áp lực gió A và B sau đây: 

q1 = Wocα1 (5.27a) 
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q2 = Wocα2 (5.27b) 

q3 = Wocα3 (5.27c) 

Ở đây: 

 Wo – giá trị áp lực gió tiêu chuẩn 

 c – Hệ số khí động lấy bằng 1,4 (kể cả áp lực đẩy và hút nếu nhà có mặt bằng 

chữ nhật); 

  – hệ số độ tin cậy lấy bằng 1,2; 

 α1, α2, α3 lấy theo bảng 5.2 

Bảng 5.2 

Chiều cao Ho (m) 10 20 40 60 80 100 200 350 

Vùng A 

k 1 1,25 1,55 1,75 _ 2,1 2,6 3,1 

α1 1 0,94 0,91 0,94 0,98 1,01 1,19 1,12 

α2 1 1,19 1,55 1,81 2,00 2,18 2,74 3,44 

Vùng B 

k 0,65 0,90 1,20 1,45 _ 1,50 2,45 3,0 

α1 0,65 0,59 0,56 0,58 0,61 0,67 0,82 1,02 

α2 0,65 0,84 1,20 1,48 1,70 1,87 2,57 3,30 

α3 1,11 1,24 1,11 1,29 1,32 1,39 1,61 1,77 

Trong bảng 5.2, k – là hệ số chiều cao, vùng A, B lấy theo tiêu chuẩn tải trọng 

gió. Các giá trị tải trọng gió tĩnh q1, q2 xác định theo công thức (5.27) phù hợp với biều 

đồ gió dạng hình thang quy đổi và q3 tƣơng ứng với biểu đồ gió động hình tam giác 

(Hình 5.3). 

 

Hình 5. 3. Phân bố tải trọng gió theo độ cao. 

Các công thức (5.21) – (5.23) cho các chuyển vị của trục thẳng đứng đi qua các 

tâm uốn của tiết diện ngang và theo phƣơng tác động của tải trọng ngang. Với tính 
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toán trên đây có thể đánh giá đƣợc các dạng uốn của kết cấu hay là độ cứng của ngôi 

nhà dƣới tác động của tải trọng gió. 

Với mô hình tính toán là một thanh công, xon một đầu ngàm vào móng và với 

giả thiết trọng khối phân bố đều theo chiều cao ngôi nhà, ta có thể xác định đƣợc chu 

kỳ dao động bản thân dạng thứ nhất theo công thức sau: 

2

2

2

1,875
j

j

H m
T

B

 
  
 

 (5.28) 

trong đó: 

m - trọng khối tính theo đơn vị chiều cao có thể lấy trong khoảng 3 đến 5 kN/m ’. 

Bj - độ cứng của nhà Bx, By khi uốn theo trục X và Y; 

H - chiều cao tính toán. 

Thay chiều cao tính toán H = 1,1 H„ ta đƣợc: 

2

02,17j

j

m
T H

B
  (5.29) 

Tần số dao động dạng thứ nhất: 

1
j

jT
   (5.30) 

Tần số dao động vòng: 

2
j

jT


   (5.31) 

Độ võng do thành phần gió động yđộng chính là biên độ dao động bản thân của 

ngôi nhà và đƣợc thể hiện trong phƣơng trình của các dao động điều hòa: 

y(t) = yđ sinωt (5.32) 

Vận tốc: 

 yʹω = ω yđ cosωt (5.33) 

Gia tốc:  

 yʺ(t) = -ω
2
yđ sinωt   (5.34) 

Gia tốc lớn nhất tại đỉnh nhà với z = Ho: 

  Y = fđộng và sinωt = -1 sẽ là: 

 Yʺmax = ω
2
fđộng (5.35) 

Trong (5.35) thay fđộng bằng độ võng tính theo (5.21) và tần số dao động vóng 

theo (5…) ta đƣợc: 
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 3
ax 1,085m j

q
Y

m
   (5.36) 

trong đó:  

  q3 – thành phần động của tải trọng tiêu chuẩn gió tại đỉnh nhà đã đƣợc 

nhân với chiều rộng mặt nhà, kN/m. 

  Ho – chiều cao nhà kể từ mặt đất, m. 

  G
tch

 – trọng lƣợng tiêu chuẩn trên mặt đất của ngôi nhà, kN; 

  ηj – hệ số xét tới chuyển vị tính theo công thức (5.24) 

  yʺmax – gia tốc lớn nhất đỉnh nhà, m/s
2
. 

 Theo công thức (5.36) ta thấy độ cứng kết cấu không chịu ảnh hƣởng trực tiếp 

đến gia tốc lớn nhất. Độ cứng kết cấu chỉ ảnh hƣởng gián tiếp tới gia tốc qua hệ số ηj 

và thành phần gió độ q3. Nhƣ vậy ngoài yếu tố về tải trọng gió, tỷ số giữa trọng lƣợng 

và diện tích mặt đứng ngôi nhà cũng có ảnh hƣởng đến gia tốc. 

5.4. Xác định độ nghiêng, lệch của nhà cao tầng 

Dƣới tác động của tải trọng ngang, độ nghiêng của từng bộ phận kết cấu phụ 

thuộc vào góc nghiêng của hệ kết cấu chịu lực, vào kích thƣớc và vị trí các bộ phận đó.  

Trền hình 5.4 trình bày sơ đồ hệ thống khung ngang của ngôi nhà bị uốn trong và 

ngoài mặt phẳng tác động của gió, ngoài hai hệ tƣờng cứng theo mặt cắt ngang có ba 

nhịp – khung có hoặc không có tƣờng nhồi.  

 

Hình 5. 4. Độ nghiêng lệch của nhà trong và ngoài mặt phẳng. 

Nhịp thứ nhất nằm giữa hai cột tự do, cột khung không nằm trong hệ tƣờng cứng. 

Do vậy độ xiên của nhịp thứ nhất phải bằng độ xiên của kết cấu chịu lực nghĩa là β1 = 
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φ (Hình 5.4a). Còn đối với những tƣờng cứng thẳng góc với phƣơng tác động của gió 

(Hình 5.4b) thì chỉ có nhịp nằm giữa hai tƣờng cứng hoặc kề bên một tƣờng thì mới có 

độ xiên, trƣờng hợp này ngôi nhà không bị uốn xiên.  

Các kết cấu bị nghiêng không chỉ do tác động của tải trọng gió mà còn do các 

nguyên nhân khác nhƣ do kết cấu chịu lực của ngôi nhà chịu nén không đều.  Nhƣng 

những độ xiên này thƣờng xảy ra ngay vào thời kỳ đầu sử dụng ngôi nhà và có thể 

phát hiện và tiến hành sửa chữa ngay đƣợc. Duy chỉ có độ nghiêng do tác động của gió 

sẽ xuất hiện trong suốt quá trình sử dụng nên có ảnh hƣởng đáng kể đối với các bộ 

phận ngôi nhà. 

Tùy thuộc vào góc nghiêng của hệ tƣờng cứng chịu lực, vào kích thƣớc và vị trí 

của các nhịp khung ta có thể xác định đƣợc các góc nghiêng của từng bộ phận ngôi 

nhà theo các công thức cho trong bảng 5.3. 

Bảng 5.3. 

Mặt cắt Vị trí nhịp khung Góc nghiêng của kết cấu 

Trong mặt phẳng tác 

động của tải trọng gió 

Nhịp nằm giữa những cột “tự do” β1 = φ 

Nhịp kề với cột của tƣờng cứng Β2 = φ × (1+C2/d2) 

Nhịp nằm giữa hai cột tƣờng cứng Β3 = φ×[1+(C2+C3)/d3] 

Trong mặt phẳng thẳng 

góc với hƣớng tải trọng 

gió 

Nhịp kề với hai cột của hai tƣờng 

cứng nằm cách nhau một bƣớc cột 

(khẩu độ) 

Β4 = φ×[(C4+C5)/d4] 

Nhịp có một bên kề với tƣờng cứng Β5 = C5 /d4 

Khi ngồi nhà có các khối cao, thấp chênh nhau nhiều thƣờng gây ra lún không 

đều với các trị số vƣợt quá quy định cho phép, nhất là phần móng lại đặt trên nền thiên 

nhiên, khi xác định độ nghiêng của kết cấu cần xét tới ảnh hƣởng lún không đều của 

nền móng. 

5.5. Xác định chuyển vị ngang của nhà cao tầng 

Dựa vào phần mềm tính kết cấu Etabs ta tìm đƣợc chuyển vị tại đỉnh của công 

trình. 

- Chọn nút trên tầng mái  vào Display/show tables… 

- Xác định chuyển vị lớn nhất của công trình f. 

5.6. Kiểm tra ổn định nghiêng lật của công trình 

Khi xét ổn định nghiêng lật của công trình, giá trị thiết kế của mô men gây lật 

đƣợc tính do ảnh hƣởng của tải trọng gió hay động đất. Khi tính mô men chống lật, 

hoạt tải sàn lấy 50%, tải trọng tĩnh lấy bằng 100%. 

1,5cl

l

M

M
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trong đó:  

cl i i

l i i

M G Z

M F H








   

Mcl – mô men chống lật; 

Ml – mô men gây lật. 
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Chương 6 

NGUYÊN TẮC KIỂM TRA BỀN VÀ CẤU TẠO                              

KẾT CẤU CHỊU LỰC 

6.1. Nguyên tắc chung 

Việc kiểm tra các tiết diện cột, dầm khung trong nhà cao tầng đƣợc tiến hành nhƣ 

các kết cấu bê tông cốt thép thƣờng hay ứng lực trƣớc tuân theo tiêu chuẩn thiết kế kết 

cấu bê tông cốt thép hiện hành TCVN 9386:2012. 

Khi kiểm tra các tiết diện của vách, lõi theo điều kiện bền (theo cƣờng độ) còn 

phụ thuộc vào phƣơng pháp xác định nội lực của kết cấu đó, bởi mỗi phƣơng pháp đều 

xuất phát từ một giả thiết nhất định. 

Đối với các kết cấu vách, lõi bê tông cốt thép cần xem nhƣ những cấu kiện liện 

tục và đồng thời chịu lực tới trạng thái giới hạn, nghĩa là kết cấu đã tận dụng hết khả 

năng của vật liệu và dẫn đến phá hoại cùng một lúc. 

Để đảm bảo điều kiện các cấu kiện trong hệ đồng thời đạt tới các trạng thái giới 

hạn trong tính toán đƣa vào các hệ số hiệu chỉnh còn gọi hệ số điều kiện làm việc. Các 

hệ số này dựa trên kết quả so sánh nội lực giới hạn theo tính toán lý thuyết với nội lực 

phá hoại thông qua thực nghiệm. 

Qui định về vật liệu: 

Vật liệu chính dùng làm kết cấu nhà cao tầng phải đảm bảo các tính năng cao 

trong các mặt: cƣờng độ chịu lực, độ bền mỏi, tính biến dạng, và khả năng chống cháy. 

Về bê tông: Khi thiết kế công trình nhà cao tầng thì dùng bê tông có cấp độ bền 

B25(M300) trở lên đối với các kết cấu bê tông cốt thép thƣờng và có cấp độ bền 

B30(M350) trở lên đối với các kết cấu bê tông cốt thép ứng lực trƣớc. 

Về cốt thép: Cốt thép dọc cần dùng loại có gờ, có độ dẻo cao, hàn đƣợc. Biến 

dạng cực hạn của thép khi kéo đứt không dƣới 0,05 (s >0,05), tỷ số của giới hạn bền 

và giới hạn đàn hồi không dƣới 1,25. 

Cốt thép dọc dùng nhóm CII, CIII hoặc cao hơn; 

Cốt đai dùng nhóm CI có đƣờng kính nhỏ hơn hoặc bằng 10mm; 

Cốt đai dùng nhóm CII có đƣờng kính lớn hơn 10mm. 

Khi thiết kế, cần căn cứ vào tính năng sử dụng công trình, đặc điểm của kết cấu 

và cấp động đất thiết kế,…để xác định mức độ dẻo cần thiết của kết cấu. Mức độ dẻo 

này quyết định các chi tiết về tính toán và cấu tạo của kết cấu. 

Phân loại việc cấu tạo kết cấu theo mức dẻo: 

Độ dẻo của kết cấu là tỷ số biến dạng của kết cấu khi bị phá hoại và biến dạng 

khi bắt đầu có biến dạng dẻo. 

Kết cấu bê tông cốt thép đƣợc cấu tạo theo ba mức dẻo: 
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- Mức dẻo thấp (I): việc cấu tạo theo cấp này chủ yếu nhằm tránh cho kết cấu 

không bị phá hoại dòn quá sớm và thực tế chỉ phù hợp với các công trình đơn giản, 

đều đặn, tƣơng đối cứng và có chiều cao vừa phải đƣợc xây dựng trong vùng có động 

đất yếu. 

- Mức dẻo trung bình (II): nhằm làm cho kết cấu có thể chịu đƣợc vài chu kỳ lặp 

lại hoặc đổi chiều với biến dạng đàn hồi có biên độ vừa phải. Áp dụng cho công trình 

đƣợc xây dựng trong vùng có động đất vừa. 

- Mức dẻo cao (III): nhằm làm cho kết cấu có khả năng phân tán năng lƣợng cao 

khi chịu nhiều chu kỳ dao động, biến dạng lớn có biên độ lớn. Do giá thành cao và 

những khó khăn khi thi công nên chỉ dùng trong các vùng có động đất mạnh. 

6.2. Các tiết diện tính toán và tổ hợp nội lực 

Trong nhà nhiều tầng tiết diện vách, lõi thƣờng thay đổi theo chiều cao nhà. Nội 

lực tăng dần từ trên xuống dƣới, lực dọc ở các tầng trên thƣờng tăng nhanh hơn mô 

men, còn ở phía dƣới thì ngƣợc lại mô men tăng nhanh hơn lực dọc. Bởi vậy đối với 

các tƣờng, lõi có tiết diện không đổi thƣờng chỉ phải kiểm tra một vài tiết diện ở tầng 

dƣới là đủ. Khi tiết diện thay đổi nhiều lần nhất thiết phải kiểm tra ở mỗi vị trí thay đổi 

đó. 

Các tiết diện ngang kiểm tra theo nén lệch tâm, các tiết diện thẳng đứng kiểm tra 

theo lực cắt tại các tiết diện ngang bị giảm yếu bởi các lỗ cửa cũng phải kiểm tra theo 

cắt và uốn. Tổng các lực nén dọc trong các phần tử, các nhánh (trong tƣờng, vách, lõi 

có lỗ) phải luôn luôn cân bằng với lực nén dọc trong từng hệ chịu lực. Trên mỗi tiết 

diện đang xét tại trọng tâm tiết diện còn có các mô men uốn do tải trọng thẳng đứng 

đặt lệch tâm Mx
d
, My

d
 và các mô men Mx

ng
, My

ng
 do tải trọng ngang tác động theo hai 

phƣơng. 

Nếu xét tới tác động theo hai phƣơng thì mỗi tiết diện cần đƣợc lần lƣợt kiểm tra 

theo các tổ hợp nội lực sau đây: 

- Tổ hợp nội lực với giá trị lực dọc Nmax và Mt.ư do tải trọng thẳng đứng; 

- Bốn tổ hợp nội lực với các giá trị mô men do tải trọng ngang gây ra bao gồm: 

(1) Mx
ng

 max và My
ng

 tƣơng ứng; 

(2) Cùng với giá trị tuyệt đối mô men nhƣ mục (1) nhƣng ngƣợc dấu; 

(3) My
ng

 max và Mx
ng

 tƣơng ứng; 

(4) Cùng với giá trị tuyệt đối mô men nhƣ mục (3) nhƣng ngƣợc dấu. 

Với bốn trƣờng hợp nêu trên đều kết hợp với các giá trị lực dọc Nmin tƣơng ứng 

(bao gồm các tải trọng tính toán tác động dài hạn và ngắn hạn). 

Trong tính toán có thể lấy: Nmin = 0,7N, trong đó N là tổng nội lực của các cấu 

kiện hợp thành kết cấu trong trạng thái giới hạn. 
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Đối với vách, lõi đối xứng hai trục và không có uốn xiên chỉ cần kiểm tra theo 

hai (cho tƣờng cứng phẳng) hay bốn (cho vách cứng nhiều cạnh và lõi cứng) tổ hợp 

nội lực. 

6.3. Kiểm tra các tiết diện ngang 

6.3.1. Tính toán cốt thép cấu kiện chịu nén lệch tâm xiên 

Cột là cấu kiện chịu nén lệch tâm xiên, tùy theo vị trí điểm đặt lực dọc cũng nhƣ 

tƣơng quan giữa các N, Mx và My với kích thƣớc tiết diện và việc bố trí cốt thép mà có 

thể xảy ra trƣờng hợp toàn bộ tiết diện chịu nén hay một phần chịu nén, một phần chịu 

kéo, có thể là một trong bốn dạng sau: 

 

Hình 6. 1. Các dạng vùng bê tông chịu nén. 

Việc tính toán tiết diện trong trƣờng hợp tổng quát (Hình 6.2) cần đƣợc tiến hành 

từ điều kiện cƣờng độ: 

 -b b si siM R S S    (6.1) 

0b b si siR A A N    (6.2) 

trong đó: dấu “cộng” trƣớc ngoặc đơn đƣợc lấy với trƣờng hợp kết cấu chịu nén lệch 

tâm và uốn, dấu “trừ“ đƣợc lấy đối với với trƣờng hợp kết cấu chịu kéo. 

M là trong cấu kiện chịu uốn: là hình chiếu của mô men do ngoại lực lên mặt 

phẳng vuông góc với đƣờng thẳng giới hạn vùng chịu nén của tiết diện, là trong cấu 

kiện chịu nén và kéo lệch tâm: là mô men do lực dọc N  đối với trục song song với 

đƣờng thẳng giới hạn vùng chịu nén và đi qua: 

 

x
o

x

x
o

x

x
o

x

x
o

x
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Hình 6. 2. Sơ đồ nội lực và biểu đồ ứng suất trên tiết diện thẳng góc với trục dọc cấu kiện bê 

tông cốt thép trong trƣờng hợp tổng quát tính toán tiết diện theo độ bền. 

+ Trọng tâm tiết diện các thanh cốt thép dọc chịu kéo nhiều nhất hoặc chịu nén ít 

nhất khi cấu kiện chịu nén lệch tâm; 

+ Điểm thuộc vùng chịu nén, nằm cách xa đƣờng thẳng giới hạn vùng chịu nén 

hơn cả khi cấu kiện chịu kéo lệch tâm; 

bS  là mô men tĩnh của diện tích tiết diện vùng bê tông chịu nén đối với các trục 

tƣơng ứng trong các trục nêu trên. Khi đó trong các cấu kiện chịu uốn vị trí của trục 

đƣợc lấy nhƣ trong trƣờng hợp cấu kiện chịu nén lệch tâm;  

siS  là mô men tĩnh của diện tích thanh cốt thép dọc thứ i đối với trục tƣơng ứng 

trong các trục nói trên; 

si  là ứng suất trong thanh cốt thép dọc thứ i đƣợc xác định theo: 

,
1

1
1,1

sc u

si spi

i

 
 

 

 
   

 

 
(6.3) 

Trong phƣơng trình (6.2) dấu "trừ" trƣớc giá trị N lấy đối với cấu kiện chịu nén 

lệch tâm, dấu "cộng" lấy đối với cấu kiện kéo lệch tâm. 

Hình dáng vùng bê tông chịu nén đƣợc xác định từ: điểm đặt của lực dọc, điểm 

đặt hợp lực của bê tông và cốt thép vùng nén, điểm đặt hợp lực của cốt thép chịu kéo 

phải nằm trên một đƣờng thẳng. Trong thực tế, tính toán để đạt đƣợc các điểm này 

thẳng hàng là rất khó, phải tính toán nhiều lần. 

Vì thế, trong thực hành tính toán thƣờng dùng cách tính gần đúng. 
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6.3.1.1. Phương pháp tính toán cốt thép dọc cột 

Nội lực để tính toán nén lệch tâm xiên đƣợc lấy từ kết quả tổ hợp trong đó cần 

chú ý các bộ ba nội lực nhƣ sau: 

- Có N lớn nhất và Mx, My tƣơng ứng; 

- Có Mx lớn nhất và N, My tƣơng ứng; 

- Có My lớn nhất và N, Mx tƣơng ứng; 

- Có Mx và My đều lớn và N tƣơng ứng; 

- Có độ lệch tâm e1x=Mx/N hoặc e1y=My/N lớn. 

Sử dụng phƣơng pháp gần đúng để tính toán cột nén lệch tâm xiên. Biến đổi 

trƣờng hợp nén lệch tâm xiên thành lệch tâm phẳng tƣơng đƣơng để tính với trình tự 

nhƣ sau: 

6.3.1.2. Tóm tắt việc tính toán cột tiết diện chữ nhật lệch tâm xiên theo phương 

pháp gần đúng 

Cốt thép đƣợc đặt theo chu vi, trong đó cốt thép đặt theo cạnh b có mật độ lớn 

hơn hoặc bằng mật độ theo cạnh b. 

 

- Điều kiện để áp dụng phƣơng pháp gần đúng là:0,5 2x

y

C

C
   , cốt thép đƣợc 

đặt theo chu vi. 

Tính độ lệch tâm theo mỗi phương: 

  

Tính độ lệch tâm ban đầu: với kết cấu siêu tĩnh 

0 1

0 1

max( , );

max( , ).

x x ax

y y ay

e e e

e e e




  

Cy

N

Mx

My

y

x

Cx

600

30
a

l
e

h
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trong đó: l – chiều cao cột; h – chiều cao tiết diện cột; 

1 1;   .
yx

x y

x x

MM
e e

N N
    

Mx – mô men theo phƣơng x; My – mô men theo phƣơng y. 

Tính hệ số uốn dọc theo từng phương 

Tính độ mảnh từng phƣơng: 

00 ;   .
yx

x y

x y

ll

i i
     

trong đó: chiều dài tính toán (theo phụ lục) l0x = 0,7l; l0y = 0,7l; l – chiều cao cột; 

ix, iy – bán kính quán tính của tiết diện cột theo phƣơng x, y. 

Xét ảnh hƣởng của uốn dọc theo từng phƣơng:  

+ khi độ mảnh theo từng phƣơng (x, y)   14 lấy  =1;  

+ khi độ mảnh theo từng phƣơng (x, y) > 14, tính hệ số ảnh hƣởng uốn dọc: 

1

1
cr

N

N

 



 
 

trong đó:   

Ncr - lực nén tới hạn tính theo công thức (TCVN 5574:2012) 

2

6,4 b
cr s

o l

E SI
N I

l




 
  

   

với:  l0 - chiều dài tính toán của cấu kiện; 

S - hệ số kể đến ảnh hƣởng của độ lệch tâm  

 

: hệ số xét đến ảnh hƣởng của cốt thép căng ứng lực trƣớc, với bê tông cốt thép 

thƣờng: . 

 

;
 

; (Rb tính bằng MPa) 

: hệ số kể đến ảnh hƣởng của tác dụng dài hạn của tải trọng đến độ cong của 

cấu kiện ở trạng thái giới hạn lấy bằng: 

1 1l
l

M

M
       

0,11
0,1

0,1 e

p

S




 



p

1p 

 0 minmax / ;e e h 
min 00,5 0,01 / 0,01 bl h R   

l
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  là hệ số phụ thuộc vào loại bê tông, lấy theo Bảng 29 (TCVN5574:2012); 

M là mô men lấy đối với biên chịu kéo hoặc chịu nén ít hơn cả của tiết diện do 

tác dụng của tải trọng thƣờng xuyên, tải trọng tạm thời dài hạn và tải trọng tạm thời 

ngắn hạn; 

Ml tƣơng tự M , nhƣng do tải trọng thƣờng xuyên và tải trọng tạm thời dài hạn; 

Nếu mô men uốn M (hoặc độ lệch tâm) do toàn bộ tải trọng và Ml do tổng của tải 

trọng thƣờng xuyên và tải trọng tạm thời dài hạn có dấu khác nhau thì l lấy nhƣ sau:

  

+ Khi giá trị tuyệt đối của độ lệch tâm do toàn bộ tải trọng |e0| > 0,1h: l =1; 

+ Khi |e0|  0,1h: l = l1+10(1- l1)e0/h, 

l1 đƣợc xác định theo công thức l với M  lấy bằng lực dọc N  (do tải trọng 

thƣờng xuyên, tạm thời dài hạn và tạm thời ngắn hạn gây ra) nhân với khoảng cách từ 

trọng tâm tiết diện đến cạnh bị kéo hoặc bị nén ít hơn cả do tải trọng thƣờng xuyên và 

tải trọng tạm thời dài hạn gây ra. 

Es, Eb: môđun đàn hồi của cốt thép, bêtông     

: mômen quán tính của tiết diện bêtông. 

Is : mômen quán tính của cốt thép. 

Do ban đầu chƣa biết As nên giả thiết trƣớc hàm lƣợng cốt thép t . 


   

 

Chú ý: Nếu t tính ra chênh lệch nhiều so với giả thiết thì giả thiết lại t và tính toán 

lại. 

- Mô men đã gia tăng Mx1; My1: 1 1;     x x x y y yM M M M   .   

- Tùy theo giá trị Mx1, My1 và Cx, Cy đƣa về tính nén lệch tâm phẳng theo 

phƣơng x hoặc phƣơng y. 

Mô hình Theo phƣơng x Theo phƣơng y 

Điều kiện 
11 yx

x y

MM

C C
  

1 1y x

y x

M M

C C
  

Ký hiệu 

1 1 2 1

;   

;   

0,2

x y

x y

a ax ay

h C b C

M M M M

e e e

 

 

 

 
1 1 2 1

;   

;   

0,2

y x

y x

a ay ax

h C b C

M M M M

e e e

 

 

 

 

eax; eay : độ lệch tâm ngẫu nhiêu theo hai phƣơng. 

- Giả thiết chiều dày a, tính h0 =h – a; Za = h -2a, chuẩn bị các số liệu Rb, Rs, 

Rsc, R nhƣ đối với trƣờng hợp nén lệch tâm phẳng. 

I

 
2

0 0,5s tI bh h a 
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- Tính toán theo trƣờng hợp đặt cốt thép đối xứng: 

1

b

N
x

R b
 . 

- Hệ số chuyển đổi m0: 

+ Khi x1  h0 thì 1
0

0

0,6
1

x
m

h
   ; 

+ Khi x1 > h0 thì 
0 0,4.m    

- Tính mô men tƣơng đƣơng (đổi lệch tâm xiên ra lệch tâm phẳng): 

1 0 2

b
M M m M

h
  . 

- Tiến hành tính toán cốt thép theo lệch tâm phẳng với cặp nội lực N, M, với 

kích thƣớc tiết diện bxh. 

- Độ lệch tâm tĩnh học (đã xét uốn dọc): 1

M
e

N
   

- Độ lệch tâm tính toán:   Với kết cấu siêu tĩnh e0 = max(e1, ea) 

            Với kết cấu tĩnh định e0 = e1 + ea. 

- Tính e: 0 0,5e e h a   . 

Dựa vào độ lệch tâm eo và giá trị x1 để phân biệt các trƣờng hợp tính toán. 

a) Trường hợp 1: nén lệch tâm rất bé khi 0.3  o

o

e

h
 tính toán gần nhƣ nén đúng 

tâm. 

- Hệ số ảnh hƣởng độ lệch tâm e: 

1

(0.5 )(2 )
e

 


 
 

+ Khi   14 lấy  =1; 

+ Khi  > 14 tính  theo công thức sau 

21,028 0,0000288 0,0016      

- Hệ số uốn dọc phụ thêm khi xét nén đúng tâm: 

(1 )

0,3
e

 
 


   

- Diện tích toàn bộ cốt thép dọc Ast: 

e
b

e
st

sc b

N
R bh

A
R R









. 
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b) Trường hợp 2: nén lệch tâm bé khi 0.3  o

o

e

h
 và x1 > Rh0.  

Xác định lại chiều cao vùng nén x với mức độ gần đúng: 

Phương án 1:  

   

   

21 0,48

21 0,48

a R oR

aR

n hn
x

n

  

 

  
 

 

trong đó:    ;  ;  a
a

b o o o

ZN e
n

R bh h h
     

Điều kiện của x: R o oh x h   , nếu ox h  thì lấy ox h ; nếu R ox h
 
thì lấy 

R ox h . 

Phương án 2: Giải phƣơng trình bậc 3 theo x 

3 2
2 1 0 0x a x a x a   

 

 

2
2 1

2
(2 ) ;   2 (1 )

2 (1 )

R o R o R o a
b

R R a o
o

b

Ne
a h a h h Z

R b

N e Z h
a

R b

  

 

      

  


  

Điều kiện của x: R o oh x h   , nếu ox h  thì lấy ox h .
 

Phương án 3:  

2

1

1 50

R
R o

o

x h





 
    

 

o
o

e

h
   

Tính diện toàn bộ cốt thép Ast tính theo công thức: 

0( / 2)

0,4

b
st

sc a

Ne R bx h x
A

R Z

 
 . 

Phương án 4:  

Dùng      đã tính đƣợc ở trên để tính gần đúng   
 , và ta đặt là   

 : 

  
  

 (  
  

 
   )

     

 

Sau khi tìm đƣợc giá trị   
  ta lấy      

    
  thay vào phƣơng trình sau ta 

tính đƣợc x ( R o oh x h   ): 
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[       
 (

 

  R
  )]   

      
     

 

  R

 

Tính diện toàn bộ cốt thép Ast tính theo công thức: 

0( / 2)

0,4

b
st

sc a

Ne R bx h x
A

R Z

 
  

c) Trường hợp 3: nén lệch tâm lớn khi 0.3o

o

e

h
   và x1  Rh0 

Tính diện toàn bộ cốt thép Ast tính theo công thức 

1 0( 0,5 )

0,4
st

s a

N e x h
A

R Z

 
 . 

- Chọn, bố trí cốt thép theo chu vi, trong đó cốt thép đặt theo cạnh b có mật độ 

lớn hơn hoặc bằng mật độ theo cạnh h. 

Sau khi đã tính đƣợc cốt thép theo phƣơng pháp gần đúng nhƣ trên, tiến hành 

đánh giá tính hợp lý của lƣợng cốt thép tính đƣợc bằng cách kiểm tra hàm lƣợng cốt 

thép hợp lý. Đối với cấu kiện cột, hàm lƣợng cốt thép hợp lý là: 1%  µ 3%. 

Đồng thời hàm lƣợng cốt thép của toàn bộ cốt thép dọc trong cột không vƣợt quá 

giá trị sau đây: 

- Với kết cấu thông thƣờng: µmax < 6%; 

- Khi xét tới động đất: µmax < 3,5%. 

Ví dụ 1: Cho tiết diện chữ nhật có các cạnh 60 cmxC  , 40 cmyC  ; chiều dài tính 

toán 0 0 4 mx yl l  . Lực nén tính toán 1250 kNN  ; 300 kNmxM  ; độ lệch tâm 

ngẫu nhiên 3 cmaxe  ;  150 kNmyM  ; 2 cmaye  . Bêtông có 13 MPabR  ; 

29000 MPabE  . Yêu cầu tính toán cốt thép có 260 MPas scR R  . Cột thuộc kết 

cấu tĩnh định. 

Giải quyết vấn đề 

 Chuẩn bị số liệu 

   0,60R   ; 0 400
23,15

0,288 60

x
x

x

l

i
   


 ; 

0 400
34,7

0,288 40

y

y

y

l

i
   


 

 max , 34,7x y      

  Xét uốn dọc 

23,15 14x    cần tính x   
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3
2 8 240 60

720000 cm 72 10  mm
12

xI


   
 

Tính gần đúng Ncr: 

8
5

cr, 2 2

0

2,5 2,5 29000 72 10
326,25 10  N 32625 kN

4000

b x
x

x

E I
N

l

  
       

cr,

1 1
1,04

1250
1 1

32625

x

x

N

N

   

 

  

34,7 14y    cần tính y  

3
2 8 240 60

320000 cm 32 10  mm
12

yI


     

8
5

, 2 2

0

2,5 2,5 29000 32 10
145 10  N 14500 kN

4000

b y

cr y

y

E I
N

l

  
       

,y

1 1
1,094

1250
1 1

14500

y

cr

N

N

   

 

  

1 1,04 300 311,9 kNmx x xM M     

1 1,094 150 164,1 kNmy y yM M     

1 311,9
520 kN

0,6

x

x

M

C
    

1 164,1
410 kN

0,4

y

y

M

C
   

 Có trƣờng hợp 
11 yx

x y

MM

C C
 . Tính theo phƣơng x. 

  600 mmxh C  ; 400 mmyb C   

 Giả thiết 50 mma  ; 0 550 mmh h a   ; 0 500 mmZ h a    

  1 1 311,9 kNmxM M  ; 2 1 160,2 kNmyM M   

 Độ lệch tâm ngẫu nhiên 0,2 30 0,2 20 34 mma ax aye e e        

  1 0

1250
240,4 mm 550 mm

13 400b

N
x h

R b
    


  

  0

0

0,6 0,6 240,4
1 1 0,738

550

x
m

h
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  1 0 2

600
311,9 0,738 164,1 493,6 kNm

400

h
M M m M

b
         

  1

493,6
0,395 m = 395 mm

1250

M
e

N
     

 Với kết cấu tĩnh định: 

  0 1 395 34 429 mmae e e       

  0

0

429
0,78 0,3

550

e

h
       

  0 0,6 550 330 mmRh      

 1 0240,4 mm Rx h  . Tính theo trƣờng hợp nén lệch tâm lớn: 

  0

600
429 50 679 mm

2 2

h
e e a         

 
   1 0 2

0,5 1250 1000 679 0,5 240,4 550
5990 mm

0,4 0,4 260 500
st

s

N e x h
A

R Z

     
  

 
  

 Hàm lƣợng cốt thép 
5990

0,025 2,5%
600 400

s   


  

 Chọn 16  22 có 26080 mmsA    

 

Bố trí cốt thép cột trên mặt cắt ngang của ví dụ 1. 

 Kiểm tra: Chọn lớp bảo vệ 30 mmbva  ; 
22

30 41 mm
2 2

bva a


       

 0 600 41 559 mm 550 mmh      đã dùng để tính toán. 

Ví dụ 2: Với kích thƣớc và vật liệu nhƣ ví dụ 1, yêu cầu tính cốt thép chịu bộ ba nội 

lực gồm 2350 kNN  ; 142 kNmxM  ; 120 kNmyM  . Cột thuộc kết cấu siêu tĩnh. 

Giải quyết vấn đề: 

 Chuẩn bị số liệu: 















a150


a150


a150


a150
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   60 cmxC  ; 40 cmyC  ; 0 0 4 mx yl l   

13 MPabR  ; 29000 MPabE  ; 260 MPas scR R  ; 0,60R    

  23,15x  ; 34,7y  ; 34,7    

 Xét uốn dọc: 

23,15 14x    cần tính x   

3
2 8 240 60

720000 cm 72 10  mm
12

xI


     

8
5

, 2 2

0

2,5 2,5 29000 72 10
326,25 10  N 32625 kN

4000

b x
cr x

x

E I
N

l

  
       

,

1 1
1,078

2350
1 1

32625

x

cr x

N

N

   

 

  

34,7 14y    cần tính y  

3
2 8 240 60

320000 cm 32 10  mm
12

yI


     

8
5

, 2 2

0

2,5 2,5 29000 32 10
145 10  N 4500 kN

4000

b y

cr y

y

E I
N

l

  
       

,

1 1
1,193

2350
1 1

14500

y

cr x

N

N

   

 

  

1 1,078 142 153,1 kNmx x xM M     

1 1,193 120 143,2 kNmy y yM M     

1 153,1
255 kN

0,6

x

x

M

C
    

1 143,2
358 kN

0,4

y

y

M

C
   

 Có trƣờng hợp 
11 yx

x y

MM

C C
 . Tính theo phƣơng y. 

  400 mmyh C  ; 600 mmxb C   

 Giả thiết 45 mma  ; 0 355 mmh h a   ; 0 310 mmZ h a    

  1 1 143,2 kNmyM M  ; 2 1 153,1 kNmxM M   

 Độ lệch tâm ngẫu nhiên 0,2 20 0,2 30 26 mma ay axe e e        
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  1 0

2350
301,3 mm 550 mm

13 400b

N
x h

R b
    


  

  0

0

0,6 0,6 301,3
1 1 0,491

355

x
m

h


       

  1 0 2

600
143,2 0,491 153,1 193,3 kNm

400

h
M M m M

b
         

  1

193,3
0,0823 m = 82,3 mm

2350

M
e

N
     

 Với kết cấu siêu tĩnh: 

   0 1max , 82,3 mmae e e    

  0

0

82,3
0,232 0,3

355

e

h
       

  0 0,6 355 213 mmRh      

  1 0301,3 mm Rx h   

Trường hợp 1: Tính theo trƣờng hợp nén lệch tâm rất bé (tính gần đúng nhƣ nén 

đúng tâm) 

  
     

1 1
1,672

0,5 2 0,5 0,232 2 0,232
e

 
  

   
  

2

2

1,028 0,0000288 0,0016

   1,028 0,0000288 34,7 0,0016 34,7 0,938

    

     
  

   1 1 0,938 0,232
0,938 0,986

0,3 0,3
e

 
 

  
       

  0

600
82,3 50 337,3 mm

2 2

h
e e a         

 
2

1

1,672 2350
13 600 400

0,986
3502 mm

260 13

e
b

e
st

s b

N
R bh

A
R R






   

  
 

  

 Hàm lƣợng cốt thép 
3502

0,025 2,5%
600 400

s   


  

 Trường hợp 2: Tính theo trƣờng hợp nén lệch tâm bé  

  0
0

82,3
0,206

400

e

h
      

  
   

2 2

0

1 1 0,6
0,6 258,5 mm

1 50 1 50 0,206

R

Rx
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0

2

2

/ 2

0,4

2350 1000 337,3 13 600 258,5 355 258,5 / 2
   10468 mm

0,4 260 310

b

st

sc

Ne R bx h x
A

R Z

 


      
 

 

 

 Chênh lệch kết quả trong 2 trƣờng hợp: 2 1

1

100 199%st st
st

st

A A
A

A


      

 Nhận xét: Kết quả diện tích cốt thép tính toán trong hai trƣờng hợp chênh lệch 

lớn. Nhận thấy 1 0301,3 mm Rx h   và 0,3   do đó, ta nên sử dụng phƣơng án 1 

có 23502 mmstA   

Chọn 12   20 có 23768 mmsA   

 

Bố trí cốt thép cột trên mặt cắt ngang của ví dụ 2. 

Ví dụ 3: Cho 800 mmxC  , 600 mmyC  ; 0 0 3600 mmx yl l  ; 9 MPabR  ; 

23000 MPabE  ; 340 MPas scR R  ; 2750kNN  ; 560 kNmxM  ; 

330 kNmyM  ; 35 mmaxe  . Yêu cầu tính toán cốt thép. Cột thuộc kết cấu siêu tĩnh. 

Giải quyết vấn đề: 

 Chuẩn bị số liệu: 

   0,56R    

  0 3600
15,6

0,288 800

x
x

x

l

i
   


  

0 3600
20,8

0,288 600

y

y

y

l

i
   


 

 max , 20,8x y      

 Xét uốn dọc: 

15,6 14x    cần tính x   









a150


a150


a150
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3
8 2600 800

256 10  mm
12

xI


    

8
3

, 2 2

0

2,5 2,5 23000 256 10
113580,25 10  N 113580,25 kN

3600

b x
cr x

x

E I
N

l

  
       

,

1 1
1,025

2700
1 1

113580,25

x

cr x

N

N

   

 

  

20,8 14y    cần tính y  

3
8 2600 800

144 10  mm
12

yI


    

8
3

,y 2 2

0

2,5 2,5 23000 144 10
63888,89 10  N 63888,89 kN

3600

b y

cr

y

E I
N

l

  
       

,

1 1
1,045

2700
1 1

63888,89

y

cr y

N

N

   

 

  

1 1,025 560 574 kNmx x xM M     

1 1,045 330 344,9 kNmy y yM M     

1 574
718 kN

0,8

x

x

M

C
    

1 344,9
575 kN

0,6

y

y

M

C
   

 Có trƣờng hợp 
11 yx

x y

MM

C C
 . Tính theo phƣơng x. 

  800 mmxh C  ; 600 mmyb C   

 Giả thiết 40 mma  ; 0 760 mmh h a   ; 0 720 mmZ h a    

  1 1 574 kNmxM M  ; 2 1 344,9 kNmyM M   

 Độ lệch tâm ngẫu nhiên 0,2 35 0,2 25 40 mma ay axe e e        

  1 0

2700
509,3 mm 760 mm

9 400b

N
x h

R b
    


  

  0

0

0,6 0,6 509,3
1 1 0,598

760

x
m

h


       

  1 0 2

800
574 0,598 344,9 849 kNm

600

h
M M m M

b
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  1

849
0,309m = 309 mm

2700

M
e

N
     

 Với kết cấu siêu tĩnh: 

   0 1max , 309 mmae e e    

  0

0

309
0,406 0,3

760

e

h
       

  0 0,56 760 456 mmRh      

  1 0509,3 mm Rx h   

Tính theo trƣờng hợp nén lệch tâm bé  

  0
0

309
0,386

800

e

h
      

  
   

2 2

0

1 1 0,56
0,56 492 mm

1 50 1 50 0,386

R

Rx





    
       

     
 

0

800
309 40 668,7 mm

2 2

h
e e a         

 

 

 

0

2

/ 2

0,4

2700 1000 668,7 9 600 492 760 492 / 2
   4834 mm

0,4 340 720

b

st

sc

Ne R bx h x
A

R Z

 


      
 

 

 

4834
1,06%

800 600
s  


 

 Chọn 1620 có 25024 mmsA  . Chọn 416 làm cốt cấu tạo. 

 

Bố trí cốt thép cột trên mặt cắt ngang của ví dụ 3. 
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6.3.2. Tính toán cốt đai cột (TCVN 5574:2012) 

Cốt đai trong cấu kiện chịu nén lệch tâm trình tự tính toán giống nhƣ đối với 

dầm, nhƣng xét trƣờng hợp tính toán đơn giản hơn. 

Cấu kiện bê tông cốt thép chịu tác dụng của lực cắt cần đƣợc tính toán để đảm 

bảo độ bền trên dải nghiêng giữa các vết nứt xiên theo điều kiện: 

1 1 00,3 w b bQ R bh   (6.4) 

Hệ số 1w , xét đến ảnh hƣởng của cốt thép đai vuông góc với trục dọc cấu kiện, 

đƣợc xác định theo công thức:  

1 1 5 1,3w w      (6.5) 

trong đó:  ,s sw
w

b

E A

E bs
   . 

Hệ số 1b  đƣợc xác định theo công thức: 

1 1b bR    (6.6) 

trong đó:  

β là hệ số, lấy nhƣ sau: đối với bê tông nặng, bê tông hạt nhỏ, bê tông tổ ong: 

0,01; đối với bê tông nhẹ: 0,02 

Rb tính bằng megapascan (MPa). 

Đối với cấu kiện cột bê tông cốt thép có cốt thép ngang chịu lực cắt, để đảm bảo độ 

bền theo vết nứt xiên cần tính toán với tiết diện nghiêng nguy hiểm nhất theo điều 

kiện: 

b swQ Q Q   (6.7) 

Lực cắt Q trong công thức (75) đƣợc xác định từ ngoại lực đặt ở một phía của tiết 

diện nghiêng đang xét. 

Lực cắt Qb do riêng bê tông chịu, đƣợc xác định theo công thức: 

  2

2 01b n bt

b

R bh
Q

c

 
  (6.8) 

trong đó: c là chiều dài hình chiếu của tiết diện nghiêng nguy hiểm nhất lên trục dọc 

cấu kiện. 

Hệ số b2 xét đến ảnh hƣởng của loại bê tông đƣợc lấy nhƣ sau: đối với bê tông 

nặng và bê tông tổ ong: 2,0; đối với bê tông hạt nhỏ: 1,7. 

Hệ số n, xét đến ảnh hƣởng lực dọc, đƣợc xác định nhƣ sau: 

khi chịu lực nén dọc, xác định theo công thức:  

0

0,1 0,5n

bt

N

R bh
    (6.9) 
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Giá trị bQ  tính theo công thức (76) lấy không nhỏ hơn  3 01b n btR bh  . 

Hệ số 
3b  lấy nhƣ sau: đối với bê tông nặng và bê tông tổ ong: 0,6; đối với 

bêtông hạt nhỏ: 0,5. 

Đối với cấu kiện bê tông cốt thép có cốt thép ngang cũng cần đảm bảo độ bền 

theo tiết diện nghiêng trong khoảng giữa các cốt thép đai, giữa gối và cốt thép xiên, 

giữa các cốt thép xiên với nhau. 

Lực cắt swQ  đƣợc xác định bằng tổng hình chiếu của các nội lực tới hạn tƣơng 

ứng trong cốt thép đai và cốt thép xiên cắt qua vết nứt xiên nguy hiểm lên trục vuông 

góc với trục dọc cấu kiện.  

Chiều dài c0 của hình chiếu vết nứt xiên nguy hiểm lên trục dọc cấu kiện đƣợc 

xác định từ điều kiện cực tiểu của biểu thức  b swQ Q . Trong công thức xác định Qb 

thay giá trị c bằng c0, giá trị c0 lấy không lớn hơn 0h2  và không lớn hơn giá trị c, đồng 

thời c0 không nhỏ hơn 0h2  nếu c > h0. 

Đối với cấu kiện chỉ đặt cốt thép đai thẳng góc với trục dọc cấu kiện, có bƣớc 

không đổi trong khoảng tiết diện nghiêng đang xét, giá trị c0 ứng với cực tiểu của biểu 

thức  b swQ Q  xác định theo công thức: 

  2

2 0

0

1b n bt

sw

R bh
c

q

 
  (6.10) 

trong đó: qsw là nội lực trong cốt thép đai trên một đơn vị chiều dài cấu kiện, đƣợc xác 

định theo công thức: 

sw sw
sw

R A
q

s
  (6.11) 

Đối với các cấu kiện nhƣ vậy, lực cắt Qsw đƣợc xác định theo công thức: 

sw sw oQ q c  (6.12) 

Khi đó, cốt thép đai xác định theo tính toán phải thoả mãn điều kiện: 

 3 1

2

b n bt

sw

R b
q

 
  (6.13) 

Đối với cấu kiện bê tông cốt thép không có cốt thép đai chịu lực cắt, để đảm bảo độ 

bền trên vết nứt xiên cần tính toán đối với vết nứt xiên nguy hiểm nhất theo điều kiện: 

  2

4 01b n btR bh
Q

c

 
  (6.14) 

Trong đó: vế phải của công thức (6.20) lấy không lớn hơn 02,5 bR bh  và không 

nhỏ hơn  3 01b n btR bh  . 
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Hệ số 
4b  lấy nhƣ sau: đối với bê tông nặng, bê tông tổ ong: 1,5; đối với bê tông 

hạt nhỏ: 1,2 

Tóm tắt tính cốt đai cột: 

- Chọn đƣờng kính cốt đai:  

.max

8

4

sw s

mm

 




 



. 

trong đó: s.max – đƣờng kính lớn nhất của cốt dọc; 

       s.min – đƣờng kính lớn nhất của cốt dọc; 

- Chọn số nhánh cốt đai n. 

- Tính Asw: 
2 / 4sw swA n . 

- Tính khoảng cách cốt đai tính toán stt: 

 2

2 02
4 (1 )sw sw

tt b n bt

R A
s R bh

Q
   . 

- Tính khoảng cách cốt đai lớn nhất smax: 

  2

4 0

max

1b n btR bh
s

Q

 
  

- Chọn khoảng cách cốt đai thiết kế stk: stk  (stt, smax, sct). 

- Kiểm tra: 

+ Đồng thời, cốt thép đai xác định theo tính toán phải thoả mãn điều kiện (để 

tránh phá hoại dòn, cốt đai phải chịu đƣợc lực cắt không ít hơn khả năng chịu cắt tối 

thiểu của bê tông): 

 3 1

2

b n bt

sw

R b
q

 
  

trong đó: qsw là nội lực trong cốt thép đai trên một đơn vị chiều dài cấu kiện, đƣợc xác 

định theo công thức: 

sw sw
sw

R A
q

s
  

+ Kiểm tra việc đảm bảo độ bền trên dải nghiêng giữa các vết nứt xiên theo điều 

kiện: 

1 1 00,3 w b bQ R bh  . 

Chú ý: Cần phải bố trí cốt đai phụ trong các cột có tiết diện lớn. 
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Hình 6. 3. Bố trí cốt thép cột (cốt dọc, cốt đai) 

coát giaù

coát ñai phuï coát ñai phuï coát giaù

h 500

b

4

0
0

h 500
b

4

0
0

h 500

b

4

0
0

1000<h 00

b

4

0
0

500

5
0
0

1000

1
4
0
0
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6.3.3. Lập biểu đồ tương tác 

 Khái niệm biểu đồ tƣơng tác: với một tiết diện đã bố trí cốt thép, biểu đồ tƣơng 

tác là một mặt cong thể hiện mối liên hệ giữa lực dọc N và mô men M tƣơng ứng của 

trạng thái giới hạn. 

Tƣơng tác ở đây là tƣơng tác giữa khả năng chịu mô men uốn M và khả năng 

chịu lực nén N. 

Với một tiết diện đã có cốt thép, biểu đồ tƣơng tác là một mặt cong (phẳng – nén 

lệch tâm phẳng, không gian – nén lệch tâm xiên), thể hiện khả năng chịu lực của tiết 

diện với mọi giá trị của M và N. 

Các giả thiết cơ bản: 

Tiết diện cột đƣợc giả thiết nhƣ sau: tiết diện phẳng trƣớc khi chịu lực và sau khi 

chịu lực. Có thể tính toán đƣợc biến dạng tại một điểm bất kỳ trên tiết diện theo biến 

dạng lớn nhất của bê tông vùng nén và cốt thép trong vùng kéo hoặc nén ít. 

Bỏ qua sự làm việc của bê tông chịu kéo. 

Giả thiết về quan hệ giữa ứng suất và biến dạng của cốt thép, của bê tông. 

Giả thiết về biểu đồ ứng suất bê tông vùng nén và bê tông vùng nén quy đổi. 

Giả thiết về biến dạng cực hạn quy ƣớc của bê tông vùng nén. 

- Thiết lập biểu đồ tƣơng tác: 

+ Nguyên tác chung: dựa vào biến dạng cực hạn của bê tông vùng nén và vị trí 

của trục trung hòa đƣợc thể hiện quả chiều cao vùng nén x, ta có thể xác định đƣợc 

trạng thái ứng suất trong bê tông và cốt thép trong cột, các ứng suất này tổng hợp lại 

thành một lực dọc và một mô men tại trọng tâm hình học của cột. 

+ Các điểm chính trên biểu đồ tƣơng tác: vì biểu đồ tƣơng tác là một đƣơng 

cong, mỗi điểm trên đƣờng cong này tƣơng ứng với một vị trí của trục trung hòa trên 

tiết diện cột (một giá trị của x), vì vậy việc thiết lập biểu đồ này thƣờng dựa vào biến 

xố trung gian là x. 

-  Sau khi lập đƣợc biểu đồ tƣơng tác, tiến hành kiểm tra theo các trƣờng hợp sau: 

+ Trường hợp 1: lực nén đƣợc xem là khá lớn khi thỏa mãn điều kiện

0,5 b x yN R C C . Có thể xem là trƣờng hợp nén lệch tâm bé, cần kiểm tra lại khả năng 

chịu lực nén. 

Khả năng chịu lực nén là Ngh đƣợc xác định từ phƣơng trình: 

0

1 1 1 1

gh x yN N N N
    

trong đó: N0 – khả năng chịu nén đúng tâm, xác định nhƣ sau: 

0 ( )b s stN R A R A    

Nx – khả năng chịu nén trƣờng hợp lệch tâm phẳng khi tính toán theo phƣơng x. 
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Hình 6. 4. Sơ đồ phân bố ứng suất trong cấu kiện nén lệch tâm tính theo biến dạng. 

 

Hình 6. 5. Mặt biểu đồ tƣơng tác cột nén lệch tâm xiên. 

Tính Nx theo giá trị đã biết của Mx1 hoặc xeox. 
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Ny – khả năng chịu nén trƣờng hợp lệch tâm phẳng khi tính toán theo phƣơng y. 

Tính Ny theo giá trị đã biết của My1 hoặc ye0y. 

+ Trường hợp 2: trƣờng hợp mô men lớn (lực nén bé) 

Với một tiết diện cho trƣớc kiểm tra khả năng chịu lực khi lực nén là tƣơng đối 

bé (N < 0,5RbAb) mô men tƣơng đối lớn thì cần kiểm tra theo điều kiện: 

* *
1

nn

y oyx ox

ox oy

N eN e

M M




  
      
   

 

trong  đó: 
*

oxM , 
*

oyM là khả năng chịu mô men uốn đƣợc xác định theo trƣờng hợp nén 

lệch tâm phẳng theo hai phƣơng x và y ứng với lực nén N. 

Khi đã có biểu đồ tƣơng tác của nén lệch tâm phẳng theo hai phƣơng x và y thì 

việc xác định 
*

oxM , 
*

oyM là dễ dàng từ giá trị N. 

Số mũ n trong điều kiện trên là 1< n 2. Tiêu chuẩn thiết kế của một số nƣớc lấy 

n theo công thức thực nghiệm sau: 

0,5

0

0

5N N
n

N N

 
  

 
 

Cách bố trí cốt thép có hiệu quả: với nén lệch tâm xiên cốt thép sẽ phát huy 

hiệu quả khi đƣợc đặt tập trung vào các góc. Khi tính toán, để giảm bớt sự phức tạp có 

thể xem cốt thép đƣợc đặt với khoảng cách đều trong từng phƣơng và đƣờng kính 

giống nhau. Tuy vậy khi đã có diện tích Ast, nếu đƣợc thì nên đặt cốt thép tập trung ở 

các góc với khoảng cách bé nhất hoặc với những thanh có đƣờng kính lớn hơn. Làm 

vậy sẽ tăng đƣợc khả năng chịu lực của tiết diện. 

6.3.4. Tính toán vách cứng 

6.3.4.1. Đặc trưng của vách cứng 

(1) Định nghĩa: vách bê tông cốt thép là cấu kiện kiểu “sàn đứng”, chỉ chịu các 

lực tác dụng trong mặt phẳng vách (in-plane loads), chiều dài vách tối thiểu bằng 4 lần 

chiều dày (L > 6b) và 1/3 lần chiều cao (L ≥ Hw/3).  

(2) Vách cứng thƣờng đƣợc dùng để chống lực ngang trong công trình nhà cao 

tầng bê tông cốt thép. Tên chính xác nên gọi là vách chịu lực (Structural walls). 
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Hình 6. 6. Hình dạng vách cứng 

a) Vách cứng dạng phẳng    b) Vách cứng dạng hộp. 

Nên tránh bố trí vách cứng bất thƣờng (irregularity) cả theo chiều cao công trình 

và mặt bằng nhằm tránh tác động xoắn lớn lên tổng thể công trình nhƣ các ví dụ dƣới 

đây: 

 

a) Công trình dạng không đều theo phƣơng đứng (vertical irregularity). 

           

b) Công trình dạng không đều theo mặt bằng: phƣơng án thiết kế không tốt. 

        

 

c) Công trình dạng đều theo mặt bằng: phƣơng án thiết kế tốt. 

Hình 6. 7. Cách bố trí vách cứng theo chiều cao công trình và mặt bằng. 

(3) Phân loại vách cứng: 

Phân loại vách cứng theo chiều cao: vách cứng thƣờng đƣợc phân loại theo 

kích thƣớc hình học nhƣ sau:  
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- Vách cao - Flexural walls (Hw/L  2): thiết kế chống uốn là ƣu tiên do tỷ số M/Q 

lớn); 

- Vách thấp - Squat walls (0,33 < Hw/L < 1-2): thiết kế chống cắt là ƣu tiên do 

M/Q nhỏ); 

- Vách đôi có dầm nối - Coupled walls; 

- Vách khoét lỗ - Punched walls. 

 

         a)  Vách cao     b) Vách thấp              c) Vách đôi        d) Vách khoét lỗ  

Hình 6. 8. Phân loại vách cứng theo chiều cao. 

Phân loại vách cứng theo công năng: vách cứng đƣợc phân loại theo vị trí và 

công năng trong công trình. Ba chức năng thông dụng của vách cứng bê tông cốt thép 

là:  

- Hệ kết cấu vách chịu lực phƣơng đứng (Bearing walls): vách chịu gần nhƣ toàn 

bộ tải trọng đứng. Thƣờng gặp trong công trình nhà ở vì vách đƣợc sử dụng nhƣ các 

tƣờng ngăn các căn hộ. 

- Hệ kết cấu khung - giằng (hệ khung + vách cứng) (Frame walls, dual system): 

vách cứng chủ yếu chịu tải trọng ngang và một phần tải trọng đứng, hệ khung chịu 

phần lớn tải trọng đứng. 

- Hệ kết cấu lõi cứng (Core walls): vách cứng bao quanh hệ thống thang máy vận 

chuyển đứng. 
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Hình 6. 9. Bố trí vách cứng trên mặt bằng công trình. 

(4) Ứng xử hệ khung-giằng (Frame-Wall Interaction) 

 

Hình 6. 10. Ứng xử hệ khung vách. 

- Biến dạng khung: biến dạng cắt chiếm ƣu thế; khả năng chịu tải ngang là do độ 

cứng các nút khung. 

- Biến dạng vách cứng: cơ bản là biến dạng uốn; biến dạng cắt hầu nhƣ không 

đáng kể; chỉ có ở trƣờng hợp vách rất thấp (0,33 < Hw/L < 1) thì kiểu phá hủy là biến 

dạng cắt. Vách ứng xử nhƣ một công xôn dài (slender cantilever). 
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Các nhận xét then chốt: 

- Nhìn chung vách cứng trong hệ kết cấu nhà cao tầng chịu chủ yếu bị biến dạng 

uốn; 

- Các giả thuyết bỏ qua sự chịu tải trọng ngang của khung có thể dẫn đến kết quả 

sai sót lớn; 

- Hệ kết cấu liên hợp khung + vách dẫn đến phƣơng án thiết kế kinh tế hơn; 

- Vách cứng nên đƣợc thiết kế vách cứng chống cả lực dọc + lực gây uốn + lực 

cắt; 

- Sơ đồ bố trí mặt bằng các vách cứng là rất quan trọng cả cho các loại tải trọng 

đứng và ngang. 

                     

 

Hình 6. 11. Mô hình cấu tạo hệ chịu lực của kết cấu nhà. 

Kết luận: 

 Hệ khung - giằng (frame wall) nhƣ Hình 6.14 là hệ chịu lực hiệu quả và đƣợc 

ƣa thích trong thiết kế công trình chống động đất ở Mỹ và Nhật vì nó cung cấp một 

mức độ siêu tĩnh cao. Một ƣu điểm của hệ khung - giằng là vách cứng dùng để ngăn 

cản dạng “dầm yếu” hình thành trong khung bê tông cốt thép, điều này có nghĩa là về 

mặt lý thuyết có thể nới lỏng yêu cầu khung bê tông cốt thép là “cột cứng - dầm yếu” 

(xem Hình 6.14a), do đó ngƣời thiết kế có thể tự do hơn để lựa chọn kích thƣớc dầm 

và cột.  
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Hệ khung - giằng đƣợc sử dụng phổ biến trong nhà thấp tầng và nhà cao trung 

bình (H < 75m) có vách cứng bố trí ở trung tâm (core wall).  

Vách cao bê tông cốt thép (Hw/L > 2) thiết kế dẻo vừa có thể tạo thành khớp dẻo 

uốn tại đáy móng với ứng xử dẻo gần bằng hệ khung bê tông cốt thép thiết kế dẻo cao. 

Vách cứng có tiết diện ngang L >> 4b, do đó không dùng đƣợc các phƣơng pháp 

tính cốt thép của cột L  4b chịu nén lệch tâm.  

Một hệ vách, lõi thƣờng bao gồm các thành phần nội lực: lực dọc N,  mô men 

uốn trong mặt phẳng thẳng đứng song song với trục x là Mx, mô men uốn trong mặt 

phẳng thẳng đứng song song với trục y là My, lực cắt theo phƣơng x là Qx, lực cắt theo 

phƣơng y là Qy (xem Hình 6.15). Trong thực tế thiết kế, chúng ta thƣờng tách vách có 

cạnh dài theo phƣơng x sẽ chịu các thành phần nội lực: N, Mx, Qx (Hình 6.15b, bỏ qua 

các thành phần nội lực My, Qy, vì nhỏ), còn vách có cạnh dài theo phƣơng y sẽ chịu các 

thành phần nội lực: N, My, Qy. 

 

Hình 6. 12. Các thành phần nội lực trong vách. 

Việc tính toán tác động đồng thời của cả mô men và lực cắt rất phức tạp và khó 

thực hiện đƣợc. Đến nay trong các tiêu chuẩn thiết kế vẫn tách riêng việc tính toán cốt 

dọc và cốt đai. Hiện nay việc tính toán cốt dọc của vách cứng có thể đƣợc tính toán 

nhiều phƣơng pháp, nhƣng phổ biến là theo 4 phƣơng pháp sau: 

(1) Phƣơng pháp phân bố ứng suất đàn hồi; 

(2) Phƣơng pháp giả thiết vùng biên chịu mô men; 

(3) Phƣơng pháp xây dựng biểu đồ tƣơng tác; 

(4) Phƣơng pháp kiểm tra khả năng chịu lực cho vách cứng. 
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y My
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Q x
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6.3.4.2. Phương pháp phân bố ứng suất đàn hồi 

Mô hình tính toán: phƣơng pháp này chia vách thành những phần tử nhỏ, xem 

mỗi phần tử nhƣ cấu kiện chịu nén (kéo) đúng tâm, coi nhƣ ứng suất phân bố đều 

trong mỗi phần tử.  

Giả thiết cơ bản: 

- Vật liệu làm việc ở giai đoạn đàn hồi; 

- Ứng suất kéo do cốt thép chịu; 

- Ứng suất nén do cả bê tông và cốt théo chịu. 

 

Hình 6. 13. Phân chia vách để tính theo phƣơng pháp ứng suất đàn hồi; 

a) Sơ đồ lực tác dụng; b) Phân chia các vùng trên tiết diện vách; 

c) Ứng suất do lực dọc N; d) Ứng suất do mô men M. 

Các bước tính toán: 

Bước 1: Chia vách thành các phần tử nhỏ với kích thƣớc ba, với a  b và  

0,5L, a càng nhỏ thì độ chính xác càng cao. Nên chia vách thành 5 vùng bằng nhau, 

tiết diện mỗi vùng: b0,2L. 

Bước 2: Xác định lực dọc tác dụng vào mỗi phần tử do lực dọc N và mô men 

trong mặt phẳng M gây ra: 

- Ứng suất trung bình (kéo, nén) của mỗi vùng là: 

1 2 3 4 5

N

M

y
2

y
1

y
4

y
5
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b

L

L/2 L/2
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i i

N M
y

A I
    (6.15) 

Trong đó: A = bL; I = bL
3
/12; yi là khoảng cách từ tâm phần tử thứ i đến trục 

chính trung tâm. 

- Lực dọc kéo (nén) tác dụng vào phần tử thứ i: 

0,2i iN b L      (6.16) 

Bước 3: Tính toán diện tích cốt thép chịu nén, kéo: 

Cốt thép từng vùng phần tử tính nhƣ cấu kiện chịu nén (kéo) đúng tâm. 

- Nếu Ni > 0 thì vùng phần tử chịu nén, diện tích cốt thép tính toán theo: 

( / 0,2 )i b
si

sw b

N R bL
A

R R

 



 (6.17) 

- Nếu Ni < 0 thì vùng phần tử chịu kéo, diện tích cốt thép tính toán theo: 

i
si

s

N
A

R
  (6.18) 

Bƣớc 4: Kiểm tra hàm lƣợng cốt thép và bố trí cốt thép. 

6.3.4.3. Phương pháp giả thiết vùng biên chịu mô men 

 

Hình 6. 14. Phân chia vách để tính theo phƣơng pháp vùng biên chịu mô men. 

Mô hình tính toán: phƣơng pháp vùng biên chịu mô men cho rằng cốt thép đặt 

trong vùng biên ở hai đầu vách chịu toàn bộ mô men. Mô men tƣơng đƣơng một cặp 
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ngẫu lực đặt tại hai vùng biên của vách. Lực dọc giả thiết là phân bố đều trên toàn bộ 

chiều dài mặt cắt ngang của vách. 

Giả thiết cơ bản: 

- Vật liệu làm việc ở giai đoạn đàn hồi; 

- Ứng suất kéo do cốt thép chịu; 

- Ứng suất nén do cả bê tông và cốt théo chịu. 

Các bước tính toán: 

Bước 1: Giả thiết chiều dài vùng biên Bt, Bp chiu mô men (Bt, Bp =0,2L). Mô 

men M tƣơng đƣơng một cắt ngẫu lực đặt ở hai vùng biên của vách. 

Bước 2: Xác định lực kéo, nén trong vùng biên của vách: 

, ,
( 0,5 0,5 )

t p t p

t p

N M
P A

A L B B
 

 
 (6.19) 

trong đó: At,p là diện tích tiết diện ngang vùng biên bên trái, bên phải của vách (At,p = 

Bt,pb); 

A là diện tích tiết diện ngang toàn bộ vách, A = bL; 

Pt,p là lực kéo hoặc nén ở vùng biên bên trái hoặc bên phải. 

Bước 3: Tính cốt thép chịu kéo, nén, xem mỗi đoạn vách nhƣ cấu kiện nén 

hoặc kéo đúng tâm. 

- Nếu Pp > 0 thì vùng biên chịu nén, diện tích cốt thép tính toán theo: 

,

( / 0,2 )p b

s p

sw b

P R bL
A

R R

 



 (6.20) 

- Nếu Pt < 0 thì vùng biên chịu kéo, diện tích cốt thép tính toán theo: 

,
t

s t

s

P
A

R
  (6.21) 

Bước 4: Kiểm tra hàm lƣợng cốt thép và bố trí cốt thép 

Kiểm tra hàm lƣợng cốt thép, nếu không thỏa mãn thì tăng kích thƣớc Bt, Bp lên 

rồi tính lại.  

Bước 5: Kiểm tra phần vách còn lại giữa hai vùng biên nhƣ đối với cấu kiện 

chịu nén đúng tâm. Lực dọc tác dụng lên vùng bụng vách đƣợc xác định theo công 

thức: 

( )b t p

N
P A A A

A
    (6.22) 

Trƣờng hợp bê tông đã đủ khả năng chịu lực thì cốt thép trong vùng này đƣợc 

đặt theo cấu tạo. 
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Phƣơng pháp giả thiết vùng biên chịu mô men tƣơng tự nhƣ phƣơng pháp phân 

bố ứng suất đàn hồi, chỉ khác ở chỗ bố trí tập trung lƣợng cốt thép chịu toàn bộ mô 

men ở hai đầu vách. Phƣơng pháp này thích hợp với các trƣờng hợp vách có tiết diện 

tăng cƣờng ở hai đầu. 

Ví dụ: Cho một vách cứng kích thƣớc nhƣ Hình vẽ: 

Chiều dài vách: L=1800 mm; Chiều cao vách: H=3600 mm; Bề rộng vách: 

b=300 mm. Cặp nội lực tính toán: Mômen M=2000 kNm, lực dọc N=2100 kN. 

Yêu cầu: Tính toán, chọn và bố trí cốt thép cho vách cứng bằng phƣơng pháp vùng 

biên chịu mômen, chiều dài tính toán 
0 0,7l H . Vật liệu sử dụng: Bê tông có cấp độ 

bền B30; Cốt thép chịu lực của vách sử dụng thép AII. 

 

Tra bảng: Bê tông B30 có Rb=17 MPa; cốt thép AII có Rs=Rsc=280 MPa    

Giả thiết chiều dài vùng biên chịu mô men Bt = Bp = 0,2L = 0,2×1,8 = 0,36 (m).  

- Lực kéo, nén ở hai vùng biên của vách: 

+ Vùng biên trái:  

 
 

 

( 0,5 0,5 )

2100 2000
0,36 0,3 968,9

1,8 0,3 1,8 0,36

t t

t p

N M
P A

A L B B

kN

 
 

     
 

           

+ Vùng biên phải:  

 
 

 

( 0,5 0,5 )

2100 2000
0,36 0,3 1808,9

1,8 0,3 1,8 0,36

p p

t p

N M
P A

A L B B

kN

 
 

    
 

   

- Tính độ mảnh của vách trong mặt phẳng uốn: 

N

M

x

y

b H

L
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+ Chiều dài tính toán của cấu kiện: L0 = 0,7H = 0,7×3,6 = 2,52 (m) 

+ Độ mảnh ngoài mặt phẳng uốn: 0 2,52
29,17 14

0,288 0,288 0,3

L

L
    


→ cần 

xét đến ảnh hƣởng của uốn dọc.   

- Tính hệ số uốn dọc tính:   

 = 1,028 - 0,0000288.2
 - 0,0016.  

   = 1,028-0,0000288×29,17
2
-0,0016×29,17 = 0,957                  

- Tính cốt thép chịu kéo, nén; xem mỗi đoạn vách nhƣ cấu kiện nén hoặc kéo đúng 

tâm: 

+ Diện tích cốt thép vùng biên chịu nén: 

 

,

3
2 2

( / 0,2 )

(1808,9 10 / 0,957 17 0,2 300 1800)
206( ) 2,06( )

280 17

p b

s p

sc b

P R bL
A

R R

mm cm

 




    
  



          

  + Diện tích cốt thép vùng biên chịu kéo: 

    
3

2 2

,

968,9 10
3460 34,6

280

t
s t

s

P
A mm cm

R


                           

Vì mômen có thể đổi chiều nên lấy lƣợng cốt thép lớn nhất bố trí cho cả 2 bên. 

- Kiểm tra hàm lƣợng cốt thép: 

 
,

min

34,6
.100% 100% 3,2% 0,4%

0,2 0,2 30 180

s t

t

A

bL
      

 
 

 Và 3,2% 3,5%t             

Chọn cốt thép 12Ø20 có 
237,68 sA cm ( Ø20a100) để bố trí cho 2 bên vách 

- Kiểm tra phần vách còn lại giữa hai vùng biên nhƣ đối với cấu kiện chịu nén đúng 

tâm: 

+ Lực dọc tác dụng lên vùng bụng vách đƣợc xác định theo công thức: 

   
2100

( ) 1,8 0,3 2 0,36 0,3 1260
1,8 0,3

b t p

N
P A A A kN

A
         


      

+ Khả năng chịu nén của bê tông giữa hai vùng biên: 

  35,271 10  b b t pN R A A A kN                   

3 35,271 10  1,260 10  b bN kN P kN                                        

Kết luận: phần vách còn lại giữa hai vùng biên đủ khả năng chịu lực, cốt thép trong 

vùng này bố trí thép cấu tạo.                                                           
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- Bố trí cốt thép cho vách:               

Xác định chiều dài vùng tới hạn trongvách: 

0,15 0,27 

1,5 0,45 
cr

L m
l

b m


 


 Chọn 500crl mm  

Chọn cốt thép Ø20a100 để bố trí cho 2 bên vách nằm trong vùng tới hạn. 

Chọn cốt thép phần vách còn lại giữa 2 biên theo cấu tạo với:               

+ đƣờng kính cốt đứng và cốt ngang:  

 
10

,
/10 300 /10 30

d n

v

mm

b mm
 



  

 chọn ϕd =20mm, ϕn =12mm 

+ khoảng cách giữa các thanh cốt thép đứng và ngang (với mức dẻo trung bình): 

  

25 25 20 500
min ;

200

25 25 12 300
 min

200

d

d

ng

ng

mm
s

mm

mm
s

mm





  


  


 chọn sd = 100mm; sng = 200mm          

Bố trí cốt thép nhƣ hình vẽ :                 

 

6.3.4.4. Phương pháp xây dựng biểu đồ tương tác 

Thực chất của phƣơng pháp này coi vách làm việc nhƣ cấu kiện chịu nén lệch 

tâm. Nguyên tắc chung của phƣơng pháp xây dựng biểu đồ tƣơng tác là dựa vào biến 

dạng cực hạn của bê tông vùng nén và vị trí của trục trung hòa đƣợc thể hiện qua chiều 

cao vùng nén x, ta có thể xác định đƣợc trạng thái ứng suất trong bê tông và cốt thép 

trong vách, các ứng suất này tổng hợp lại thành một lực dọc và một mô men tại trọng 

tâm hình học của vách, chính là 1 điểm của biểu đồ tƣơng tác. Tập hợp các điểm này 

sẽ tạo thành một đƣờng cong liên hệ giữa lực dọc N và mô men M. 

500 500800

3
0

0

1800

Ø20a100
1 2 Ø12a200

3 1

Ø12a200
4

Ø8a600x400
5

Ø12a200 4Ø12a200 4

Ø12a200 3

Ø20a100Ø20a200
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Vì biểu đồ tƣơng tác là một đƣờng cong, mỗi điểm trên đƣờng cong tƣơng ứng 

với một vị trí của trục trung hòa trên tiết diện vách.  

Ảnh hƣởng lực dọc (N) trên ứng xử của tiết diện vách nhận thấy đƣợc qua biểu 

đồ tƣơng tác N - M  (N-M interaction chart) nhƣ ví dụ sau đây: MacGregor trình bày 

các sơ đồ phân bố biến dạng tƣơng ứng với các điểm đặc trƣng của biểu đồ tƣơng tác 

N-M:  

 

 

Hình 6. 15. Biểu đồ tƣơng tác. 

Năm điểm đƣợc nhận dạng trong biểu đồ tƣơng tác ở Hình là:  

- Điểm A: nén thuần túy, không mômen uốn M =0; 

- Điểm B: nén + uốn lệch tâm nhỏ, tất cả cốt thép trên tiết diện đều chịu nén 

(x=chiều cao tiết diện): c = cu (bê tông) và t < y  (thép); 

- Điểm C: phá hoại cân bằng, biến dạng lớn nhất của bê tông vùng nén đạt đến 

biến dạng cực hạn quy ƣớc của bê tông đồng thời biến dạng lớn nhất của cốt thép đạt 

đến giới hạn chảy: c = cu (bê tông) và t = y (thép); 
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- Điểm D: nén + uốn lệch tâm lớn:  c = cu (bê tông) và t > y (thép); 

- Điểm E: uốn thuần túy, không có lực dọc N=0. 

Phƣơng pháp xây dựng biểu đồ tƣơng tác thực chất coi vách cứng là một cấu kiện 

chịu nén lệch tâm và cốt thép phân bố trên toàn tiết diện vách đƣợc kể đến trong khả 

năng chịu lực của vách. 

 

 

Hình 6. 16. Dạng bố trí cốt thép và biểu đồ tƣơng tác của vách cứng. 

6.3.4.5. Phương pháp kiểm tra khả năng chịu lực 

(1) Tính toán và bố trí cốt thép sơ bộ cho vách cứng 

Tính toán cốt thép nhƣ cấu kiện chịu nén lệch tâm phẳng, có tiết diện bL, chịu 

tác dụng của N, M. Tính đƣợc As và As

. 

(2) Chọn và bố trí cốt thép trên tiết diện theo tỷ lệ sau: 

 

Hình 6. 17. Phân bố cốt thép trong vách cứng. 

(3) Kiểm tra khả năng chịu lực cho vách cứng 

Tính các hệ số: 

N

MA =0,35(A +A )x s s

'

A =0,35(A +A )x s s

'

A =0,5(A +A )y s s

'

L

0,1L 0,1L

b
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0 0

1
1

;    ;    

;   0,5 ;    
2

s ys x
x y

b b b

y

y

R AR AN
n

R bL R bL R bL

na

L

 

 
   

 

  


   



 (6.23) 

- Nếu 1  2 thì kiểm tra khả năng chịu lực theo: 

2

0 2 ( )b x yNe R bL n          (6.24) 

- Nếu 1 > 2 và 1 < gh thì kiểm tra khả năng chịu lực theo: 

2 1
0 1 1 1(1 ) ( )(1 ) 2

2

y

b xNe R bL


       


 
       

 
 (6.25) 

-  Nếu 1 > gh, tính 1 1( );   0,125 0,5
y

gh gh y xn m


    


     
 

+ Khi e0/L > m1/n1; tính c1 =0,5(0 - ), thì kiểm tra khả năng chịu lực theo: 

 2

0 1 1 1( )bNe R bL m c n n     (6.26) 

+ Khi e0/L  m1/n1; tính n2= 0.8+2(y + 1) và c2 =m1/(n2 - n1), thì kiểm tra khả 

năng chịu lực theo: 

 2

0 2 2( )bNe R bL n n c    (6.27) 

trong đó gh phụ thuộc  nhƣ sau: 

 0,04 0,06 0,08 0,1 0,12 0,14 0,16 

gh 0,53 0,52 0,51 0,5 0,49 0,48 0,46 

6.3.4.6. Thực hành tiết kế vách cứng bê tông cốt thép theo ACI 318-08 

Trình bày các vấn đề cơ bản trong thiết kế vách cứng bê tông cốt thép theo tiêu 

chuẩn Mỹ ACI 318-08 có các điều kiện sau đây: 

Vách cao - flexural walls : Hw/L  2, thiết kế chống lực dọc + lực uốn + lực cắt; 

nhà cao trung bình - moderate height building (H = 20-75 m); vách cứng thông thƣờng 

đổ tại chổ: thoả mãn ACI 318 từ Chƣơng 1 đến 18, áp dụng thích hợp cho động đất 

vừa: 0,167g < Se(T =
 
TB) < 0,5g  và  0,067g < Se(T = 1s) < 0,2g. 

1. Yêu cầu cấu tạo cốt thép vách cứng  

- Chiều dày vách tối thiểu: 

tw   (hs /25, lw /25, 100mm); 

tw2  (hs /15, 200mm) nếu lw2 < (2 tw2 , lw /5); 

tw2  (hs /10, 200mm) nếu lw2 > (2 tw2 , lw /5). 

(6.28) 

- Hàm lƣợng thép thép cấu tạo tối thiểu: 



-188- 

 

   Đƣờng kính thép cấu tạo:  ,
10

w
Av Ah

t
    

1

0,0015v
l

w

A

t s
   ; 

2

0,0025h
t

w

A

t s
    (6.29) 

- Bƣớc bố trí cốt thép cấu tạo: 

s1  (3tw, 450mm);  s2  (3tw , 450mm) (6.30) 

trong đó: 

Hw - chiều cao vách cứng; 

hs - chiều cao mỗi tầng sàn nhà; 

lw , lw2 - chiều dài vách cứng và phần tử biên; 

tw , tw2 - chiều rộng vách cứng và phần tử biên; 

Av - thép cấu tạo theo phƣơng đứng, bƣớc thép s1, hàm lƣợng thép phƣơng đứng 

l; 

Ah - thép cấu tạo theo phƣơng ngang, bƣớc thép s2, hàm lƣợng thép phƣơng 

ngang t. 

 

Hình 6. 18. Cấu tạo cốt thép vách cứng. 

2. Bố trí thép dọc chịu uốn 

s
1

s
1

s
1

s
1

s
1

s
1

s
2

s
2

s
2

s
2

A
h

A
v

lw2

t
w2

t
w

lw

P

MV
u

u

u
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Thép dọc chịu uốn + nén trong vách cao bê tông cốt thép có thể đƣợc bố trí theo 

các cách nhƣ sau:  

- Bố trí thép dọc phân tán đều trên toàn bộ tiết diện ngang vách cứng; 

- Đặt dày thép dọc tính toán (thép As đƣờng kính  > 16mm và có hàm lƣợng tt 

thỏa mãn chƣơng 7, chƣơng 10 của ACI 318-05) ở hai phần tử biên tại hai đầu vách ( 

0,1lw) và bố trí thép dọc cấu tạo (thép Av hàm lƣợng xấp xỉ min = 0.15% nhƣ phần 

15.3.1) ở phần giữa vách ( 0.8lw): nhằm cải thiện độ dẻo và tăng khả năng chống uốn 

của vách. Ở hai đầu vách phải bố trí thép đai kín thỏa mản chƣơng 7, chƣơng 10 của 

ACI 318-05, để tăng hiệu quả ép ngang (confined concrete) nhƣ Hình 6.19. 

 

Hình 6. 19. Các phƣơng án bố trí cốt thép vách cứng phẳng. 

Ví dụ : Mômen chống uốn tăng 25% khi bố trí thép dọc của vách phẳng phƣơng án 2 

có cùng hàm lƣợng thép so sánh với phƣơng án 1.  

 

Trƣờng hợp vách bê tông cốt thép dạng hộp, có thể đặt dày cốt thép ở các góc và 

phân tán ở phần giữa vách nhằm cải thiện độ dẻo và tăng khả năng chống uốn. 

PA1: Bố trí thép đều nhau 

Mmax= 380 Mmax= 475 

PA2: Bố trí thép dày ở 2 đầu 



-190- 

 

3. Tính toán thép dọc chịu uốn 

Để tính thép dọc chịu uốn + nén của vách cao bê tông cốt thép (chủ yếu thép tính 

toán As ở hai đầu vách), áp dụng chƣơng 10 (10.2→10.3, 10.10→10.14, 10.17) và 

chƣơng 14 (14.2→14.3) của ACI 318-05 kết hợp sử dụng đường cong tương tác 

(interaction curves Pn - Mn): 

     

    

- Hầu nhƣ vách phẳng đƣợc tính nhƣ  

kết cấu chịu nén một phƣơng. 

-  Nội lực tính toán (P, M) tại các mặt 

cắt ngang phải nằm trong đƣờng cong 

tƣơng tác (Pn, Mn): 

 P = Pn  yêu cầu M  Mn   

- Hầu nhƣ vách hộp đƣợc tính nhƣ 

kết cấu chịu nén hai phƣơng. 

 P = Pn   

yêu cầu Mx  Mnx; My  Mny  

 My = Mny   

yêu cầu P  Pn ; Mx  Mnx  
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Thực chất hai phƣơng pháp: phƣơng pháp ứng suất đàn hồi và phƣơng pháp vùng 

biên chịu mô men là biến bài toán tính toán vách thành tính toán các cấu kiện chịu nén 

và kéo đúng tâm. Theo tiêu chuẩn ACI 318-05 quy định cách tính toán cốt thép cho 

cấu kiện chịu nén đúng tâm nhƣ sau:  

Diện tích cốt thép chịu nén đƣợc tính từ phƣơng trình: 

 '0,8 0,85 ( )c sc y scN f A A f A     (6.31) 

trong đó:  - hệ số giảm cƣờng độ chịu lực của vật liệu khi chịu nén, theo ACI -.3.2.2 

cho phép lấy  =0,7. 

A – diện tích toàn bộ tiết diện ngang của bê tông của vách; 

Asc – diện tích cốt thép chịu nén;  

fc
'
 – cƣờng độ chịu nén đặc trƣng của bê tông;  

fy – cƣờng độ chịu kéo của cốt thép. 

Diện tích cốt thép chịu nén đƣợc xác định theo công thức: 

'

'

0,85
0,8

0,85

c

sc

y c

N
f A

A
f f







  (6.32) 

Trƣờng hợp tính toán theo cấu kiện chịu kéo đúng tâm thì cốt thép đƣợc tính nhƣ sau: 

st

b y

N
A

f
   (6.33) 

trong đó b là hệ số giảm cƣờng độ của vật liệu khi chịu kéo, theo ACI-.9.3.2.1 lấy 

b=0,9. 

4. Tính toán thép chống cắt 

Áp dụng phần 11.10 của ACI 318-08, các bƣớc chính thiết kế chống cắt vách cao 

bê tông cốt thép nhƣ sau: 

Kiểm tra cƣờng độ chống cắt lớn nhất cho phép:  

'

,max

5

6
n c w wV f t d   (6.34) 

Đơn vị: [Vn] = N; [fc
’
] = MPa ; [tw], [dw] = mm ; với 0.8w wd l     

Yêu cầu: 
,maxn uV V  ;   

Hệ số giảm cƣờng độ chống cắt:  = 0.75;  

Tính cƣờng độ chống cắt của bê tông: 

1
'

4 4

u w
c c w w

w

P d
V f t d

l
    (6.35) 

dấu - khi Pu là kéo, dấu + khi Pu là nén.  
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Xác định thép chịu cắt theo phƣơng ngang (Av, ss): 

- Nếu 0,5u cV V   bố trí (Av, s2) theo cấu tạo; 

- Nếu 0,5u cV V   tính toán (Av, s2) nhƣ sau: 

u nV V   (6.36) 

( )u n sV V V    (6.37) 

2

v y w

u c

A f d
V V

s


    (6.38) 

2

v u c

y w

A V V

s f d






   (6.39) 

Từ cặp (Av, s2) tính đƣợc từ phƣơng trình (6.45): 

2

0.0025v
h

w

A

t s
     (6.40) 

2

/ 5

3

450

w

w

l

s t

mm




 



  (6.41) 

Kiểm tra thép chịu cắt theo phƣơng đứng (Ah, s1):  

1

h
n

w

A

t s
    (6.42) 

Yêu cầu: 

0.0025 0.5(2.5 )( 0.0025)

0.0025

w
n h

w

n

n h

h

l
 



 


   




 



  
(6.43) 

1

/ 3

3

450

w

w

l

s t

mm




 



  (6.44) 
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Hình 6. 20. Dạng bố trí cốt thép vách cứng. 

6.4. Cấu tạo cốt thép dầm 

6.4.1. Vùng tới hạn trong dầm 

Qua kết quả khảo sát các công trình bị sụp đổ do động đất gây ra vị trí bị phá 

hoại, trƣớc tiên thƣờng bắt đầu từ các nút khung và những phần dầm, cột tiếp giáp với 

nó. Tại các vị trí đó, bê tông bị nát vụn do biến dạng ngang quá lớn khi bị nén làm cho 

cốt đai bị kéo đứt, cốt dọc bị mất ổn định, oắn ra ngoài. Để giảm biến dạng ngang của 

bê tông, tăng cƣờng sự ổn định cốt dọc cần thiết phải tăng cƣờng cốt đai trong vùng 

này (gọi là vùng tới hạn). Cốt đai là các vòng kín, ôm chặt lấy lõi bê tông, khi kết cấu 

chịu lực lớn và khi dao động, phần bê tông ngoài lõi có thể bị vỡ nhƣng phần bê tông 

trong lõi vẫn còn phát huy đƣợc khả năng chịu lực và tạo độ dẻo cần thiết cho kết cấu. 
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Hình 6. 21. Cột bị phá hoại. 

Chiều cao của dầm khung:  
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Trong trƣờng hợp dùng dầm bẹt (bd > hd) cần tính toán theo các sơ đồ hệ khung 

vách chịu lực với độ cứng uốn hệ sàn dầm bẹt tƣơng đƣơng với hệ dầm sàn thông 

thƣờng. 

Đối với cột: 

 
0 ;

25

250

c

c

L
h

b mm





 

trong  đó: l – nhịp dầm; l0 – nhịp thông thủy của dầm; L0 – chiều dài thông thủy của 

cột. 

 

Hình 6. 22. Tiết diện cột – dầm bê tông cốt thép. 

Những vùng sau đây gọi là vùng tới hạn:  

- Vùng có khả năng hình thành khớp dẻo, đó là: 
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+ Các đầu dầm liên kết cứng với cột; 

+ Vùng giữa dầm nơi có đặt lực tập trung lớn (có mô men lớn ở vùng giữa nhịp 

và có lực cắt vƣợt quá khả năng chịu cắt của bê tông). 

Trong dầm kháng chấn chính, các vùng tới hạn có chiều dài lcr = 1,5hd (trong đó 

hd là chiều cao dầm) tính từ tiết diện ngang tại đầu mút dầm qui tụ vào nút dầm-cột, 

cũng nhƣ tính từ cả hai phía của tiết diện ngang bất kỳ mà ở đó có thể có chảy dẻo 

trong tình huống thiết kế chịu động đất, phải đƣợc xem là các vùng tới hạn. 

Trong các dầm kháng chấn chính đỡ các cấu kiện thẳng đứng không liên tục (bị 

cắt/ngắt), các vùng trong phạm vi một khoảng bằng 2hd ở mỗi phía của cấu kiện thẳng 

đứng đƣợc chống đỡ cần đƣợc xem nhƣ là vùng tới hạn. 

Nên chọn chiều dài vùng tới hạn tính từ mép cột lấy bằng lcr =1,5hd; tính từ điểm 

đặt lực tập trung ra hai bên, mỗi bên dài 1,5hd. 

 

Hình 6. 23. Quy định vùng tới hạn trong dầm. 

Trong phạm vi các vùng tới hạn của dầm kháng chấn chính, phải đƣợc bố trí cốt 

đai thỏa mãn những điều kiện sau đây: 

- Đƣờng kính w của các thanh cốt đai (tính bằng mi li mét) không đƣợc nhỏ hơn 

o.w, đồng thời không đƣợc nhỏ hơn đƣờng kính cốt dọc max/4: 

 w max .max[ / 4; ]o w   ; 

- Khoảng cách s của các vòng cốt đai (tính bằng mi li mét) không đƣợc vƣợt quá: 

s = min {hd/4; 24w; so.w; kmin}  

trong đó: 

min là đƣờng kính thanh thép dọc nhỏ nhất (tính bằng mi li mét); 

max là đƣờng kính thanh thép dọc lớn nhất (tính bằng mi li mét); 

w là đƣờng kính thanh cốt thép đai; 

hd là chiều cao tiết diện của dầm (tính bằng mi li mét). 

- Cốt đai đầu tiên phải đƣợc đặt cách tiết diện mút dầm không quá 50 mm (xem 

Hình 5.6). 

Mức độ dẻo kết cấu o.w (mm) k so.w (mm) to.w (mm) β0 

III 10 6 100 200 0,35 

lcr
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hd

Vuøng tôùi haïn

Vuøng ngoaøi tôùi haïn

Daàm
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II 8 8 150 250 0,30 

I 6 8 150 300 0,25 

- Hàm lƣợng cốt đai: 
.min 0

w b
w

s

A R

bs R
    

trong đó: s – khoảng cách giữa các cốt đai; b – bề rộng dầm; As – diện tích tiết diện cốt 

đai trong dầm. 

Cốt đai ngoài vùng tới hạn: s  min[hd/2; 300mm; 12] 

Đầu mút cốt đai phải uốn móc ôm lấy cốt dọc, góc uốn  135
o
, đoạn thẳng 

10w. Đoạn uốn gập t  to.w. 

 

Hình 6. 24. Cấu tạo hình dạng cốt đai trong dầm. 

6.4.2. Cốt thép dầm 

 

Hình 6. 25. Cấu tạo dầm bê tông cốt thép. 

Khi thiết kế dầm cần chú ý những điều sau: 
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- Cốt đai trong dầm đƣợc tính toán và cấu tạo cần kết hợp với các yêu cầu chống 

động đất: 

Chọn đoạn l1: l1  max[3hd, l/4] (xem Hình 6.29); 

Trong đoạn l1 khoảng cách giữa các cốt đai:  min ;0,25 ;8 ;150tt ds s h mm ; 

Trong đoạn l2 khoảng cách giữa các cốt đai:  min 0,5 ;12 ;300ds h mm . 

- Đƣờng kính cốt thép dọc không nhỏ hơn 14mm ( 14mm); 

- Hàm lƣợng cốt thép dọc:  
min max 2%     , ở vùng mô men dƣơng 

min 0,2%   , ở vùng mô men âm 
min 0,25%  . 

- Độ dài của cốt thép chịu mô men âm tính từ mép cột không nhỏ hơn 1/4 nhịp 

dầm thông thủy. Cốt thép ở phía dƣới dầm neo vào cột không ít hơn 2 thanh, và độ dài 

neo thẳng không nhỏ hơn 20 (đƣờng kính thép dọc). Khi không đủ chiều dài neo 

thẳng, cần uốn gập 90
0
 lên phía trên thì đoạn nằm ngang của phần neo phải không nhỏ 

hơn 10. 

- Phần cốt thép dọc của dầm đƣợc uốn cong để neo vào nút luôn luôn phải ở phía 

trong các thanh cốt đai kín tƣơng ứng của cột. 

- Ít nhất phải bố trí hai thanh có bám dính tốt với  = 14 mm ở cả phần mặt trên 

và đáy dầm liên tục dọc suốt toàn bộ chiều dài dầm. 

- Ít nhất 1/4 diện tích tiết diện cốt thép lớn nhất phía trên tại các gối phải chạy 

dọc suốt chiều dài dầm. 

- Các thanh cốt thép ở phía trên hoặc đáy dầm kéo qua các nút trong phải đƣợc 

cắt ở một khoảng không nhỏ hơn lcr trong các cấu kiện qui tụ vào nút đó (chiều dài 

vùng tới hạn của từng cấu kiện đó) tính từ bề mặt của nút. 

 

Hình 6. 26. Quy định lƣợng cốt thép dọc bố trí trong dầm. 
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Hình 6. 27. Cấu tạo cốt thép trong dầm. 
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Hình 6. 28. Cấu tạo cốt thép đai trong dầm. 

6.5. Cấu tạo cốt thép cột 

Bảng 6. 1. Quy định về cốt dọc cột 

Cốt dọc trong cột Kết cấu thông thƣờng Có xét tới động đất 

Hàm lƣợng cốt thép max 

Hàm lƣợng cốt thép min 

< 5% 

> 0,5% 

< 3,5% 

(0,6 – 0,8)% 

Khoảng cách giữa các cốt dọc  400 mm  250 mm  

 200 mm động đất 

mạnh 

Khoảng hở giữa các thanh thép  50 mm  50 mm 

Mối nối cốt thép đổ bê tông tại chỗ Khi  > 25mm phải nối 

hàn, các trƣờng hợp khác 

đƣợc nối buộc 

lnối =1,3lan 

Bắt buộc phải nối hàn 

lnối =1,3lan+k 

k =5  10 

Cốt thép cột ở đỉnh Phải bẻ gập và neo vào 

dầm với chiều dài  lan 

Phải bẻ gập và neo vào 

dầm với chiều dài  lan, 

ở đầu cốt thép cần làm 
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neo gập với chiều dài 

10 

Bảng 6. 2. Quy định về cốt đai 

Cốt dọc trong cột Kết cấu thông thƣờng Có xét tới động đất 

Đƣờng kính cốt đai > 0,25doc max và 6mm > 0,25doc max và 8mm 

Động đất mạnh10mm  

Vùng nút khung (đoạn l1) cốt đai 

phải bố trí liên tục, đai kín với 

khoảng cách cốt đai 

<6doc min và 100mm <6doc min và 100mm 

Vùng cốt đai tăng cƣờng, cốt đai 

phải bố trí liên tục, đai kín với 

khoảng cách các cốt đai 

>6doc min và 100mm 6doc min và 100mm 

động đất mạnh. 

8doc min và 150mm 

động đất trung bình. 

Vùng cốt đai không tăng cƣờng, 

khoảng cách các cốt đai 

50% cốt đai vùng tăng 

cƣờng và <12doc 

(hàm lƣợng µ>3%: <10doc 

và 200mm) 

50% cốt đai vùng 

tăng cƣờng và <12doc 

(hàm lƣợng µ>3%: 

<10doc và 200mm) 

Chỗ nối cốt thép dọc cột, khoảng 

cách các cốt đai 

<5doc và 100 khi cốt dọc 

chịu kéo; 

<10doc và 200mm khi cốt 

dọc chịu nén 

 

<5doc và <100 khi cốt 

dọc chịu kéo; 

<10doc và <200mm 

khi cốt dọc chịu nén 

 

Vùng tới hạn trong cột: là vùng có khả năng xuất hiện khớp dẻo nhất, sự phá 

hoại thƣờng bắt đầu từ vùng này. Trong vùng tới hạn cần có những cấu tạo đặc biệt để 

đảm bảo độ dẻo cần thiết và khả năng phân tán năng lƣợng. 

Những vùng sau đây gọi là vùng tới hạn: 

- Đoạn từ đầu mút cột tiếp giáp với nút khung có chiều dài bằng l1 (xem Hình 

6.33); 

- Chân cột giáp với móng có chiều dài  ¼ chiều cao thông thủy của cột. 

Cốt đai: 

Cốt đai trong cột dùng cốt đai rời thì hai đầu phải uốn móc một góc 135
o
 và chiều dài 

đoạn thẳng neo  w (w – đƣờng kính cốt đai), cách một cốt dọc có một cốt đai. 
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Hình 6. 29. Quy định cách thức bố trí cốt thép trong cột. 
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Hình 6. 30. Cấu tạo cốt đai trong cột chịu tải động đất. 

 

Hình 6. 31. Một số dạng cấu tạo cốt đai trong cột. 
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6.6. Cấu tạo cốt thép nút khung 

Các nút khung, các nút liên kết giữa cột vách và dầm nối với vách hay lõi cứng là 

những vị trí tập trung nội lực lớn, là nơi chịu lực phức tạp, tập trung ứng suất và biến 

dạng, nên việc tính toán nút khung thƣờng liên quan đến đƣờng kính, khoảng cách cốt 

đai, đƣờng kính, số lƣợng và neo cốt dọc vào nút; nên ngoài việc bố trí các cốt thép 

chịu lực theo tính toán cần thêm cốt đai gia cƣờng. Các cốt đai này phải bảo đảm sự 

liên kết của cột và dầm chống lại sự gia tăng lực cắt một cách đột ngột tại nút khung 

và tăng cƣờng độ bền của nút khung theo các tiết diện nghiêng mà trong tính toán, 

thiết kế chƣa định lƣợng đƣợc. 

Đoạn neo cốt thép dầm vào cột hoặc cốt thép cột vào dầm đối với công trình có 

tính động đất lấy nhƣ sau: 

5 (10 )neo anl l      

(tính từ mép cột hoặc mép dầm). 

trong đó: lan – đoạn neo cốt thép đối với công trình không tính động đất; 

     - đƣờng kính cốt thép; chọn dấu trong ngoặc khi động đất mạnh. 

 

 

Hình 6. 32. Bố trí cốt đai tại nút khung theo yêu cầu kháng chấn. 
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Hình 6. 33. Quy định chiều dài đoạn neo cốt thép. 
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Hình 6. 34. Cấu tạo nút khung thông thƣờng không tính động đất: 1. cốt đai bổ sung; 

2,3,4,5,6,7 cốt dọc trong dầm, cột đƣợc uốn cong tại các nút. 

Đối với công trình có tính động đất tại các nút khung, cần bổ sung thêm cốt đai 

gia cƣờng. 

Trình bày lý do của việc bố trí cốt đai cột trong nút khung của nhà cao tầng: 

(nguồn http://www.edcons.edu.vn/) 

Phần liên kết giữa dầm và cột (nút khung) đóng vai trò quan trọng trong việc bảo 

đảm cho các cấu kiện phát huy hết khả năng làm việc của chúng, bảo vệ công trình 

không bị sụp đổ khi các cấu kiện chƣa bị phá hoại. Một nguyên tắc quan trọng trong 

thiết kế kết cấu là phải bảo đảm các liên kết không bị phá hoại trong mọi trƣờng hợp. 

Muốn vậy thì cƣờng độ (khả năng chịu lực) của liên kết phải lớn hơn cƣờng độ của tất 

cả các cấu kiện mà nó liên kết. Sự phá hoại từng cấu kiện riêng lẻ có thể không gây 

nên sự sụp đổ của công trình, nhƣng sự phá hoại của các liên kết giữa dầm và cột thì 

rất dễ dẫn đến sự sụp đổ của toàn công trình. 

Để thấy đƣợc điều này, ta hãy xét một khung phẳng chịu tải trọng ngang nhƣ trên 

Hình 6.35a. Giả sử cột đã đƣợc thiết kế theo nguyên tắc cột khỏe – dầm yếu (tức là cột 

không bao giờ phá hoại trƣớc dầm). Lúc này sẽ có hai trƣờng hợp xảy ra: 

Trƣờng hợp 1: Các nút khung đƣợc thiết kế tốt, chúng có cƣờng độ cao hơn dầm. 

Trong trƣờng hợp này, toàn kết cấu chỉ bị sụp đổ khi tất cả các đầu dầm đều đã xuất 

hiện khớp dẻo (Hình 6.35b). Bởi vì chỉ khi đó thì mới xuất hiện cơ cấu sụp. Sự phá 

hoại của một số dầm sẽ không tạo nên cơ cấu sụp (Hình 6.35c). 

 Trƣờng hợp 2: Các nút khung không đƣợc thiết kế cẩn thận, chúng có cƣờng độ 

thấp hơn dầm. Trong trƣờng hợp này, các nút khung sẽ bị phá hoại trƣớc khi khớp dẻo 

xuất hiện trong dầm. Khi đó chỉ cần sự phá hoại của vài nút khung là cơ cấu sụp đổ sẽ 

hình thành (Hình 6.35d). 

Mặc dù liên kết có vai trò quan trọng nhƣ vậy nhƣng các tài liệu hƣớng dẫn thiết 

kế kết cấu bê tông cốt thép ở nƣớc ta hiện nay lại rất ít quan tâm đến nó: gần nhƣ 

không có một tài liệu tiếng Việt nào quan tâm đúng mức đến vấn đề này. Nhiều kỹ sƣ 
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thiết kế cũng chỉ quan tâm đến việc thiết kế các cấu kiện dầm, cột… mà bỏ qua những 

điểm nối vô cùng quan trọng giữa chúng. 

 
Hình 6. 35. Tầm quan trọng của nút khung trong khung chịu tải trọng ngang; 

 (a) Khung chịu tải trọng ngang, (b) Cơ cấu sụp đổ chỉ xảy ra khi tất cả các dầm đều xuất hiện khớp 

dẻo; (c) Nếu chỉ có một số khớp dẻo xuất hiện trong dầm thì chƣa hình thành cơ cấu sụp đổ; (d) Chỉ 

cần vài nút khung bị phá hoại, cơ cấu sụp đổ xuất hiện. 

Để thiết kế và cấu tạo nút khung một cách hợp lý, ta cần phải biết cơ chế chịu lực 

và phá hoại của nó. Xét một khung phẳng chịu tải trọng ngang, tải trọng quan trọng 

trong nhà cao tầng, nhƣ trên Hình 6.36a. Biểu đồ mô men của nó có dạng nhƣ trên 

Hình 6.36b. Tách nút A ra khỏi khung và biểu diễn các mô men tác dụng lên nó nhƣ 

trên Hình 6.36c. Các mô men tác dụng lên nút A sẽ hình thành các cặp ngẫu lực làm 

nút này có khuynh hƣớng biến dạng và phá hoại nhƣ trên Hình 6.36d. Hình 6.37 cho 

thấy các vết nứt đƣợc hình thành trong nút khung bê tông cốt thép trong một thí 

nghiệm. Trong thí nghiệm này tải trọng ngang đƣợc đổi chiều (giống nhƣ tải trọng gió 

và động đất trong thực tế) nên vết nứt đƣợc hình thành theo cả hai phƣơng. 

 

Hình 6. 36. Sự làm việc và cơ chế phá hoại của nút khung; 

(a) khung chịu tải trọng ngang; (b) dạng của biểu đồ mô men; (c) mô men tác dụng lên nút khung; (d) 

biến dạng và phá hoại của nút khung. 

Để chống lại sự phá hoại nói trên, một biện pháp đơn giản là bố trí cốt đai cho 

cột trong nút khung nhƣ trên Hình 6.36. Một số ý kiến hiện nay cho rằng việc bố trí 

cốt đai nhƣ vậy sẽ gây khó khăn cho việc thi công. Nói nhƣ vậy tức là chƣa hiểu đƣợc 
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tầm quan trọng của liên kết trong kết cấu. Thực ra, việc đƣa bất cứ một cấu kiện nào, 

một thanh thép nào vào kết cấu cũng đều gây khó khăn cho thi công. Vấn đề là nếu cấu 

kiện đó, thanh thép đó là cần thiết thì khó khăn cách mấy cũng phải đƣa vào. 

 
Hình 6. 37. Sự phá hoại của nút khung.                 Hình 6. 38. Gia cƣờng cho nút khung. 
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Hình 6. 39. Phân tích sự làm việc nút khung. 

6.7. Cấu tạo cốt thép vách cứng và lõi cứng 

6.7.1. Lựa chọn và bố trí các vách và lõi cứng 

- Khi thiết kế các công trình sử dụng vách và lõi cứng chịu tải trọng ngang, phải 

bố trí ít nhất 3 vách cứng này không đƣợc gặp nhau tại một điểm. 

- Nên thiết kế các vách giống nhau (về độ cứng cũng nhƣ kích thƣớc hình học) và 

bố trí sao cho tâm cứng của hệ trùng với tâm khối lƣợng của chúng. Trong trƣờng hợp 

chỉ đối xứng về độ cứng (độ cứng trong giai đoạn đàn hồi) mà không đối xứng về kích 

thƣớc hình học thì khi vật liệu làm việc ở giai đoạn dẻo dƣới tác động lớn nhƣ động 

đất vẫn có thể dẫn đến thay đổi độ cứng. Điều này sẽ gây ra biến dạng và chuyển vị 

khác nhau trong các vách khác nhau. Hệ quả là sự đối xứng về độ cứng bị phá vỡ và 

phát sinh ra các tác động xoắn rất nguy hiểm đối với công trình. 

- Không nên chọn các vách có khả năng chịu lực lớn nhƣng số lƣợng ít mà nên 

chọn nhiều vách nhỏ có khả năng chịu tải tƣơng đƣơng và phân bố đều các vách trên 

mặt bằng công trình. 

- Không nên chọn khoảng cách giữa các vách và từ các vách đến biên quá lớn.  

- Tổng diện tích mặt cắt ngang của các vách (lõi) cứng có thể xác định theo công 

thức gần đúng: 0,015vl siA A ; trong đó Asi là diện tích sàn từng tầng. 

- Từng vách nên có chiều cao chạy suốt từ móng đến mái và có độ cứng không 

đổi trên toàn bộ chiều cao của nó. 

- Các lỗ (cửa) trên các vách không đƣợc làm ảnh hƣởng đáng kể đến sự làm việc 

chịu tải của vách và phải có biện pháp cấu tạo tăng cƣờng cho vùng xung quanh lỗ. 
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- Chiều dày thành vách, lõi cứng lấy không nhỏ hơn 1/20 chiều cao tầng nhà và 

150mm. 

- Chiều dày vách ngoài việc kiểm tra theo cƣờng độ nhƣ đã nêu còn cần kiểm tra 

theo khả năng chịu ứng suất nén chính và có thể tính theo công thức: 0,25v b v vQ R b h  

; trong đó Qv – lực cắt tính toán của vách hoặc của nhánh vách cứng, bv, hv – tƣơng 

ứng là chiều dày và chiều cao tiết diện vách cứng. 

- Khi vách cứng chịu lực tập trung còn phải kiểm tra khả năng nén cục bộ. 

- Khi thiết kế chống động đất trong vách và trong lõi thƣờng đặt các cột chìm ở 

hai đầu vách và ở các góc lõi.  

6.7.2. Cấu tạo vách và lõi cứng 

Cốt thép trong vách đƣợc đặt thành lƣới cốt thép đứng và ngang, phải đặt hai lớp, 

mỗi lớp một lƣới. Cốt thép ngang > 50% cốt thép đứng. Hai lƣới thép này phải đƣợc 

liên kết với nhau bằng các móc đai hình chữ S với mật độ 6 móc/m
2
. 

Đƣờng kính cốt thép đứng và ngang: d, ng  10mm và  bv/10. 

Hàm lƣợng cốt thép thẳng đứng xác định theo tính toán, nhƣng phải chọn  

0,40% (đối với động đất yếu), và  0,60% (đối với động đất trung bình và mạnh), đồng 

thời  3,5%. 

Cốt thép nằm ngang chọn không ít hơn 1/3 lƣợng cốt thép dọc với hàm lƣợng 

0,25% đối với động đất yếu và  0,40%  đối với động đất trung bình và mạnh.  

Khoảng cách giữa các thanh cốt thép đứng và ngang: 

- Với kết cấu có mức dẻo cao: 
20 20

min ;   min
200 200

d ng

d ngs s
mm mm

 
   ;  

- Với kết cấu có mức dẻo trung bình: 
25 25

min ;   min
200 200

d ng

d ngs s
mm mm

 
   ; 

- Với kết cấu có mức dẻo thấp, cấu tạo cốt thép theo cách thông thƣờng: 

2 2
min ;   min

300 300

v v

d ng

b b
s s

mm mm
  . 

Dùng cốt thép néo (chữ C hoặc S) để liên kết hai lƣới thép, đƣờng kính 6mm. 

Cần có 6 thanh cho mỗi mét vuông lƣới, khoảng cách cốt néo không quá 400mm. 

Trong vùng nối buộc khoảng cách cốt néo không qua 300mm. 

Chiều dài nối buộc cốt thép: lnối = 1,5lan (đối với động đất yếu), lnối = 2lan (đối với 

động đất trung bình và mạnh). Trong đó lan chiều dài đoạn neo tính toán cho trƣờng 

hợp thông thƣờng không xét động đất. Các điểm nối thép phải đặt so le. 

Vùng tới hạn của vách 
0,15

1,5
cr

L
l

b
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Hình 6. 40. Bố trí cốt thép trong vách. 

Trƣờng hợp vách có lỗ mở nhỏ (b1 và e  500mm) phải đặt tăng cƣờng ít nhất 

212 ở mỗi biên và mỗi góc lỗ mở. 

Trƣờng hợp có lỗ trống kích thƣớc nhỏ, khi tính toán xem là vách đặc thì cần bố 

trí cốt thép xung quanh lỗ tạo thành một khung kín giả. Nếu vách có lỗ mở lớn phải 

dùng biện pháp tăng chiều dày thành vách quanh lỗ và cấu tạo thành vách dƣới dạng 

dầm bao có gờ hoặc ít nhất cũng phải gia cƣờng bằng dầm bao chìm. 

Đối với vách có lỗ cửa lớn, phần lanh tô cửa cần bố trí cốt thép chéo. Các cốt 

thép chéo này nằm trong cốt đai (giống cột giả) với chiều dài neo tăng thêm 50% so 

với cốt thép chịu kéo của BTCT thông thƣờng. Bƣớc cốt đai không lớn hơn 100mm. 

b

lcr

 = 3,5%b o2%oBieán daïng cuûa beâ toâng

dng
Vuøng tôùi haïn

lcr

Vuøng tôùi haïn

x

S
ng

S
ñ

L
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Hình 6. 41. Cấu tạo cốt thép gia cƣờng lanh tô cửa. 

 

Hình 6. 42. Bố trí cốt thép trong vách. 
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1,5lneo
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Hình 6. 43. Bố trí cốt thép trong vách. 

 

Hình 6. 44. Bố trí cốt thép trong vách. 
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Hình 6. 45. Bố trí cốt thép trong vách. 
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Hình 6. 46. Bố trí cốt thép trong vách. 
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Hình 6. 47. Bố trí cốt thép trong vách. 

 

Hình 6. 48. Bố trí cốt thép trong vách. 
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Hình 6. 49. Bố trí cốt thép trong vách. 

 

Hình 6. 50. Bố trí cốt thép trong vách. 
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Hình 6. 51. Bố trí cốt thép trong vách. 
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Hình 6. 52. Bố trí cốt thép trong vách (tham khảo). 

6.8. Nối cốt thép 

Nối chồng, nối hàn, nối bằng coupler. 

Vị trí nối cốt thép phải nối so le.  

Có thể nối hàn (phải kiểm tra mối hàn) hoặc nối chống. 

Trƣờng hợp nối chồng, đoạn cốt thép chồng lên nhau là lch đƣợc xác định nhƣ 

sau: 1,2ch an dl l    , trong đó lan là đoạn neo cốt thép tính theo BTCT thƣờng, 

=510 đối với kết cấu dẻo thấp đến cao. 

Trong đoạn nối chồng, cần giảm khoảng cách giữa các cốt đai, khoảng cách giữa 

các cốt đai >8w. 
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Không nối chồng trong vùng tới hạn. 

Chiều dài đoạn neo thẳng của cốt thép lneo xác định theo: 
neo an dl l   . 

Nếu dùng neo gập thì đoạn thẳng trƣớc khi uốn lấy không nhỏ hơn 10d. 

Nối cốt thép cột dầm có thể nối bằng coupler (TCVN 8163 : 2009). 

 

Hình 6. 53. Loại mối nối tiêu chuẩn. 
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Hình 6. 54. Nối cốt thép bằng coupler. 

 

Hình 6. 55. Nối thép bằng U-bolt. 
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